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PCVUE 12 RELEASE NOTES

7 SUMMARY:

This document contains information about changes in PcVue 12. It includes information up to
Maintenance Release 12.0.31.

Last update ‘ 03/11/2025

Revision ‘ 1.1

Confidentiality TLP:CLEAR

The information in this book is subject to change without notice and does not represent a commitment on the part of the
publisher. The software described in this book is furnished under a license agreement and may only be used or copied in
accordance with the terms of that agreement. It is against the law to copy software on any media except as specifically
allowed in the license agreement. No part of this manual may be reproduced or transmitted in any form or by any means
without the express permission of the publisher. The author and publisher make no representation or warranties of any
kind with regard to the completeness or accuracy of the contents herein and accept no liability of any kind including but
not limited to performance, merchantability, fitness for any particular purpose, or any losses or damages of any kind caused
or alleged to be caused directly or indirectly from this book. In particular, the information contained in this book does not
substitute to the instructions from the products’ vendor. This book may contain material belonging to third-parties. Such
information is used exclusively in internal work processes and is not intended to be disclosed. In addition, this notice is
not a claim of property on such third-party information.

All product names and trademarks mentioned in this document belong to their respective owner
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1. Updates

1. New features

Support for included mimics and popups (SPR # 66242, 66024) Web Server Extensions
Included mimics and popups are now supported in WebVue. > WebVue
It was a known issue since 12.0.7 (Initial Release).
12.0.11
Also in: 15.0.0, 12.1.0 Dev
29584
Support of iPad OS 13 Web Server Extensions
WebVue now supports the Safari web browser shipped with iPad OS 13. > WebVue
12.0.11
Also in: 15.0.0, 12.1.0 Dev
29584
Reference: PcVue 12 Release Notes Last update: November 3, 2025
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2. Fixes

Fatal error when exporting with limited amount of exported records
(SPR # 67739)

A fatal error could occur when performing an export having the advanced property "Statistics
output.Limit exported records" activated, even if the actual number of records was lower than
this limit.

Data Export
12.0.16

SNMP trap not sent (SPR # 67679)

When configuring multiple traps with the same generic format, only the last trap was sent.

Communication
interfaces > SNMP
Agent

12.0.16

Also in: 15.0.0

Import failed due to expressions (SPR # 67558, 67545, 67276, 66885)
When importing expressions via a Smart Generator or the Application Architect, expressions
configured with a result variable that was not produced locally were only partly loaded and did
not behave as expected at runtime.

Configuration
Environments
12.0.16

Also in: 15.0.0

Fatal error when editing a property defined by expression (SPR # 67450)
Under some circumstances, a fatal error could occur when opening the expression editor for
defining a property. The issue occurred when the operating system was set for the Hebrew
character set. Other non-English languages were potentially impacted also (reproduced with
French charset).

Configuration
Environments >
Application Architect
12.0.16

Also in: 15.0.0

Driver IpOpenWebNet - Support for extension modules (SPR # 67702)

The SCS extension modules were incorrectly updated when a new measurement was received
for a single Lighting Point.

Data Acquisition >
Other built-in drivers

12.0.16

Also in: 15.0.0
Improper disconnection WebScheduler
Without a user action causing a request to the web server, the user was forcibly disconnected 12.0.16

after the session time-out (default 1 mn). It could happen when configuring multiple schedules
before saving them at once. A keep-alive request is now sent every 10 sec to make sure the
connection is maintained.

Also in: 15.0.0, 15.0.0

Buffered Al and AO values not recorded (SPR # 66941, 66834, 66297)
The buffered values for Al and AO objects of a DNP3 device were not correctly recorded in the
archives when they were associated to trends. These values are read when connecting to the
device at startup or upon reconnection.

Data Acquisition >
DNP3 Client

12.0.16

Also in: 15.0.0, 15.0.0,
12.1.0 Preview 03

Fatal error at project startup (SPR # 67652)

Under some circumstances, a fatal error could occur at project startup due a conflict in
accessing pending event logs (event logs waiting to be recorded).

Historical data
12.0.16

Also in: 15.0.0, 15.0.0,
11.2.06094, 11.2.06094

Fatal error upon copy of a variable or trend (SPR # 66986)

Under some circumstances, a fatal error could occur when copying a variable or a trend.

Configuration
Environments >
Application Explorer
12.0.16

Also in: 15.0.0,
11.2.06094
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Support for OID and Value in Generic Trap (SPR # 67126)

Generic traps were not supporting OID and Value parameters properly. They now behaves as
described in the online help.

Communication
interfaces > SNMP
Agent

12.0.16

Also in: 15.0.0,
11.2.06092

Upgrade Potential memory leak in Networking with mixed PcVue
versions (SPR # 67867)

Under some circumstances, while migrating a project, a memory leak occurred on a data
acquisition server if it ran a version greater than or equal to 11.2.6086 and communicating with
a client station running with version 12.0.15 or lower. The leak occurred at each restart of a
client station, and its size was proportional to the number of variable subscriptions sent by the
client station to the server station (250 bytes per subscription - typically a leak of 2.5 MB for 10
000 variables at each restart of a client station).

Networking
12.0.16
Also in: 11.2.06094

Fatal error with large .hds temporary file (SPR # 73098, 69357, 66782)

A fatal error occurred when the size of a temporary file exceeded 2 Gb.
From now on, these files are limited to 2 Gb and are indexed when reaching this limit.

Historical data
12.0.30
Also in: 15.2.0

Failed to export all data (SPR # 72532)

Under some circumstances, when multiple data to export had the same timestamp, the data
export could fail to export all archived data matching the time filter.

Data Export
12.0.29
Also in: 16.0.0, 15.2.6

Error with text variable in Data export name (SPR # 69664, 68837, 68832)

Text variables were not correctly supported when used in the Name property of a Data export
item.

Data Export
12.0.29
Also in: 15.2.0, 15.1.5

Instruction WINDOW mode CHANGE - Intellisense (SPR # 72098, 72077)
The instruction WINDOW mode CHANGE was missing in the Intellisense.

Scripting > SCADA
Basic
12.0.28

Null timestamp for saved variables (SPR # 67079)

If a variable was saved while its status was inhibited, it was re-initialized with a null timestamp.

Real time data
12.0.28
Also in: 16.0.0, 15.2.5

Upgrade Error handling when importing configuration (SPR # 71781)

Error handling was not consistent across a number of SCADA Basic instructions designed to
import configuration:

®  |nstruction EXPRESSION mode IMPORT_FILE_ONVAR;
®  |Instruction EXPRESSION mode IMPORT_FILE_TEMP

®  Instruction ASSOCIATEDACTIONS mode IMPORTBYFILE
°

Instruction EVENT mode IMPORTBYFILE
They now return:

®  0:If the file is not accessible or contains nothing to treat (add/delete/modify)
®  >0: Number of lines processed from the file (add/delete/modify) if the import succeeds
or fails

The error values documented in the online help were no longer in line with the implementation
since version 10.

Scripting > SCADA
Basic

12.0.28

Also in: 16.0.0, 15.2.5

Alarm synthesis timestamp changed on server switchover (SPR # 71548)

On a server switch from passive to active, an alarm synthesis is recalculated, including its value
and timestamp. If the alarm synthesis has not changed, the value is not set. But, since a
regression introduced in Maintenance Release 12.0.20 the timestamp was updated, causing
event triggering if any.

This is a known issue in 12.0.20, all subsequent Maintenance Releases of version 12 until
12.0.27 (included) and all releases of version 15 until 15.2.3 (included).

Alarms
12.0.28
Also in: 16.0.0, 15.2.4

Animations on the tree-view control (SPR # 70786)

Animations on tree-view nodes were not executed.
The issue was a regression introduced in 12.0.25.

Web Server Extensions

> WebVue
12.0.28
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Infinite loop at startup with a network license (SPR # 71568)

Under some circumstances, an infinite loop could occur at startup when using a network dongle.
The issue occurred in a scenario when the license owner is not accessible. Clicking the Quit
button caused the renter station to go in an infinite loop.

It was a regression introduced in 15.2.3.

General > Licensing
12.0.28
Also in: 16.0.0, 15.2.4

Memory leak with BACnet objects (SPR # 70978)

Under some circumstances, a memory leak occurred on a client station (typically the web back
end) when accessing BACnet Schedule or Calendar objects for the WebScheduler.

The issue only occurred if the server station producing the BACnet objects was not available at
the time of the request from the client station.

Data Acquisition >
BACnet Client
12.0.28

Also in: 16.0.0, 15.2.3

Incorrect time restriction with development licenses (SPR # 71147)

If a development license was rented from a network slot, data acquisition was incorrectly
limited to 1 hour instead of 4.

General > Licensing
12.0.28
Also in: 16.0.0, 15.2.3

Could not delete actions associated to alarms (SPR # 71293)

Since 12.0.25, 15.1.5 and 15.2.0 it was no longer possible to delete actions associated to alarms
in the behavior panel of the Application Explorer.

Configuration
Environments >
Application Explorer
12.0.28

Also in: 15.2.3

Instruction EVENT mode ADDPROG - Variable with multiple events (SPR
#70979)

Scripting > SCADA
Basic

Since version 12, when for a given variable, multiple events were created with the SCADA Basic ~ 12.0.28
instruction EVENT mode ADDPROG, only the first and last ones were executed. i

Also in: 15.2.3
Project name containing a space (SPR # 71067) General
Fix of a regression, since version 12, a project with a space in its name failed to start when using  12.0.27

the -wts command line argument.

Fatal error at start-up and shutdown (SPR # 70803)

Under some circumstances, a fatal error could occur at start-up or during shutdown.

Miscellaneous
12.0.27

Fatal error when sending multiple write commands (SPR # 70802)

Under some circumstances, a fatal error could occur on a data acquisition server when sending
write commands.

The issue only occurred when sending multiple write requests simultaneously, and only in case
of connection issues with the device.

Data Acquisition >
Other built-in drivers
12.0.27

Also in: 16.0.0, 15.2.3

Memory leak when accessing timetables and schedules (SPR # 70890,
70816, 70009)

A memory leak occurred on the Web & Mobile back end server when using the WebScheduler
to access timetable and schedule objects.

In addition, under some circumstances, a fatal error could also occur on the producer of a
BACnet schedule object upon login in the WebScheduler.

WebScheduler
12.0.27

Also in: 16.0.0, 16.0.0,
15.2.3,15.2.3

Fatal error on the Web & Mobile back end server (SPR # 69142, 66521)

Under some circumstances, a fatal error could occur on the Web & Mobile back end server upon
a call to the SubscriptionPolledRefresh method of the RealTimeData service for a large number
of variables. The issue occurred more frequently when the subscription comprised optional
properties or thresholds.

Web Server Extensions
> Web Services Toolkit
12.0.27

Fatal error with alarm synthesis (SPR # 70341)

Under some circumstances, a fatal error could occur on the Web & Mobile back end server upon
connection of a web client. The issue occurred if a population was configured with the property
Take the applied population into account activated and the scope of at least one of its variable
set to Session context.

Web Server Extensions
> WebVue

12.0.27

Also in: 16.0.0, 15.2.2
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Incorrect handling of the Beep on new alarm property (SPR # 70460,
70222)

The property Beep on new alarm on a user profile was incorrectly handled, leading to unwanted
beeps on mimic opening even without active alarms.

Web Server Extensions
> WebVue

12.0.27

Also in: 16.0.0, 15.2.2

Instruction TREND mode SETVAR - Legend not filled up properly (SPR #

69098)

When adding a trend with the SCADA Basic instruction TREND mode SETVAR in a web context,
the trend label in the legend was not correctly updated with the variable name when its
description was empty.

Web Server Extensions
> WebVue

12.0.27

Also in: 16.0.0, 15.2.2

Support for @#V in the Trend viewer (SPR # 70157)

The Trend viewer now supports the substitution @#V used to refer to the context variable in a
web context.

Web Server Extensions
> WebVue

12.0.27

Also in: 16.0.0, 15.2.2

Inhibited alarms not filtered properly (SPR # 68617)

Inhibited alarms were not filtered properly in the Log viewer when used in a web context.

Web Server Extensions
> WebVue

12.0.27

Also in: 16.0.0, 15.2.1

Fatal error on reading properties (SPR # 70107, 69711)

Under some circumstances, a fatal error could occur when an OPC client read some vendor-
specific properties.

This issue was a regression introduced in the following Maintenance releases: 11.2.06099,
12.0.22,15.0.3 and 15.1.1.

Communication
interfaces > OPC Server
12.0.27

Also in: 16.0.0, 15.2.1,
11.2.06101

OnMimicClose function not executed (SPR # 70035)

When closing a mimic using the SCADA Basic instruction WINDOW mode CLOSE, the SCADA
Basic function configured to be executed upon mimic close was not executed.

Scripting > SCADA
Basic
12.0.26

IP-1SO-S7 driver - Handle leak (SPR # 69989, 69911)

Under some circumstances, a handle leak could occur when using the IP-ISO-S7 driver.

Data Acquisition >
Other built-in drivers
12.0.26

Also in: 16.0.0, 16.0.0,
15.2.1

Line printers not supporting long server list name (SPR # 70170)

A server list with a name longer than 14 characters could not be used to configure a Line printer.

General
12.0.26
Also in: 16.0.0, 15.2.1

Incorrect historical trends (SPR # 70197)

Under some circumstances, invalid points were recorded in HDS databases, leading to
inconsistent Trends display. The issue could occur after a project restart for variables that were
invalid when stopping the project.

Historical data
12.0.26
Also in: 16.0.0, 15.2.1

Trend cleared when scrolling (SPR # 70076)

After a request in historical mode, the trend was cleared when using the horizontal scrollbar.
Now, the horizontal scrollbar is disabled in historical mode, as it requires executing a new
historical request.

Web Server Extensions
> WebVue

12.0.26

Also in: 16.0.0, 15.2.1

Incorrect statistical values in the Trend viewer legend (SPR # 70075)

Statistical values (min, max, average...) displayed in a Trend viewer legend were not always
correct due to data compression.

Web Server Extensions
> WebVue

12.0.26

Also in: 15.2.1
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Fatal error on alarm apparition (SPR # 69996, 69874) Alarms
Under some circumstances, a fatal error could occur when a new alarm was triggered while a 12.0.25
log request was in progress if the alarm matched the log request filter criteria. .
e oroe e Also in: 15.2.0
Fatal error when browsing through mimics (SPR # 66838) HMI
Under some circumstances, a fatal occurred when browsing through mimics while a mimic was 12.0.25

being closed.

Also in: 15.0.0, 12.1.0
Preview 02, 11.2.06091

Could not execute animation (SPR # 69124, 66762)

After cancelling a Send Text or Send Register animation, all the other animations were locked.

Web Server Extensions
> WebVue
12.0.24

Instruction FTP modes DOWNLOAD & UPLOAD - GDI object leak (SPR #

69306)

A GDI object leak occurred when using the SCADA Basic instruction FTP with modes DOWNLOAD
and UPLOAD.

Scripting > SCADA
Basic

12.0.24
Also in: 15.2.0, 15.2.0,
15.1.4,15.1.4

Several fixes related to Recipes (SPR # 69322)
The list of fixes includes:

® Anincorrect error message was displayed when a recipe file name was over 8
characters,

A fatal error occurred when validating a recipe without a title or recipe number,

Under some circumstances, updating the title or recipe number was not taken into
account or created a duplicated recipe.

Miscellaneous
12.0.24

Also in: 15.2.0, 15.1.5,
15.1.5

Variables @DATE & @TIME not updated (SPR # 69349)

Under some circumstances, the variables @DATE and @TIME could no longer be updated. The
issue occurred after having applied a population.

Miscellaneous
12.0.24
Also in: 15.2.0, 15.1.4

Fatal error on Log report modification (SPR # 69558)

A fatal error occurred when modifying or creating a Log report while the print spooler service
was unavailable.

Configuration
Environments >
Application Explorer
12.0.24

Also in: 15.2.0, 15.1.4,
11.2.06101

Wrong alarm timestamp set (SPR # 69559)

Fix of regression, since 12.0.20 and 15.0.0, writing the value of an alarm in a SCADA Basic script
was causing the timestamp to be changed even if the value was the same.

Alarms
12.0.24
Also in: 15.2.0, 15.1.3

Tooltip truncated (SPR # 69339)

Under some circumstances, the tooltip of an animation was truncated.

HMI > Animations
12.0.24

Also in: 15.2.0, 15.1.3,
11.2.06101

Fatal error when adding trends by script (SPR # 69477)

A fatal error occurred when removing and adding trends to a Trend viewer via a SCADA Basic
script.

HMI > Trend viewer
12.0.24

Also in: 15.2.0, 15.1.3,
11.2.06101

Instruction VARIABLE mode GET_TYPE - Did not work with HMI

variables (SPR # 69337)
The instruction VARIABLE mode GET_TYPE returned an error when used with HMI variables.

Scripting > SCADA
Basic

12.0.24

Also in: 15.0.0
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Multiple animations executed at once (SPR # 69124)

All the Send or Run animations configured on a graphic item were triggered at once, without
considering their order. Now they are performed one after the other when successful and not
cancelled (if a Send Register animation is cancelled for example)

Web Server Extensions
> WebVue

12.0.24

Also in: 15.0.0

Could not deactivate the Network dongle role (SPR # 68063)

It was not possible to deactivate the property Network dongle role in the advanced tab of a
station.

Configuration
Environments >
Application Explorer
12.0.23

Setting FirstDayOfWeek not correctly taken into account (SPR # 69314,

68462)
The setting FirstDayOfWeek was not correctly taken into account in the Standard week display.

WebScheduler

12.0.23
Also in: 15.2.0, 15.2.0,
15.1.2,15.1.2

Fatal error on disconnection (SPR # 69276, 66623)

Under some circumstances, a fatal error could occur when disconnecting from an OPC Server.

Data Acquisition > OPC
Client

12.0.23

Also in: 15.2.0, 15.1.2

Incorrect aggregated value (SPR # 69283, 67600)

Under some circumstances, invalid aggregated values were exported. The issue occurred when
no record was found in the exported time period, causing a random value to be exported.

Data Export
12.0.23
Also in: 15.2.0, 15.1.2

Clipboard paste (SPR # 68372)

Better control of the clipboard Paste command to prevent side effects when the type of data
contained in the clipboard is not supported and not supposed to be pasted in a mimic.

HMI
12.0.23
Also in: 15.2.0, 15.1.2

Instruction MAPDISPLAY - Fatal error with modes LOADDEFAULT and
EXPORT (SPR # 69019)

Under some circumstances, a fatal error could occur when calling the modes LOADDEFAULT and
EXPORT in sequence.

Scripting > SCADA
Basic

12.0.23

Also in: 15.2.0, 15.1.1

OPC items with bad quality not ignored (SPR # 69148)

Since version 11.1, the setting defined in the OPC Server configuration that allows ignoring the
value of an item with quality Bad was not working properly with bit and alarm variables.

Data Acquisition > OPC
Client

12.0.23

Also in: 15.2.0, 15.1.1,
15.0.3, 11.2.06099

#V not resolved (SPR # 65319)

The #V substitution string was not resolved in the Trend viewer, preventing from using it in the
legend or Data export wizard.

HMI > Trend viewer
12.0.23

Also in: 15.1.0, 15.0.3,
11.2.06100

Unable to close mimics (SPR # 69069) HMI
Under circumstances, it was not possible to close mimics when the Cache property was enabled. 12.0.22
Alarm timestamps not saved (SPR # 69032) General
When an alarm was configured with the Saved property enabled, not all of its timestamps 12.0.22

(AlaOn, AlaAck, AlaOff) were stored. Only the timestamp of its last state was recorded. These
timestamps can be used in the Alarm viewer.

Also in: 15.2.0, 15.1.1,
15.0.3
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Fatal error with OPC Server interface (SPR # 68813) Communication

Under some circumstances, a fatal error could occur when using the OPC Server interface, due interfaces > OPC Server
to some resources not being released properly. 12.0.22

Also in: 15.2.0, 15.1.1,
15.0.3, 11.2.06099

Memory leak with array of strings (SPR # 68954) Data Acquisition > OPC
A memory leak occurred when variables were mapped to an OPC DA item of type array of Client
strings. The amount of leake memory depended on the size of the array.
12.0.22
Also in: 15.1.0, 15.0.3
Empty Alarm and Log viewers (SPR # 68670) TouchVue
Alarm and Log viewers displayed in a mimic in TouchVue remained empty even when there 12.0.22
were alarms and/or events to display. .
Displaying the same mimic in WebVue worked properly. Also in: 15.0.0, 12.1.0 Dev
29584

DBImport - Log suffix not correctly managed (SPR # 68868, 68864, 68744) Add-ons and Tools

When using the DBImport for importing logged events, the Log suffix was not correctly 12.0.21
managed, leading to incorrect import. i
¢ ¢ . Also in: 15.1.0, 15.1.0,

15.1.0, 15.1.0, 15.0.3,
15.0.3, 15.0.2, 15.0.2

Memory leak on modification of text extended attributes (SPR # 68634)  General

A memory leak occurred when writing text extended text attributes of a variable. 12.0.21
Also in: 15.1.0, 15.1.0,
15.1.0, 15.0.2, 15.0.2,
15.0.2

Timestamp type for IEC 104 Sectors (SPR # 68569) Configuration

It was not possible to configure the Timestamp type (UTC or Local) for IEC 104 Sectors modeled  Environments >

with the Application Architect. . . .
°p Application Architect

12.0.21
Also in: 15.1.0, 15.1.0,
15.0.2

Virtual keypad for user animations (SPR # 638669) HMI > Animations
The virtual keypad could not be used with some user animations (user name, signature ...). 12.0.21
Also in: 15.1.0, 15.1.0,
15.0.2,15.0.2

Setting FirstDayOfWeek not taken into account (SPR # 68462) WebScheduler

The setting FirstDayOfWeek defined in the web.config file was not correctly taken into account.  12.0.21
Starting from version 15, this setting can be set with the Web Deployment Console when

deploying the WebScheduler. Also in: 15.1.0, 15.1.0,
15.0.2, 15.0.2
Fatal error on web session opening (SPR # 68602) Web Server Extensions

A fatal error of the Web back end could occur when opening a web session if an alarm synthesis  12.0.21
was defined and the corresponding variable was missing in the configuration. .
Also in: 15.1.0, 15.0.2

Trends not displayed (SPR # 68698, 67972) Web Server Extensions
Trends were not displayed when the style of invalid points was set to Invisible. > WebVue
12.0.21

Also in: 15.1.0, 15.0.2
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PcVue >

Incorrect text encoding (SPR # 67999, 61478)

Some cultures relying on non-latin characters were not correctly managed by the
WebScheduler, leading to incorrect text display.

WebScheduler
12.0.21
Also in: 15.1.0, 15.0.2

HDS fatal error upon shutdown (SPR # 68338)

Under some circumstances, a fatal error of the HDS could occur upon project shutdown.

Historical data
12.0.20
Also in: 15.1.0

OPC-XML server not correctly created (SPR # 68568, 68486)

OPC-XML servers were not correctly created if modeled with the Application Architect. The Url
property was missing.

Configuration
Environments >
Application Architect
12.0.20

Also in: 15.1.0, 15.0.2

Masked alarm reappearing after passive server restart (SPR # 68378)
Under some circumstances, saved alarms were incorrectly reloaded when a passive server was
restarting. Specifically, their saved Masked status could be corrupted and trigger reappearance
or disappearance of such alarms upon a restart.

Alarms
12.0.20
Also in: 15.1.0, 15.0.1

SG-OPC - Incorrect server after synchronization (SPR # 68454)

Under some circumstances, an incorrect server was set after an import synchronization. The
issue occurred when multiples servers were configured and the selected server was different
from the first one.

Configuration
Environments > Smart
Generators

12.0.20

Also in: 15.1.0, 15.0.1

Fatal error on passive server (SPR # 68426)

A fatal error could occur when stopping a passive server due to pending reports not deleted
correctly.

Data Acquisition > IEC
61850 Client

12.0.20

Also in: 15.1.0, 15.0.1

Report groups disabled (SPR # 68460)

Under some circumstances, a report group was disabled after receiving a report that had the
buffer overflow flag set.

Data Acquisition > IEC
61850 Client

12.0.20

Also in: 15.1.0, 15.0.1

Fatal error when writing an SNMP variable (SPR # 68479)

Under some circumstances, a fatal error could occur when writing an SNMP variable.

Data Acquisition >
SNMP Manager
12.0.20

Also in: 15.1.0, 15.0.1

Memory leak on errors (SPR # 68511)

Under some circumstances, a memory leak could occur when facing connectivity issues with
devices refreshed by polling. Some polled read requests were not correctly freed after errors.

Data Acquisition >
SNMP Manager
12.0.20

Also in: 15.1.0, 15.0.1

HDS not stopping (SPR # 68314)

Under some circumstances, the HDS was not correctly stopped at project exit. The issue
occurred after having added a new trend associated to a long update rate, and the project exit
being triggered before the end of the first update period of the new trend.

Historical data
12.0.20
Also in: 15.1.0, 15.0.1

Initial value of new variables not loaded (SPR # 68578)

When updating a project version on a passive server, newly created variables (in this project
version) were not correctly initialized with their initial value after a server switchover.

Networking
12.0.20
Also in: 15.1.0, 15.0.1
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PcVue >

Multiple active servers in a single active server association (SPR #
68379)

In a single active server historical association, multiple servers could be active simultaneously
when started at the same time or after a network failure.

Networking
12.0.20
Also in: 15.1.0, 15.0.1

Instruction FOPEN - Fatal error with unknown access mode (SPR #
68097)

A fatal error could occur when using the instruction FOPEN with an unexpected access mode
argument.

Scripting > SCADA
Basic

12.0.20

Also in: 15.1.0, 15.0.1

Instruction WINDOW mode CLOSEALL - Mimics close failed (SPR #

68639)

The SCADA Basic instruction WINDOW mode CLOSEALL was not working properly in a web
context. Some mimics could fail to close and remained open.

Web Server Extensions
> WebVue

12.0.20

Also in: 15.1.0, 15.0.1

Incorrect cursor value (SPR # 68428)
The cursor value displayed in the Trend viewer was incorrect for curves whose rank was over 8.

HMI > Trend viewer
12.0.20
Also in: 15.0.0

BeforeClose script not triggered (SPR # 68418)

The SCADA Basic function called upon closing a mimic was not correctly triggered when the
mimic was closed via SCADA Basic.

This fix applies to PcVue desktop only.

Scripting > SCADA
Basic

12.0.20

Also in: 15.0.0

Trend viewer average value updated in historical mode (SPR # 67633)

In the Trend viewer legend, the average value of a paused/historical trend was incorrectly
updated based on real-time values.

Web Server Extensions
> WebVue

12.0.20

Also in: 15.0.0

Access to previous user session (SPR # 66317)
Under some circumstances, a session reuse could occur.

WebScheduler
12.0.20
Also in: 15.0.0

AD user login failure (SPR # 68106)

Active Directory users could not login after a restart of the computer and until it had reached
the Domain controller at least once. From now on, group SIDs are managed in addition to user
names and their associated groups.

General > User
management
12.0.20

Also in: 15.0.0, 15.0.0,
15.0.0

Fatal error upon HDS shutdown (SPR # 66900)

A fatal error could occur during shutdown when the HDS tried to record the exit invalid trend

points. It only occurred when one of the trend had no previous record available in the database.

Historical data

12.0.20

Also in: 15.0.0, 15.0.0,
15.0.0, 15.0.0, 15.0.0,
11.2.06095, 11.2.06095,
11.2.06094, 11.2.06094,
11.2.06094

Instruction SVLOG mode EXTRACT - Lines enclosed with double-quote

(SPR # 68234, 66631)

Since version 11.2.06066, every lines returned by the instruction SVLOG mode EXTRACT were
enclosed with double-quotes. This could cause compatibility issues with 3rd party software or
scripts used to parse the exported files.

Scripting > SCADA
Basic

12.0.20

Also in: 15.0.0, 15.0.0,
15.0.0, 11.2.06091,
11.2.06091, 11.2.06091

Reference: PcVue 12 Release Notes
Copyright ©2024 - ARC Informatique. All rights reserved — LI N0 H I3

Last update: November 3, 2025

Page 12/119



4
PcVue >

Instruction SVLOG - Last line missing in buffer (SPR # 68234)

When exporting data with the SCADA Basic instruction SVLOG, the last line was missing in the
exported buffer.

Scripting > SCADA
Basic

12.0.20
Also in: 15.0.0,
11.2.06097
Fatal error when closing a mimic (SPR # 67571) HMI
Under some circumstances, a fatal could occur when closing a mimic. The issue occurred when 12.0.20
trying to close a mimic while it is already being closed. For example, it could happen when -
mimic closure required the execution of a with VBA or SCADA Basic script taking some time to Also in: 15.0.0,
execute. 11.2.06094

Fatal error on the Web back end (SPR # 67721)

Under some circumstances, a fatal error could occur on a Web back end server, due a trace

message with an incorrect format. The issue could only occur when the Mimic Details trace level

was activated in the Web back end configuration.

Web Server Extensions
12.0.19

Ethernet/IP Add-on - Handling of large arrays (SPR # 68352)

The Ethernet/IP add-on did not handle large arrays of DWord correctly. If the array was larger
than 50 items, variables were always set to status NS (invalid).

Add-ons and Tools
12.0.19
Also in: 15.0.0

Unable to start BRCB on a newly active server after switchover (SPR #
68309)

In a configuration containing several IEC 61850 networks managed by the same server
association, the server switchover was not correctly processed for all produced networks. Some
networks remained active on the passive server, meaning that URCB/BRCB were not stopped,
and thus forbade the newly active server to start them.

Data Acquisition > IEC
61850 Client

12.0.19

Also in: 15.0.0

Incorrect quality if range dependent on other variables (SPR # 67969)

Under some circumstance, the quality of register variables could be incorrect. The issue only
occurred with OPC variables, when the variable range was defined by dependency to other
variables.

Data Acquisition > OPC
Client

12.0.19

Also in: 15.0.0

OPC-XML - Data types handling caused a fatal error (SPR # 67622)
Under some circumstances, a fatal error could occur when processing data received from an
OPC-XML server. The issue only occurred for data of type long, uint, ushort, ulong, if they were
not already converted on the OPC server side.

Data Acquisition > OPC
Client

12.0.19

Also in: 15.0.0

OPC-XML - Fatal error with a disconnected server (SPR # 65755)

A fatal error occurred when a GetStatus() request was sent to a disconnected server.

Data Acquisition > OPC
Client

12.0.19

Also in: 15.0.0
Fatal error with .ico file in B directory (SPR # 67904) HMI
A fatal error could occur when opening the Image selector on a library containing a .ico file. It 12.0.19
was due to an improper handling of the thumbnails for this type of files. Also in: 15.0.0

Incorrect display if Print format includes tabs (SPR # 67841)

Alarm viewer columns were incorrectly filled when the Print format was empty or set with
tabulation characters.

HMI > Alarm viewer
12.0.19
Also in: 15.0.0

Virtual keypad - Validate text input with key Enter (SPR # 66378, 65503)

Text input could not be validated by pressing the hardware keyboard key Enter (if any). The
input could only be validated with the OK button of the Virtual keypad.

HMI > Animations
12.0.19
Also in: 15.0.0

Blinking effect (SPR # 65506)

Fix of a blinking effect on the map control when a marker position was updated.

HMI > Map control
12.0.19
Also in: 15.0.0
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PcVue >

Fatal error on text color modification (SPR # 67988)
A fatal error could occur when editing the text color of a Text marker.

HMI > Map control
12.0.19
Also in: 15.0.0

Instruction VARIABLE mode ASSOCIATEDLABEL - Incorrect return
value (SPR # 67675)

The label name was returned instead of the label current value when the instruction VARIABLE
mode ASSOCIATEDLABEL was called for a variable of type Bit.

Scripting > SCADA
Basic

12.0.19

Also in: 15.0.0

Alarm viewer sorting not working with checkbox selection (SPR # 68143)

In WebVue, sorting was incorrectly done on the adjacent column when the Line selection mode
was set to By checkbox.

Web Server Extensions
> WebVue

12.0.19

Also in: 15.0.0

Web client no longer refreshed (SPR # 68066, 67305)

Under some circumstances, when using popup mimics, WebVue was no longer refreshed and
was disconnected after a while.

Web Server Extensions
> WebVue

12.0.19

Also in: 15.0.0

Instruction EXPORT_LOG mode GETSTATISTIC - Sort order argument
ignored (SPR # 68221, 68211)

The argument StatSortOrder was not correctly taken into account when using the instruction
EXPORT_LOG mode GETSTATISTIC.

No error was returned when passing an inappropriate value, and with a correct value, it was not
taken into account and sorting was not effective.

Scripting > SCADA
Basic

12.0.19

Also in: 15.0.0, 15.0.0

Fatal error when configuring a license renter station (SPR # 67689,
67090)

A fatal error of the Application Explorer occurred when modifying the configuration of a station
to make it a license renter. The issue occurred if no license owner station was configured, or if
the owner station had been previously deleted.

Configuration
Environments >
Application Explorer
12.0.19

Also in: 15.0.0, 15.0.0,
15.0.0, 15.0.0, 15.0.0

Mimic design screen resolution no longer forced to 1440*900 (SPR #
66529)

Mimic generated with the Application Architect were always configured with the resolution
1440*900 for the property Design screen resolution. They are now using the active resolution at
the time of the generation.

Configuration
Environments >
Application Architect
12.0.19

Also in: 15.0.0, 12.1.0 Dev
29584

Fatal error on exit (SPR # 66105)

A fatal error occurred upon exit when using frames of type Info or Command not set to the
maximum size.

Data Acquisition >
Other built-in drivers
12.0.19

Also in: 15.0.0, 12.1.0 Dev
29584, 11.2.06088

Host name resolved even when communication not started (SPR #
66228)

Resolution of the hostname of an SNMP device was executed even when the device was not
started. Hostname resolution is now executed only when data acquisition is started for the
device.

Data Acquisition >
SNMP Manager

12.0.19

Also in: 15.0.0, 12.1.0 Dev
28713, 11.2.06084
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PcVue >

Trends not displayed correctly on large screens (SPR # 63081) HMI > Trend viewer

Curves were not rendered properly if the Trend Viewer was larger than 3200 pixels. 12.0.19
Also in: 15.0.0,
11.2.06095

OPC watchdog treatment not fully executed (SPR # 66922) Real time data

Under some circumstances, watchdog treatment on OPC variables was not working properly 12.0.19

and only part of the variables were set to NS WD on watchdog failure. .
Also in: 15.0.0,
11.2.06091

Hidden control zone (SPR # 68024) Web Server Extensions

Control zone highlight was not properly hidden when the control zone itself was hidden because >~ WWebVue
it belonged to a hidden group or symbol.

12.0.18
Animation not triggered (SPR # 67697) Web Server Extensions
When a symbol was part of a group, its animations were not correctly triggered on mouse-click. > \WebVue

12.0.18

Also in: 15.0.0
Trend viewer toggle button show/hide (SPR # 67701) Web Server Extensions

The toggle button to show/hide curves (in the legend) was not working properly when trends > WebVue
were dynamically set via SCADA Basic instruction TREND mode SETVAR.

12.0.18

Also in: 15.0.0
Event OnSelectionChanged improperly triggered in Combo-box (SPR # HMI > Form controls
68123) 12.0.18
The event OnSelectionChanged was improperly triggered in the Combo-box control when Also in: 15.0.0, 15.0.0

navigating in the dropdown list using the keypad. It is now only triggered upon validation of the
new item selection.

Textbox control not initialized with variable content (SPR # 67452) HMI > Textbox control
The Textbox control was not correctly initialized with the value of a variable when used in a 12.0.18

mimic with a branch. Also in: 15.0.0, 15.0.0

Tooltip displayed for hidden buttons (SPR # 68024, 67993) Web Server Extensions
The tooltip was displayed on graphic objects, even if it was hidden due to a Visibility animation. >~ WebVue

12.0.18

Also in: 15.0.0, 15.0.0
Function Keys configuration lost (SPR # 68051) General
Since version 12.0.16, Functions Keys configuration was lost after restarting a project. 12.0.17

Web component not correctly deployed on older operating systems (SPR Deployment tools >

#67994) Web Deployment

The Web components were not correctly deployed by the WDC on operating systems using IIS Console
7.5 or lower, which include Windows 7, Windows Server 2008 and Windows Server 2008 R2.

This was due to the use of the applicationinitialization element in the IIS configuration (only 12.0.17
supported from IIS 8.0 onward). Also in: 15.0.0
Fatal error on symbol edition (SPR # 67832) HMI

Under some circumstances, a fatal error could occur when modifying symbol sub-objects viathe 12.0.17
Graphic Explorer. .
Also in: 15.0.0

VBA event KeyPressed not triggered (SPR # 68045) HMI > Grid control

The VBA event KeyPressed of the Grid Control was not triggered when pressing an arrow key if 12.0.17
the key was associated to a Function Key action. .
Also in: 15.0.0
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PcVue >

Instruction KEY mode ADDPROG and ADDPROGS - Failure with key

code greater than 26

The SCADA Basic instruction KEY with modes ADDPROG and ADDPROGS failed when the key
code was greater than 26.

Scripting > SCADA
Basic

12.0.17

Also in: 15.0.0

Fatal error on browse request by a web client (SPR # 67983)

Under some circumstances, a fatal error could occur when the configuration of a variable was
modified while a browse request was being processed for a web client.

Web Server Extensions
12.0.17
Also in: 15.0.0

Fatal error when closing a web session

Under some circumstances, a fatal error could occur when closing a web client session. The
issue could be reproduced if an Alarm Syntheses was configured with the option Take the
applied Population into account, and if the value of an extended attribute was changed while
closing the web session.

Web Server Extensions
12.0.17
Also in: 15.0.0

Fatal error at startup (SPR # 68005)

Under some circumstances, a fatal error could occur at network startup on projects with a large
number of BACnet devices among which some are disconnected.

Data Acquisition >
BACnet Client
12.0.17

Also in: 15.0.0, 15.0.0

Could not filter alarms with level 0 only (SPR # 67821)

It was not possible to filter real time alarms with level 0 only (minLevel=0 and maxLevel=0). With
such requests, the maxLevel parameter was automatically set to 29.

This issue only affected web components with alarm filtering capabilities (WebVue, Web
Services Toolkit and TouchVue).

Web Server Extensions
12.0.17
Also in: 15.0.0, 15.0.0

Impossible to restore communication despite time-out errors (SPR #
67881)

Under some circumstances, the communication with some TCP/IP devices could not be restored
despite multiple time-out errors. The issue was due to the PLC not responding to requests while

the underlying socket was still in an Ok state.

From now on, after a period of 180 sec in time-out error, it is possible to force a close of the
socket, which is then re-opened at the next retry.

To activate this behavior, the following keys must be added in the file C\EqtConf.ini:
[TCPIP]

EnableCloseOnConsecutiveTimeOut = 1

MaxConsecutiveTimeOutInSec = 180

Data Acquisition >
Other built-in drivers
12.0.17

Also in: 15.0.0,
11.2.06097

Opening a mimic containing the Grid Control (SPR # 67930)

When using the Grid Control with the Variable Tracking mode activated, the height of each row
was unnecessarily stored in the mimic (or symbol) file. It was leading to an unusual long time to
open the mimic, and could lead to a fatal error in some cases (due to timeout errors).

HMI > Grid control
12.0.17

Also in: 15.0.0,
11.2.06095

Trends not displayed upon request to the archives (SPR # 66731)

Under some circumstances, trends could disappear and no longer be displayed when requesting
historical data. The issue occurred when a real time value (for one of the displayed variables)
was received while processing the historical data.

HMI > Trend viewer
12.0.17

Also in: 15.0.0,
11.2.06095

Memory leak when changing a threshold on a passive server (SPR #
68034)

Scripting > SCADA
Basic

Under some circumstances, a memory leak could occur when executing the instruction 12.0.17

VARIABLE mode THRESHOLD_SETVALUE on a passive server. .
Also in: 15.0.0,
11.2.06095

Associated actions and context mimic not accessible (SPR # 67797) HMI

Under some circumstances, associated actions and context mimic were not accessible from a 12.0.17

log or alarm viewer. The issue only occurred when the mimic was opened via a SCADA Basic -

script executed at startup. Also in: 15.0.0,
11.2.06094
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PcVue >

Incorrect value and boundaries for System.Localhost.Session.Type (SPR
#67957)

The variable System.Localhost.Session.Type had an incorrect low boundary, O instead of -1, and
was wrongly set to -1 where the value should have been 104 when a client was connected using
the Web Services Toolkit.

The same fix applies to the values returned by the SCADA Basic instruction SESSION mode
GETTYPE.

Audit
12.0.16
Also in: 15.0.0

Instruction KEY modes ADDPROG, ADDCLK and ADDSTD - Existing key
not replaced (SPR # 67955)

When creating a new function key action with the SCADA Basic instruction KEY modes
ADDPROG, ADDCLK or ADDSTD, an existing definition of the key combination was not replaced
by the new one, leading to the execution of both actions when triggered.

As described in the help, any existing definition of a temporary key is now replaced, and the
instruction returns an error if the existing key is permanent (configured) and cannot be replaced
by script at runtime.

Scripting > SCADA
Basic

12.0.16

Also in: 15.0.0, 15.0.0,
15.0.0

Upgrade Alarm synthesis default property value (SPR # 67799, 66701)

The default value of the property Take the applied population into account of Alarm Syntheses
items is False since version 11.2 Release.

This new default value was mistakenly not applied to Alarm syntheses created with the
Application Architect. It is now applied.

This change may introduce a behavior change in the way alarm syntheses are calculated in some

Configuration
Environments >
Application Architect
12.0.16

projects. Please refer to the Known issues section for more information. Also in: 15.0.0,
11.2.06094
Context mimic with variables attributes (SPR # 67261) HMI
Since version 12.0, it was possible to open a context mimic from a graphic object animated with 12 (.15
a variable attribute such as #_Q, #_T or TATTx#. Such mimics only support a context based on a -
variable value. Alsoin: 15.0.0
Fatal error when opening mimics in binary format (SPR # 66783) HMI
Under some circumstances, a fatal error could occur when opening a mimic due to some objects 12.0.15
being loaded twice. i
¢ Also in: 15.0.0
Graphical interface frozen (SPR # 67045) HMI
Under some circumstances, the graphical interface could freeze due to the use of AVl or GIF 12.0.15
objects in mimics. The loading and display of these objects is now optimized to avoid an .
overconsumption of CPU resources. Also in: 15.0.0
Residual objects displayed with large preview (SPR # 67062) HMI
Some residual objects were displayed in images and symbols selectors when using large 12.0.15
preview. .
Also in: 15.0.0

Incorrect position of a symbol in design mode (SPR # 67570)

In design mode, a symbol at an absolute position was incorrectly anchored in the Map Control.

HMI > Map control
12.0.15
Also in: 15.0.0

Instruction SQL_COMMAND mode READBUFFERCELL - Empty cells
were ignored (SPR # 67266)

String cells having a NULL value were ignored and skipped when using the instruction
SQL_COMMAND with the mode READBUFFERCELL. They are now interpreted as empty strings.

Scripting > SCADA
Basic

12.0.15

Also in: 15.0.0

Instruction TREND mode SETVAR - Variable description not updated
(SPR # 66637)

In a WebVue context, the variable description was not updated in the legend when the curve
was modified with the SCADA Basic instruction TREND mode SETVAR.

Web Server Extensions

> WebVue
12.0.15
Also in: 15.0.0
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PcVue >

Several fixes & enhancements to TouchVue (SPR # 67297, 66946, 66697,
66640, 65853, 65370)
The list of fixes & enhancements includes:

®  Under some circumstances, mimics could freeze,

®  Under some circumstances, users could not logout nor login,

®  Some variable commands were not correctly triggered when embedded in object
groups, symbols or mimic tab,

® Incorrect error messages were displayed after unsubscribing a variable.

TouchVue

12.0.15

Also in: 15.0.0, 15.0.0,
15.0.0, 15.0.0, 15.0.0,
15.0.0, 12.1.0 Preview 03,
12.1.0 Dev 29935, 12.1.0
Dev 29584, 12.1.0 Dev
29584, 12.1.0 Dev 28713

Driver SAIA - Equipment not correctly initialized (SPR # 67443)

At startup, some devices were not correctly initialized and connection could not be established.
Startup of devices is now serialized to enforce a proper initialization.

Data Acquisition >
Other built-in drivers
12.0.15

Also in: 15.0.0,
11.2.06093

Fatal error with redundant servers (SPR # 67440)

Under some circumstances, a fatal error could occur due to trap handling in redundant server
set-up.

Data Acquisition >
SNMP Manager
12.0.15

Also in: 15.0.0,
11.2.06093

Error message displayed when opening a map (SPR # 66956)

Under some circumstances, an error message could be raised when displaying a map at project
startup, due to execution synchronization issues.

HMI > Map control
12.0.15

Also in: 15.0.0,
11.2.06093

License for version 15 not recognized by PcVue version 12

Some licenses shipped during Q2 2021 for version 15 were not recognized by PcVue version 12.
It was a known issue since 12.0.7 (Initial Release).

General > Licensing
12.0.14

Fatal error with a variable name used in a tooltip (SPR # 67020)

A fatal error occurred when a variable with a name longer than 80 characters was used in a
tooltip.

HMI > Animations
12.0.14
Also in: 15.0.0

Fatal error when opening a web client (SPR # 67012)

Under some circumstances, a fatal error of the web back end station could occur when running
a WebVue client. This issue was due a synchronization issue with the server.

Web Server Extensions
> WebVue

12.0.14

Also in: 15.0.0

File & Folder filter for Project version not correctly saved (SPR # 68848,
66794)

Under some circumstances, the file selection configured in the central project management was
not correctly saved. The issue could occur in particular when selecting the All files in project
directory checkbox at the project root level.

General > Version
management

12.0.14

Also in: 15.0.0, 15.0.0,
15.0.0, 12.1.0 Preview 02,
12.1.0 Preview 02,
11.2.06099, 11.2.06099

Invalid OPC variables after switchover (SPR # 66837, 66655)

Under some circumstances, variables mapped to OPC items could remain invalid after a data
acquisition server switchover if errors occurred during the switchover.
The issue affected:

®  Versions 11.2.06781 to 11.2.06793,
®  Allreleases of 12.0 up to 12.0.14.

Data Acquisition > OPC
Client

12.0.14

Also in: 15.0.0,
11.2.06092
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PcVue >

Incorrect filtered list of alarms in Alarm viewer (SPR # 67009)

Under some circumstances, the alarms displayed in an Alarm viewer did not match the expected
filter. It could occur if a filter was applied using VBA while quickly opening and closing mimics.

HMI > Alarm viewer
12.0.14

Also in: 15.0.0,
11.2.06091

IEC 104 variables not refreshed (SPR # 66723)

Under some circumstances, some IEC 104 variables could not be refreshed at startup or on
server switchover.

Data Acquisition > IEC
60870-5 Client
12.0.13

Incorrect colors in Trend viewer (SPR # 66754)

Under some circumstances, color of traces were incorrect in a Trend viewer. The issue occurred
when a trend historical request was executed while another one was still in progress.

Web Server Extensions
> WebVue

12.0.13

Also in: 15.0.0

Populations not correctly applied to HDS log lists (SPR # 66699)

Under some circumstances, populations were not correctly applied to HDS log lists in Log
Viewer, leading to an empty display. The issue occurred when multiple criteria were applied to
the same attribute.

Historical data
12.0.13

Also in: 15.0.0, 15.0.0,
12.1.0 Preview 03

Fatal error with symbol containing a Trend viewer (SPR # 66968)

A fatal error occurred when manipulating a symbol containing a Trend viewer with the option
Save runtime properties activated.

HMI

12.0.13

Also in: 15.0.0, 15.0.0,
12.1.0 Preview 03, 12.1.0
Preview 03

ActiveX controls based on .Net loaded twice (SPR # 66858) HMI

ActiveX controls based on .Net components were loaded twice. 12.0.13
Also in: 15.0.0, 12.1.0
Preview 03

Unable to edit symbol from the Graphic Explorer (SPR # 66665) HMI

Under some circumstances, it was not possible to edit a symbol directly from the Graphic 12.0.13

lorer. The i d when th h int of bol invalid.

Explorer. The issue occurred when the anchor point of a symbol was invali Also in: 15.0.0, 12.1.0

Preview 03

Images not stretched (SPR # 66947, 65941)

The option Stretch image was not taken into account when rendering images used in Images
animations (e.g.: Image on Bit).

Web Server Extensions
> WebVue

12.0.13

Also in: 15.0.0, 12.1.0
Preview 03

Fatal error with included mimics (SPR # 66854)

A fatal error occurred when an included mimic was opened with a Link open animation when
the parent mimic was named explicitly (instead of using the * character).

Web Server Extensions
> WebVue

12.0.12

Also in: 15.0.0, 15.0.0,
15.0.0, 12.1.0 Preview 02,
12.1.0 Preview 02, 12.1.0
Preview 02

Code page displayed in string values (SPR # 66842)

When the code page was different from UTF-8, string values were prefixed with the applied
code page (UCS-2, DBCS...).

Data Acquisition >
BACnet Client
12.0.12

Also in: 15.0.0, 12.1.0
Preview 02
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PcVue >

Time-out on variable initialization (SPR # 66803) Data Acquisition >
Under some circumstances, a time-out could occur when initializing DNP3 variables. DNP3 Client
12.0.12
Also in: 15.0.0, 12.1.0
Preview 02
Fatal error when exiting the VCR mode (SPR # 66773) Historical data > VCR

Under some circumstances, a fatal error could occur when exiting PcVue if running in VCR mode  12.0.12

and while playing records. Also in: 15.0.0, 12.1.0
Preview 02

Alarm viewer with first column empty (SPR # 66855, 59115) Web Server Extensions

A fatal error of the web back end occurred when displaying a mimic in WebVue if it contained > WebVue
an alarm viewer with the first column configured to be empty.

12.0.12
Also in: 15.0.0, 12.1.0
Preview 02
Object flickering with translation animation (SPR # 66725) Web Server Extensions
In WebVue, graphic objects were flickering when configured with a translation animation and > WebVue
rendered partly outside of the visible window.
12.0.12
Also in: 15.0.0, 12.1.0
Preview 02
SCADA Basic script not executed on mimic opening (SPR # 66785, Web Server Extensions
66340) > WebVue
SCADA Basic script on mimic opening were not executed in WebVue when the mimic was 12.0.12

containing an empty Trend viewer.

Also in: 15.0.0,12.1.0
Preview 02

Send and Link animations not available on transparent graphic objects = Web Server Extensions
(SPR # 66577, 66327) > WebVue

Send and Link animations were not executed when configured on an object with invisible border 12.0.12
and background. The control zone was not active nor displayed. .
Also in: 15.0.0, 12.1.0

Preview 02

Translation animation with improper control zone (SPR # 66230) Web Server Extensions

Graphic objects configured with a translation animation were always highlighted with a control > WebVue
zone even if the cursor mode was not activated on the animation. 12.0.12

Also in: 15.0.0, 12.1.0
Preview 02

Trends not set with SCADA Basic instruction (SPR # 66340) Web Server Extensions

Opening a mimic and defining trends with the SCADA Basic instruction SETVAR in the same > WebVue
script was not working properly. 12.0.12

Also in: 15.0.0, 12.1.0
Preview 02

Fatal error when loading the content file of a tree view (SPR # 66779) HMI > Form controls

A fatal error occurred when updating the content of a tree-view control by loading a content file  12.(0.12
defined by a variable link. The initial loading worked properly, the issue occurred when loading .
another file including items with animations. Also in: 15.0.0, 12.1.0

Preview 02, 11.2.06091
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PcVue >

Trend viewer runtime configuration lost (SPR # 66736)
The runtime configuration of Trend viewer was not correctly saved with branched mimics.

HMI > Trend viewer
12.0.12

Also in: 15.0.0, 12.1.0 Dev
29935

Instruction CIMWAY mode READFRAME - Fatal error when read request

failed (SPR # 66607)

A fatal error could occur when a read request triggered by the instruction CIMWAY mode
READFRAME failed.

Scripting > SCADA
Basic

12.0.12

Also in: 15.0.0, 12.1.0 Dev
29935

Blinking colors not working in animation (SPR # 66679)

Blinking colors were not correctly supported in an animation when changing from blinking to
fixed color.

Web Server Extensions
> WebVue

12.0.12

Also in: 15.0.0, 12.1.0 Dev
29935

Blinking colors with indexed colors (SPR # 66091)

Blinking colors were not properly displayed on text objects when using indexed colors.

Web Server Extensions
> WebVue

12.0.12

Also in: 15.0.0, 12.1.0 Dev
29935

Trend viewer runtime properties lost (SPR # 66648)

The runtime properties of Trend viewer was lost when a curve's label contained a comma.

HMI > Trend viewer
12.0.12

Also in: 15.0.0, 12.1.0 Dev
29935, 11.2.06090

Fatal error on frame modification (SPR # 66627)
A fatal error could occur when modifying a frame while the communication was starting.

Data Acquisition >
Other built-in drivers
12.0.11

Also in: 15.0.0, 15.0.0,
12.1.0 Dev 29584

Send Bit animation - Mode Handled and Pulse reworked (SPR # 66459,
66439, 66334)
The Send Bit animation has been reworked, in particular the modes Handled and Pulse:

®  With Handled mode, the bit value was not reverted when the mimic lost focus,

®  Pulse mode was executed only when the HMI option Mimic.Animations.Send
bit.Handled & Pulse execution was set to Standard.

Web Server Extensions
> WebVue

12.0.11

Also in: 15.0.0, 15.0.0,
12.1.0 Dev 29584, 12.1.0
Dev 29584

Fatal error when creating a variable (SPR # 66630)

Under some circumstances, a fatal error could occur when creating a variable. The issue

occurred when a branch segment of the variable was used in another branch previously deleted

(e.g. B1.B2 and B2.B3).

Configuration
Environments >
Application Explorer
12.0.11

Also in: 15.0.0, 12.1.0 Dev
29935

Associated labels not correctly displayed with mismatching label type
(SPR # 66371)

Under some circumstances, the displayed associated label was incorrect. The issue occurred

when the compatibility setting Allow use of mismatched associated label type was enabled, with

a variable of type alarm configured with a Bit Associated Label.

HMI > Animations
12.0.11

Also in: 15.0.0, 12.1.0 Dev
29584
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PcVue >

Background image position (SPR # 66458)

Background image settings were not correctly interpreted in the Chart Control, leading to an
incorrect positioning of the image.

HMI > Chart control
12.0.11

Also in: 15.0.0, 12.1.0 Dev
29584

Time filter wrongly disabled in the Log viewer (SPR # 66606)

The Time filter in the Log viewer was incorrectly disabled if the access to filtering options was
disabled.

Web Server Extensions
> WebVue

12.0.11

Also in: 15.0.0, 12.1.0 Dev
29584

Fatal error when displaying libraries of mimics or symbols thumbnails

(SPR # 66499, 66480)

A fatal error of the Library Explorer, the Application Explorer or the Application Architect
occurred when changing the displayed library of mimics and/or symbols if in thumbnails display
mode.

Configuration
Environments

12.0.11

Also in: 15.0.0, 12.1.0 Dev
29584, 11.2.06088

#x substitution with free archive units

The substitution #x (timestamp quality) did not work properly when used to record logged
events on free archive units.

Historical data

12.0.11

Also in: 15.0.0, 12.1.0 Dev
29584, 11.2.06087

Font not properly initialized (SPR # 66411)

Under some circumstances, when using the ASCII format, text fonts were not properly
initialized. Consequently, the text graphic item failed to load and display.

HMI > Graphics

12.0.11

Also in: 15.0.0, 12.1.0 Dev
29584, 11.2.06087

Fatal error upon modification of Equipment configuration (SPR # 66627)

Under some circumstances, a fatal error could occur when modifying the configuration of an
Equipment or a Frame while Communication was starting.

Data Acquisition >
Other built-in drivers
12.0.11

Also in: 12.1.0 Dev 29584

Calendar dialog box not modal (SPR # 66099)

The calendar dialog box of the Trend viewer could be improperly hidden behind the mimic. It is
now managed correctly as a modal dialog.

Web Server Extensions
> WebVue

12.0.10

Also in: 15.0.0, 12.1.0 Dev
29584

Lost control zones (SPR # 66209)

Control zones were lost on polygons after executing them once.

Web Server Extensions
> WebVue

12.0.10

Also in: 15.0.0, 12.1.0 Dev
29584

Issue when changing the binding (SPR # 65998, 65964)

When changing the binding of a web site, the Registry service endpoint was not properly re-
configured, preventing the web site from being operational.

The workaround was to delete and recreate the web site or to modify the WDC configuration
file manually.

It was a known issue since 12.0.7 (Initial Release).

Deployment tools >
Web Deployment
Console

12.0.10

Also in: 15.0.0, 15.0.0,
15.0.0, 12.1.0 Dev 29584,
12.1.0 Dev 28713, 12.1.0
Dev 28713
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PcVue >

Smart Generator for Wago - Incorrect mapping (SPR # 66348, 65717)
The last variable of a frame was incorrectly mapped if the last available index in the frame did
not fit the size of the data point to map.

The issue occurred in particular when the last data point to map was of type REAL.

Configuration
Environments > Smart
Generators

12.0.10

Also in: 15.0.0, 15.0.0,
12.1.0 Dev 29584, 12.1.0
Dev 28713, 11.2.06087,
11.2.06086

Incorrect behavior of the send register animation (SPR # 66236)

If a user double-clicked on a send register animation (instead of a single click), WebVue
improperly opened an empty confirmation dialog box that the user could not close.

Web Server Extensions
> WebVue

12.0.10

Also in: 15.0.0, 12.1.0 Dev
29584

Failed to import multiple events (SPR # 66361, 66158)

Importing multiple events on variable at once failed if the last part of their name was identical.
The issue could be reproduced when generating multiple instances of a template comprising an
event with the Application Architect.

Development kits >
XML Generic Import
Toolkit

12.0.10

Also in: 15.0.0, 12.1.0 Dev
29584, 11.2.06086

Instruction WINDOW mode IS_OPEN - Handling of the '*' (SPR # 66337)

Using the value '*' for the branch argument when calling the instruction WINDOW mode
IS_OPEN no longer worked.
This issue was a regression introduced in version 11.2.06048.

Scripting > SCADA
Basic

12.0.10

Also in: 15.0.0, 12.1.0 Dev
29584, 11.2.06086

Missing warning if PcVue is not running (SPR # 66092)

No warning was displayed when launching a configuration tool (including the Application
Explorer, Application Architect and Smart Generators) while the PcVue main process (Sv32.exe)
was not running.

It was a regression affecting version 12.0 Initial and Maintenance Releases.

Configuration
Environments

12.0.10

Also in: 15.0.0, 12.1.0 Dev
28713

Fatal error at startup (SPR # 66066, 66017)

A fatal error occurred at startup of the Web Deployment Console if the computer name had
been changed at the operating system level.

This was a known issue since 12.0.7 (Initial Release).

Deployment tools >
Web Deployment
Console

12.0.10

Also in: 15.0.0, 12.1.0 Dev
28713

Could not load or generate log reports (SPR # 66341, 62750)

It was not possible to load or generate log reports from a station using a server license. This
change also fixes an issue related to user rights for log reports (as defined in the Window tab of
a user profile).

Historical data

12.0.10

Also in: 15.0.0, 12.1.0 Dev
28713, 11.2.06086

Issue with long string literals (SPR # 66255)

Using a string literal with a size longer than 80 characters generated a memory overrun that
could lead to a PcVue fatal error.

Scripting > SCADA
Basic

12.0.10

Also in: 15.0.0, 12.1.0 Dev
28713,11.2.06086
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PcVue >

Instruction LOGDISPLAY mode FILTER - Fatal error with multiple INC
clauses (SPR # 66217)

A fatal error occurred when using a filter having multiple INC clauses and using the % wildcard.
e.g.: =(#A1 INC %Domain%) && (#A2 INC %Nature%)

Scripting > SCADA
Basic

12.0.9

Also in: 15.0.0, 12.1.0 Dev
28713

Web client frozen after closing foreground mimic (SPR # 66179)

Under some circumstances, the web client could freeze after closing a foreground mimic when
another foreground or modal mimic was opened.

Web Server Extensions
> WebVue

12.0.9

Also in: 15.0.0, 15.0.0,
15.0.0, 12.1.0 Dev 28713,
12.1.0 Dev 28713, 12.1.0
Dev 28713

Web client frozen with modal mimic in background (SPR # 66037)

Under some circumstances, after opening a mimic from a modal mimic, the web client could
freeze due to the modal mimic being moved to background and no longer being accessible.

Web Server Extensions
> WebVue

12.0.9

Also in: 15.0.0, 15.0.0,
12.1.0 Dev 28713, 12.1.0
Dev 28713

Zoom actions not working in the Trend Viewer (SPR # 66048)

Under some circumstances, the zoom actions of the Trend Viewer were not working properly.

Web Server Extensions
> WebVue

12.0.9

Also in: 15.0.0, 15.0.0,
12.1.0 Dev 28713, 12.1.0
Dev 28713

Fatal error with image and symbol selectors (SPR # 66005)

It was possible to try to insert an image or a symbol using the corresponding selector even if no
mimic was open, causing a fatal error.

HMI

12.0.9

Also in: 15.0.0, 12.1.0 Dev
28713

Mimic incorrectly resized and positioned when switching to Design
mode (SPR # 66196)

Under some circumstances, when switching a mimic from runtime to design mode, its size and
position were incorrectly recalculated due to screen resolution adaptation.

HMI

12.0.9

Also in: 15.0.0, 12.1.0 Dev
28713

Misleading message displayed (SPR # 66068)

When a web back end endpoint was configured but the corresponding feature was not installed,
a misleading message was displayed at startup: "No configuration found for the backend. Use
web deployment console to deploy" instead of indicating that the feature was not installed.

Web Server Extensions
12.0.9

Also in: 15.0.0, 12.1.0 Dev
28713

Incorrect blinking color on alarms (SPR # 66111)

Under some circumstances, the blinking color of graphical items remained even after a status
change of the alarm, typically after its acknowledgment.

Web Server Extensions
> WebVue

12.0.9

Also in: 15.0.0, 12.1.0 Dev
28713

Memory leak with Trend Logs (SPR # 66205)

A significant memory leak occurred when retrieving Trend Logs.

Data Acquisition >
BACnet Client

12.0.9

Also in: 15.0.0, 12.1.0 Dev
28713, 11.2.06084
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PcVue >

BACnet helpers frozen

Under some circumstances, BACnet helpers and the Application Explorer could freeze after
having selected a BACnet variable which object-type is defined by its numeric Id.

Configuration
Environments >
Application Explorer
12.0.9

Also in: 15.0.0, 12.1.0 Dev
28713, 11.2.06078

Reports not processed in case of large datasets (SPR # 66118)

Reports were not handled properly when associated to a dataset with more than 150 members.

The fix is validated with up to 1000 dataset members associated to a Report Control Block.

Data Acquisition > IEC
61850 Client

12.0.8

Also in: 15.0.0, 15.0.0,
15.0.0, 12.1.0 Dev 28713,
12.1.0 Dev 28713

Incorrect OPC values returned (SPR # 66161)

Under some circumstances, OPC items could not be read correctly by OPC clients, in particular
when requesting a group containing invalid or unknown items.

Communication
interfaces > OPC Server
12.0.8

Also in: 15.0.0, 12.1.0 Dev
28713, 11.2.06083

VBA form issue with the map control (SPR # 65854)

Under some circumstances, when a VBA form was open on top of a map control, it could
happen that mouse events were trapped by the map control, thus preventing correct user
interaction in the VBA form.

HMI > Map control
12.0.8

Also in: 15.0.0, 12.1.0 Dev
28713, 11.2.06082

Fatal error when importing variables (SPR # 64677)

Under some circumstances, when the auto-number internal identifiers (variable tagname)
setting was not activated, a fatal error could occur when importing variables with the SCADA
Basic instruction VARIABLE modes IMPORTFILE or IMPORTBUFFER.

Scripting > SCADA
Basic

12.0.7

Also in: 15.0.0, 12.1.0 Dev
28713,12.1.0 Dev 28713,
11.2.06081, 11.2.06080
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PcVue >

3.  Critical fixes

Several fixes in the IEC 61850 client driver (SPR # 67463)
Fixes are related to the handling of communication object stop/start and includes:
®  Fix of a fatal error that occurred when changing the configuration of several variables
linked to IEC 61850 report or dataset. The issue could be reproduced when doing an
Application Architect synchronization with IEC 61850 devices connected and
communicating actively.
®  Variable updates could be frozen for 1 minute upon redundant data acquisition server
switch from active to passive.
®  Failure to reconnect to URCB or BRCB upon redundant data acquisition server switch
from active to passive.

Data Acquisition > IEC
61850 Client

12.0.16

Also in: 15.0.0,
11.2.06094

Invalid trend point on shutdown (SPR # 71407, 71324, 71311)

When using an HDS archive unit, the invalid point (quality 64) was no longer stored when
shutting down PcVue.
The issue was a regression introduced in Maintenance Releases 12.0.26 and 15.2.1.

Historical data
12.0.28

Also in: 16.0.0, 15.2.4,
15.2.4

Control animations not executed (SPR # 70070, 69124)

Since Maintenance Release 12.0.24, control animations in mimics were not executed if rendered
in Web & Mobile clients. The issue affected WebVue and TouchVue.
This is a known issue in 12.0.24.

Web Server Extensions
12.0.25

Memory leaks (SPR # 69240, 69217)

Memory leaks occurred when Web or Mobile clients were connected.
The issue was a regression since release 15.0.0.

Web Server Extensions
12.0.24

Also in: 15.2.0, 15.2.0,
15.2.0, 15.2.0, 15.1.1,
15.1.1

Loss of variables (SPR # 68541, 66899)

Under some circumstances, session context and client context variables were lost when a Web
user logged in.

The issue only occurred if the compatibility setting Auto-number internal identifiers was
disabled.

Web Server Extensions
> WebVue

12.0.20

Also in: 15.0.0, 12.1.0
Preview 03

Unable to restart serial communication (SPR # 67037)

Since version 12, it was no longer possible to restart a serial communication after stopping it.
The application had to be restarted to correctly reinitialize the COM port.

Data Acquisition >
Other built-in drivers
12.0.15

Also in: 15.0.0

Emergency purge not executed (SPR # 67005)

Since version 12.0, the emergency purge was no longer executed properly. In addition, if no
scheduled purge was configured, the issue could lead to potential storage issues and changes no
longer recorded.

Historical data
12.0.13
Also in: 15.0.0

Empty result when Population applied to an HDS log list (SPR # 66699)

Since version 12.0 release, when a population was applied to an HDS log list, no result was
returned nor displayed.

Historical data
12.0.13
Also in: 12.1.0 Preview 03

Polling stopped after 25 days (SPR # 66766)

The cyclic polling mechanisms used by the IEC 61850 data acquisition driver stopped working
properly after a period of 25 days. It was necessary to restart the application to recover a
correct behavior.

The affected mechanisms were the following:

Polling of Datagroup (all versions affected),

Polling of DataSet (all versions affected),

Polling of watchdog (all versions affected),

Cyclic attempt to reconnect a disconnected device (all versions affected),
Cyclic re-synch Gl for reports (affected since version 11.2),

Cyclic attempt to reconnect disconnected reports (affected since version 11.2).

Data Acquisition > IEC
61850 Client

12.0.12

Also in: 15.0.0, 12.1.0 Dev
29935, 11.2.06090
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PcVue >

Session context not taken into account in RealTimeData service (SPR #
66609, 66410)

Session context was not correctly managed in the RealTimeData service of the WST. As an
example, the USER variable was returning the name of the user logged on the back end hosting
the services (if any) instead of the name of the user authenticated as part of the WST session.

Web Server Extensions
> Web Services Toolkit
12.0.11

Also in: 15.0.0, 15.0.0,
15.0.0, 12.1.0 Dev 29584

Fix an issue with Windows updates causing a fatal error at startup

This change fixes an issue introduced by a series of Windows Updates rolled out by Microsoft in
August 2019 that caused a fatal error at startup of PcVue and FrontVue.
At the time of writing, the list of suspected Windows Updates is the following:
Windows update Release date Applies to
KB4512508 (OS Build 18362.295) August 13th, 2019 Windows 10 version 1903
KB4511553 (OS Build 17763.678) August 13th, 2019 Windows 10 version 1809,
and Windows Server 2019
KB4512534 (OS Build 17763.720)
and Windows Server 2019
KB4512501 (OS Build 17134.950)
KB4512509 (OS Build 17134.984)
KB4512516 (OS Build 16299.1331)
KB4512494 (OS Build 16299.1365)
KB4512507 (OS Build 15063.1988)
)
)

August 17th, 2019 Windows 10 version 1809,
August 13th, 2019
August 19th, 2019
August 13th, 2019
August 16th, 2019
August 13th, 2019
August 17th, 2019
August 13th, 2019

Windows 10 version 1803
Windows 10 version 1803
Windows 10 version 1709
Windows 10 version 1709
Windows 10 version 1703
Windows 10 version 1703
Windows 10 version 1607,

KB4512474 (0OS Build 15063.2021
KB4512517 (OS Build 14393.3144

and Windows Server 2016

KB4512495 (OS Build 14393.3181)

and Windows Server 2016

KB4512497 (OS Build 10240.18305)
(RTM)

KB4517276 (OS Build 10240.18308)
(RTM)

KB4512488 (Monthly Rollup)

Server 2012 R2

KB4512478 (Preview of Monthly Rollup)
Server 2012 R2

KB4512518 (Monthly Rollup)
KB4512512 (Preview of Monthly Rollup)
KB4512506 (Monthly Rollup)

Windows Server 2008 R2 SP1
KB4512514 (Preview of Monthly Rollup)
Windows Server 2008 R2 SP1
KB4512476 (Monthly Rollup) August 13th, 2019
KB4512499 (Preview of Monthly Rollup) August 17th, 2019
The issue affected versions 10.0, 11.0, 11.1, 11.2 and 12.0.

Earlier releases of these PcVue and FrontVue versions cannot be used if any of these Windows
Updates is installed.

August 17th, 2019 Windows 10 version 1607,

August 13th, 2019 Windows 10 version 1507

August 17th, 2019 Windows 10 version 1507

August 13th, 2019 Windows 8.1, and Windows

August 17th, 2019 Windows 8.1, and Windows
Windows Server 2012
Windows Server 2012
Windows 7 SP1, and

August 13th, 2019
August 17th, 2019
August 13th, 2019
August 17th, 2019 Windows 7 SP1, and

Windows Server 2008 SP2
Windows Server 2008 SP2

General

12.0.10

Also in: 12.1.0 Dev 29584,
11.2.06087, 11.1.06122,
11.0.06100,
10.0SP2_Update

Upgrade Upgrade of HDS table schema (SPR # 66166)

With version 12, the length of Log list names can be up to 100 characters long (was 12).

This change affects the schema of HDS log tables (column LogList).

The change in table schema is done automatically at startup if the size of the database is less
than 10 Gb.

If the size is higher, the traces ask you to run the migration script.

The issue is that the migration script, as supplied with the installation package 12.0.7 and 12.0.8,
was wrongly altering the column EvtTitle instead of the column LogList, causing the archiving to
no longer be effective after project startup.

If you have upgraded your HDS log tables with version 12.0.7 or 12.0.8, it is advised to apply the
following changes manually:

®  Alter the LogList column of Log tables to type it varchar(100),
®  Alter the EvtTitle column of Log tables to type it varchar(255),
®  Make sure the value of DBVersion is set to 4.

If you are upgrading your HDS log tables with version 12.0.9 or later, no specific action is
required apart from running the migration script.

Historical data
12.0.9
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4. Enhancements

Sampling period greater than the export period (SPR # 67469)

It is now possible to have a sampling period equal or greater than the export period. This change
allows using the export feature to generate a single sampled value snapshot.

Data Export
12.0.16
Also in: 15.0.0

Show/hide columns
It is now possible to hide the columns Is Standard Week Empty and Is Exception Period Active. By
doing so, the time to load the list of timetables is greatly reduced.
The setting to add to the WebScheduIer Web.qonfig file is the following:
<setting name="HideSpecialColumns"
serializeAs="String">
<value>True</value>
</setting>

WebScheduler
12.0.16
Also in: 15.0.0

Positioning of markers (SPR # 67820, 67757, 67756)

It is now possible to select at design time how markers of type Symbol shall be anchored on the
map:

Centered,

Anchor point,

Top-left corner,

Top-right corner,

Bottom-left corner,

Bottom-right corner.

HMI > Map control
12.0.16

Also in: 15.0.0, 15.0.0,
15.0.0, 15.0.0

Driver Udp Genisys - Support for redundancy (SPR # 73476)

The Udp Genisys driver now supports field device redundancy.

Data Acquisition >
Other built-in drivers
12.0.30

Also in: 15.2.9

Driver Udp Genisys - Switch polling mode
The driver Udp Genisys now supports the following SCADA Basic instruction to switch indication

request from master poll to master recall:
CIMWAY(“SENDMSG”,“network.device”,“ResetRecallFlag”);

Data Acquisition >
Other built-in drivers
12.0.30

Also in: 15.2.9

Sunair - Support for new controllers

The Sunair driver now supports T-5000A 5 kW, T-10000A 10 kW and T-10000B 10 kW
transmitter systems.

Data Acquisition >
Other built-in drivers
12.0.28

Also in: 16.0.0, 15.2.3

Tyco POSM IP - Support for device redundancy (SPR # 71218)

The data acquisition driver Tyco POSM over IP now supports a device standby address to
manage the Centinel redundancy system.

Data Acquisition >
Other built-in drivers
12.0.28

Also in: 16.0.0, 15.2.3

Udp Genisys - Ability to send value 0 (SPR # 70038)

A new property is available for the Udp Genisys nodes to enable sending value O for bits.
Defaults to false since the control data should be reset by the device itself.

Data Acquisition >
Other built-in drivers
12.0.25

Also in: 16.0.0, 15.2.1

Checks before running Component Registration Tool (SPR # 65708)

The Component Registration Tool now checks whether an affected process is still running before
proceeding. In addition, a warning message is displayed to warn the user about the potential
overwrite of system configuration settings such as services accounts.

Deployment tools >

Component Registration

tool
12.0.23
Also in: 15.0.0
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Filtering HDS log list with Sql-like syntax (SPR # 68855, 68823)

It is now possible to use Sql-like syntax when filtering Log lists for a Log viewer with the SCADA
Basic instruction LOGDISPLAY mode FILTER.

Web Server Extensions
> WebVue

12.0.22

Also in: 15.2.0, 15.1.1,
15.0.3

Instruction EMAIL - Support for UNC path for attached files (SPR #
68852)

When using the EMAIL instruction, it is now possible to reference attachment files by using UNC
path (e.g. \\hostname\folder\file.txt).

Scripting > SCADA
Basic

12.0.22

Also in: 15.1.0, 15.0.3,
11.2.06099, 11.2.06099

New BITMASK expression (SPR # 63570)

It is now possible to use the custom field BITMASK(x) in the advanced properties of OPC
variables. The variable value is then the result of the logical bit AND operation between the OPC
item value and the mask.

Data Acquisition > OPC
Client

12.0.21

Also in: 15.1.0, 15.0.2

New interop property (SPR # 68568, 63486)

A new interop property is available for OPC-XML servers. It enables adding the http basic
authentication header to all requests and is designed for OPC-XML servers that do not send the
HTTP 401 error if the header is required.

Data Acquisition > OPC
Client

12.0.20

Also in: 15.1.0, 15.0.2

Writing the same value (SPR # 68416)

Until this change, writing the same value to an internal variable was not triggering notifications
in components such as the SV Manager Toolkit even if the global variable setting Send write
request even if the value to write is the same as the current value was enabled. In such
circumstances, it is now possible to send multiple times the same value and be notified
accordingly, which is required by some on add-ons such as the KNX driver.

It was working properly with I/O variables.

Real time data
12.0.20
Also in: 15.0.0, 15.0.0

OPC-XML - Support for Http Basic Authentication (SPR # 67279, 67278,

65932)
The OPC-XML driver now supports Http Basic Authentication.

Data Acquisition > OPC
Client

12.0.19

Also in: 15.0.0, 15.0.0,
15.0.0, 15.0.0, 12.1.0
Preview 03

Driver XBUS-IP-MASTER - Handling of connection termination (SPR #
66310)

In order to improve interop with some devices, it is now possible to select if a connection shall
be terminated using the TCP RST_ACK or FIN_ACK flag.

Data Acquisition >
Other built-in drivers
12.0.19

Also in: 15.0.0, 12.1.0 Dev
28713, 11.2.06085

Replication Manager - Purging previous steps before a new replication
(SPR # 65618)

When an earlier replication failed to complete, remaining steps were still pending and stored in
a dedicated table so that they can be processed later on. This feature had side effects in case
one did not want the pending steps to be executed. It is now possible to purge this table of
pending steps before executing a new replication, by using the Database Manager tool or by
using the /P command line argument:

® /P=1to purge the table,

® /P=0to keep previous steps (default).

Add-ons and Tools
12.0.18

Also in: 15.0.0, 15.0.0,
12.1.0 Dev 28713,
11.2.06093, 11.2.06082,
11.1.06120

Support for double spontaneous transmissions (SPR # 68078)

Support for double transmission of information objects with cause of transmission spontaneous.

It can be configured in the advanced properties of IEC 104 points.

Communication
interfaces > IEC 60870-
5-104 Outstation
12.0.17

Also in: 15.0.0
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Support of signed float 32 bits format (SPR # 68105)

New format Signed float 32 bits (swapped word) is now available for built-in drivers.

Data Acquisition >
Other built-in drivers
12.0.17

Also in: 15.0.0

Instruction TRACE mode FILE - Message max length (SPR # 67950)

The instruction TRACE mode FILE can now handle a message of up to 2047 characters (was 80).

Scripting > SCADA
Basic

12.0.17

Also in: 15.0.0
Support for extended function keys General
The list of fixes & enhancements includes: 12.0.17

®  Support of F13 to F16 function keys, Back Space and Tab keys,
®  Support of the Alt key as a modifier,
®  Error and Log messages reworked.

Also in: 15.0.0, 15.0.0

New method to log messages (SPR # 67826)
A new method LogInformation is available in VBA on the Project object. It can be used to send
log messages to the Event Viewer.
ThisProject.LogInformation LogLevel, LogMsg
Where LoglLevel can take value 1, 2 or 3, and LogMsg is the message to be logged (string)
® 1 =|nformation,
® 2 =Warning,
® 3 =Error.

Scripting > VBA
12.0.16
Also in: 15.0.0

New substitution characters for timestamp formatting - 12-hour clock
(SPR # 67015)

New substitution characters are available in the Alarm viewer, the Log viewer and the Trend
viewer for timestamp formatting based on 12-hour clock representation:

®  #H:Hours from 1 through 12 (as opposed to #h for 00 through 23),

®  #p: AM/PM designator.
In additional, only for the Alarm viewer, #H and #p support the suffix AlaOn, AlaAck and AlaOff.

HMI

12.0.14

Also in: 15.0.0, 15.0.0,
15.0.0, 15.0.0, 15.0.0

Default mode of On text animations (SPR # 66983)

On text animations now use the Variable mode by default (was using Value mode).

HMI > Animations
12.0.13
Also in: 15.0.0

OPC-XML - Support for arrays (SPR # 66898)

When using OPC-XML, it was not possible to map a variable on a specific index of an array of
items (string, boolean, 14, Ul4...). This feature was already available with the OPC-DA client.

Data Acquisition > OPC
Client

12.0.12

Also in: 15.0.0, 15.0.0,
12.1.0 Preview 02, 12.1.0
Preview 02

Support of SCADA Basic modes INSERT and REMOVE for CHECKLIST,

COMBOBOX, LISTBOX and OPTIONLIST instructions (SPR # 66028)

The SCADA Basic modes INSERT and REMOVE of the instructions CHECKLIST, COMBOBOX,
LISTBOX and OPTIONLIST are now supported in WebVue.

Web Server Extensions
> WebVue

12.0.11

Also in: 15.0.0, 15.0.0,
12.1.0 Dev 29935, 12.1.0
Dev 29584

Allow write commands when equipment is in error (SPR # 66436)

Prior to this modification, write commands were not sent when the equipment was seen in
error. In particular, they were not executed on valid write-only frames when another frame had
a status error.

Now, writes commands are sent based on the frame status instead of the device status.

Data Acquisition >
Other built-in drivers
12.0.11

Also in: 15.0.0, 12.1.0 Dev
29584
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Ability to disable file opening after data export (SPR # 65359)

From now on, when the user does not have the desktop rights, the Data Export Wizard of the
Trend Viewer and the Grid Control no longer asks the user if he/she wants to open the
generated file, a simple information is displayed, thus preventing the access to the file system.

Data Export

12.0.11

Also in: 15.0.0, 12.1.0 Dev
29584

BACnet exception handling (SPR # 66582)

Handling of Exception Schedule has been reworked to improve interop with devices that do not
clear obsolete exception entries themselves.

WebScheduler

12.0.11

Also in: 15.0.0, 12.1.0 Dev
29584, 11.2.06089,
11.1.06123, 11.0.06101

Small font size in Send Text animation (SPR # 66342, 66038)

When a Send Text animation was configured with direct input, the font size for displaying and
typing the text were different.

Web Server Extensions
> WebVue

12.0.11

Also in: 15.0.0, 12.1.0 Dev
28713
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5. Performance

Image caching (SPR # 66155)

Images loaded in mimics and symbols were not cached by the web browser, thus they were

loaded every time the mimic was opened.

The setting to add to the GraphicalData web.config file is the following - Value in seconds,

default to 0 (expiration controlled by the web browser) :

<setting name="CacheMaxAge" serializeAs="String">
<value>0</value>

</setting>

There is no need for customization to take advantage of the default value.

Web Server Extensions
> WebVue

12.0.16

Also in: 15.0.0

Time to open/close a session (SPR # 69199)
The time to open and close a WebVue session has been significantly improved, in particular
when the project comprises a large amount of alarm syntheses.
For example on a project with 6000 alarms, 3000 alarm syntheses and 15000 alarm synthesis
counters:
Before performance improvement:
® Time to open a WebVue session: 18.5 sec, including 17 sec to load alarm synthesis,
® Time to close a WebVue session: 3 min 9 sec, including 3 min 5 sec to unload context
variables.
After performance improvement:
® Time to open a WebVue session: 4.9 sec, including 3.5 sec to load alarm synthesis,

® Time to close a WebVue session: 2.5 sec, including 1 sec to unload context variables.

Real time data
12.0.23
Also in: 15.2.0, 15.1.1

GDI object leak (SPR # 67251)

A memory leak occurred when opening a mimic containing Form controls (Combo-box, List-box,
Option-list, Tree view). One GDI object was lost for each control using a custom font.

HMI > Form controls
12.0.15
Also in: 15.0.0

Degraded response time (SPR # 67120)

Since version 12.0 Initial Release, general performances when requesting Web Services were
degraded up to 50 folds (100 read requests within 50 seconds instead of 1 seconds). This fix
restores performances to a level similar to version 11.2.

Web Server Extensions
> Web Services Toolkit
12.0.15

Also in: 15.0.0

Filtering based on populations (SPR # 66703, 66695)

Since version 12 Initial Release, runtime performances related to population filters were
degraded due to a regression.

Applying a population filter could take several minutes to be fully performed. It is now almost
instantaneous.

Real time data

12.0.12

Also in: 15.0.0, 12.1.0 Dev
29935
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6. Installation

OPC UA Gateway version 1.6.0

Update of the installation package of the OPC UA Gateway available in the Add-ons & Tools
section of the DVD.

Add-ons and Tools
12.0.30

OPC UA Gateway version 1.5.11 (SPR # 70709)

Update of the installation package of the OPC UA Gateway available in the Add-ons & Tools
section of the DVD.

Add-ons and Tools
12.0.28
Also in: 16.0.0, 15.2.4

Documentation update
The product documentation has been updated:
®  Online help in Russian - Now at the level of version 12.

General >
Documentation
12.0.27

Also in: 15.2.1

Sentinel System driver 7.6.1

Update of the installation package for the Sentinel System driver.

General > Licensing
12.0.27
Also in: 15.2.1

Availability of the KNX add-on (SPR # 68513)

The KNX add-on, available since version 11.2, was not shipped with the installation package and
had to be downloaded from the Technical Ressources web site. It is now part of the installation
package.

Data Acquisition > KNX
12.0.20
Also in: 15.0.0

Support for Microsoft SQL Server 2019

Historical data

Update of the readme file and the online help to reflect support for SQL Server 2019 which is 12.0.20
effective since Maintenance Release 12.0.14. .
Also in: 15.0.0
Timestamping server for Authenticode signature Installation
Change of the timestamping server used for Authenticode signature of installation packagesand  12.0.20
binary files. i
The trust chain of the new timestamping server is attached to the following root certificate: Also in: 15.0.0,
®  Friendly name: DigiCert 11.2.06098
®  Serial number: Oce7e0e517d846fe8fe560fc1bf03039
®  Common name: DigiCert Assured ID Root CA
®  Valid from : Friday, November 10, 2006 1:00:00 AM
®  Valid to : Monday, November 10, 2031 1:00:00 AM
Make sure this certificate is in the list of trusted certificates.
Documentation update General >
The product documentation has been updated: Documentation
®  Online help in Chinese - Now at the level of version 12, 12.0.17

®  Online help in Russian - Now at the level of version 11.2.
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7. Security

Vulnerabilities in the client/server Networking (SPR # 74711, 74710,
74709)

The following vulnerabilities are fixed. They affect the TCP-based client/server Networking
feature:

® (CVE-2025-9998 - Improper validation of packets sequencing - Affects all versions.

®  (CVE-2025-9999 - Improper validation of payload elements - Affects all versions.
See our Security alert page for more information.
[Edit: The fix in 12.0.31, 15.2.12, 16.3.1 an 16.3.2 is not effective. Refer to the section Known
issues for more information.]

Networking
12.0.31
Also in: 16.3.1, 15.2.12

Buffer overflow vulnerability (SPR # 73486)
The following vulnerability is fixed. It affects the IEC 61850 client driver:

®  (CVE-2024-34057 - Buffer overflow in the Triangle MicroWork’s IEC 61850 Client library
- Affects all versions since 10.0.
See our Security alert page for more information

Data Acquisition > IEC
61850 Client

12.0.30

Also in: 15.2.9

Vulnerability in the Microsoft Visual Basic for Applications runtime (SPR

# 73056)

The following vulnerability is fixed. It affects the VBA runtime:
® (CVE-2010-0815 & CVE-2021-1854 - Remote Code Execution - Affects all versions since
9.0.
See our Security alert page for more information.

Scripting > VBA
12.0.30
Also in: 15.2.8

OPC UA Gateway version 1.5.14

Update of the installation package of the OPC UA Gateway available in the Add-ons & Tools
section of the DVD.
This version of the OPC UA Gateway addresses the following security vulnerabilities:

®  ZDI-CAN-20497 / CVE-2023-32172
®  7DI-CAN-20576 / CVE-2023-32173

®  7DI-CAN-20577 / CVE-2023-32174
Please note that the version 1.5.13 released earlier this year addressed the following security
vulnerabilities:

® CVE-2022-4304
CVE-2023-0286
ZDI-CAN-20353 / CVE-2023-41185
ZDI-CAN-20494 / CVE-2023-32170
ZDI-CAN-20495 / CVE-2023-32171

®  7DI-CAN-20497 / CVE-2023-32172
See our Security alert page for more information.

Add-ons and Tools
12.0.29
Also in: 15.2.7

Vulnerability in the email & SMS account configuration (SPR # 69821,
65029)

The following vulnerability is fixed. It affects the configuration of the email and SMS accounts:

®  (CVE-2022-4312 - Cleartext Storage of Sensitive Information vulnerability, allowing a
user able to authenticate locally to access the SMTP account credentials and the SIM
card PIN code - Affects all versions since 8.10.
See our Security alert page for more information.

Miscellaneous
12.0.28
Also in: 16.0.0, 15.2.4

Denial Of Service vulnerability (SPR # 71486)

The following vulnerability is fixed. It affects the ICCP/TASE.2 interface Add-on and the IEC
61850 Client driver:

® (CVE-2022-38138 - Access of Uninitialized Pointer vulnerability in the stack used for the
ICCP/TASE.2 interface and the IEC 61850 Client driver.

For the IEC 61850 Client driver, it affects all versions since 10.0.
For the ICCP/TASE.2 interface, it affects all versions since 15.1.

See our Security alert page for more information.

Data Acquisition > IEC
61850 Client

12.0.28

Also in: 16.0.0, 15.2.3
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Vulnerability in the OAuth configuration (SPR # 71066, 70710)

The following vulnerability is fixed. It affects the configuration of the OAuth web service hosted
in Microsoft IIS:

®  (CVE-2022-2569 - Cleartext Storage of Sensitive Information vulnerability, allowing a
user able to authenticate locally to access session data of legitimate users stored in the
OAuth database - Affects versions 12 & 15.
See our Security alert page for more information.

Web Server Extensions
12.0.27

Also in: 16.0.0, 15.2.3,
15.2.3

OPC UA Gateway version 1.5.10

Update of the installation package of the OPC UA Gateway available in the Add-ons & Tools
section of the DVD.
This version of the OPC UA Gateway addresses the following security vulnerabilities:

® (CVE-2022-29862 — Chained Certificate Loop PoD

®  (CVE-2022-29864 — Reference Counter Decrement DoS
See our Security alert page for more information.

Add-ons and Tools
12.0.27
Also in: 15.2.3

Dream Report version 2020 R2 SP1

Update of the installation package for Dream Report available in the Add-ons & Tools section of
the DVD.
This version of Dream Report addresses the following security vulnerabilities:

® CVE-2020-13532
® CVE-2020-13533
® CVE-2020-13534

® (CVE-2021-21957
See our Security alert page for more information.

Add-ons and Tools
12.0.27
Also in: 15.2.1

Vulnerabilities in the Web back end modules

This is a follow-up to fixes available since 11.2.06097, 12.0.17 and 15.0.0. This fix covers other
ways to exploit similar Remote Code Execution vulnerabilities uncovered after more tests of the
initial fix.

The following vulnerability is fixed. It affects the interface between the Web & Mobile back end
and the web services hosted in Microsoft IIS:

® (CVE-2020-26867 - A Remote Code Execution vulnerability due to the unsafe
deserialization of messages received on the interface - Affects all versions since 8.10.
See our Security alert page for more information.

Web Server Extensions
12.0.23

Also in: 15.2.0, 15.1.2,
11.2.06100

Password displayed with virtual keypad (SPR # 68668)

When unlocking a user with the virtual keypad, the password was displayed in the input dialog
instead of '*' characters.

HMI
12.0.21
Also in: 15.1.0, 15.0.2

Secret storage (SPR # 68391)

The storage of the Authentication password for IEC 61850 devices is now protected and can
include quotes.

Data Acquisition > IEC
61850 Client

12.0.20

Also in: 15.0.0

Vulnerabilities in the Web back end modules
The following vulnerabilities are fixed. They affect the interface between the Web & Mobile
back end and the web services hosted in Microsoft IIS:
® (CVE-2020-26867 - A Remote Code Execution vulnerability due to the unsafe
deserialization of messages received on the interface - Affects all versions since 8.10.
® (CVE-2020-26868 - A Denial Of Service vulnerability due to the ability for a non-
authorized user to modify information used to validate messages sent by legitimate
web clients - Only affects version 12.0.
® (CVE-2020-26869 - An information exposure vulnerability allowing a non-authorized
user to access session data of legitimate users - Only affects version 12.0.
See our Security alert page and Security Bulletin 2020-1 for more information.

Web Server Extensions
12.0.17

Also in: 15.0.0, 15.0.0,
15.0.0, 15.0.0, 15.0.0,
15.0.0, 15.0.0, 15.0.0,
11.2.06097, 11.2.06097,
11.2.06097, 11.2.06097

Access to another web session (SPR # 66644)

Under some circumstances, a web client was able to access the session of another web client,
leading to potential information disclosure and privilege elevation. This was due to the reuse of
a previously closed session Id, but with an access token not yet expired.

Web Server Extensions
12.0.15

Also in: 15.0.0, 12.1.0 Dev
29584
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Access to the online help and potential security policy infringement General

(SPR # 66776, 65910) 12.0.13

Under some circumstances, access to the online help was possible before completion of project  Also in: 15.0.0, 12.1.0 Dev
startup.

It could occur in particular by pressing the F1 key from one of the message box opened to 28713, 11.2.06091

indicate that network access issues prevent access to the version management central folder.
Access to the file system was therefore possible before user authentication, which could be
against the security policy on some systems.

Automatic logout not effective in WebVue (SPR # 66653) Web Server Extensions
The automatic logout was not completely effective in WebVue. > WebVue

After the inactivity timeout elapsed, it was indicated that the session ended but refreshing the

page (with F5 or Refresh button) was opening it again without entering credentials. 12.0.12

Also in: 15.0.0, 15.0.0,
12.1.0 Dev 29935, 12.1.0
Dev 29935

Reference: PcVue 12 Release Notes Last update: November 3, 2025
Copyright ©2024 - ARC Informatique. All rights reserved — LI N0 H I3 Page 36/119



4
PcVue >

8. Other fixes & enhancements

e SPR#74125 12.0.30
Also in: 15.2.11
e SPR #70346, 72458 12.0.29
Also in: 16.0.0, 15.2.6
e SPR#71732, 72461 12.0.29
Also in: 15.2.4
e SPR#71119, 71120, 71915, 71916 12.0.28
e SPR#70713, 71058, 71134, 71235 12.0.28
Also in: 16.0.0, 15.2.3
e SPR #67079, 70906, 71074 12.0.27
Also in: 16.0.0, 15.2.3
e SPR #69235 12.0.27
e SPR #70003 12.0.27
Also in: 16.0.0, 15.2.3,
15.2.3
e SPR #66129 12.0.26
e SPR#70141 12.0.26
Also in: 16.0.0, 15.2.1
e SPR #69895 12.0.25
Also in: 15.2.0, 15.2.0,
15.1.5
e SPR #69894 12.0.25
Also in: 15.2.0, 15.1.5,
15.1.5
e SPR #68404, 69531, 69570 12.0.24
e SPR #69820 12.0.24
Also in: 15.2.0, 15.1.5
e SPR #69218 12.0.24
Also in: 15.2.0, 15.1.3,
11.2.06101
e SPR #69217 12.0.23
e SPR #69216, 69235 12.0.23
Also in: 15.2.0, 15.1.1
e SPR #68423, 68424 12.0.23
Also in: 15.1.0
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SPR #66177, 66223, 69424 12.0.23
Also in: 15.0.0, 15.0.0,
12.1.0 Dev 29584, 12.1.0
Dev 28713, 11.2.06088,

11.2.06085
e SPR #66794, 68848 12.0.22
Also in: 11.2.06099
e SPR #68450 12.0.20
Also in: 15.1.0, 15.0.1
e SPR #68498 12.0.20
Also in: 15.0.0
e SPR #68268 12.0.20

Also in: 15.0.0, 15.0.0,
11.2.06097, 11.2.06097

e SPR #65348, 68261 12.0.19
Also in: 15.0.0

e SPR #67223, 67986 12.0.17
Also in: 15.0.0

e SPR #67486 12.0.16
Also in: 15.0.0, 15.0.0,
15.0.0

e SPR #66811, 66857 12.0.12
Also in: 15.0.0, 12.1.0
Preview 02

e SPR #66192 12.0.11

Also in: 15.0.0, 15.0.0,
12.1.0 Dev 29584, 12.1.0
Dev 29584

e SPR #66009, 66150 12.0.10
Also in: 15.0.0, 12.1.0 Dev
29584

e SPR #66219, 66269 12.0.9
Also in: 15.0.0, 12.1.0 Dev
28713
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PcVue

¥

2. Release

1. New features

MultiTech LoRa Gateway interface
A data acquisition driver for MultiTech LoRa Gateways is now available.

Add-ons and Tools

New data acquisition driver - EtherNet/IP (SPR # 64622, 63343)

A data acquisition driver for EtherNet/IP™ controllers is now available.
It supports controllers in the CompactLogix, ControlLogix, DriveLogix and FlexLogix series.

Add-ons and Tools

Management of Generic Traps (SPR # 64853)
The SNMP Agent Add-on now supports generic traps.

Communication
interfaces > SNMP
Agent

Also in: 11.2.06071

Modelling of IEC 104 Qutstation datapoints

It is now possible to define IEC 104 Outstation datapoints in templates and instances.

Configuration
Environments >
Application Architect

Access MS Excel files from within expressions - File reference and
Excel /0 lists

A set of new functions is available. They can be used in expressions to get data from 3rd party
Microsoft Excel files, including TextJoin, Lookup and Match.

With the Application Architect, using such expressions to predefine variables addresses in
templates, you can use your regular Excel 1/0 list as an input for mapping variables
automatically without error.

These MS Excel file handling functions come with the ability to pre-configure accessible files
using the Application Explorer to define file references.

In addition to security concerns, file references allow you to pre-define how and when external
files are loaded and unloaded to prevent excessive resource consumption.

Configuration
Environments >
Application Architect

Application data files modeling

If your application requires application data files, you can now model Xml and text-delimited
files thanks to templates and instances.

Examples of use include cases where a script requires a data file containing a list of mimics, a list
of branches, a list of trended variables, a hierarchy of mimics for custom mimic navigation...
Such files can now be generated as part of your application modelling.

This new feature supports the modeling of data files required to populate the built-in form
controls.

Configuration
Environments >
Application Architect

Making multiple copies of a configuration item

It is now possible to paste multiple copies of an item using the Multiple paste command. The
Multiple paste command is available from the context menu when a supported item is being
copied.

Items supported by the Multiple Paste command:

Template instance,

Topology element,

All configuration objects,

Mimic,

Symbol,

Embedded template,

All configuration sub-objects except those that can only be configured once.

Configuration
Environments >
Application Architect

Modelling of Archive Units and Log List

It is now possible to define archive units and log list in templates and instances.

Configuration
Environments >
Application Architect

Reference: PcVue 12 Release Notes
Copyright ©2024 - ARC Informatique. All rights reserved — LI N0 H I3

Last update: November 3, 2025

Page 39/119



4
PcVue >

Modelling of BACnet automation objects

It is now possible to define BACnet automation objects in templates, including objects of type
Device, Notification-Class, Calendar, Schedule, Event Log and Trend Log.

Configuration
Environments >
Application Architect

Modelling of IEC 61850 communication items

It is now possible to define IEC 61850 Devices, Datasets, Report groups and Polling groups in
templates and instances.

Configuration
Environments >
Application Architect

Modelling of LNS communication items
It is now possible to define LNS Networks and Nodes in templates and instances.

Configuration
Environments >
Application Architect

New expression items for numbering and offset calculation

A series of new expression items is available to make it easier to establish numbering or
offsetting rules for the value of instances' properties.

This includes a counter of the number of child instances, number of embedded instances,
number of variables...

Configuration
Environments >
Application Architect

New features in the Application Explorer

The following elements are now be available in the Application Explorer:
®  Monitoring of active sessions,
® Web & Mobile back ends configuration,
®  SQL Connections configuration,

®  File references configuration.
Enhancements to the BACnet engineering process, including the automatic detection of fields in
vendor-specific EDE files, as well as support for a variety of encoding.

Configuration
Environments >
Application Explorer

Upgrade Configuration of function keys (SPR # 48178)

Function keys can now be configured using the Application Explorer.

As part of the configuration management, a change has been introduced to simplify project
design. What used to be called 'standard' or 'default' function keys are no longer re-created
automatically at startup if they have been deleted from the function key configuration. As part
of the migration, the project designer shall make sure to delete the function keys that are not
necessary. In addition, the SCADA Basic script designed to delete all function keys and re-create
only the useful ones can now be safely removed. Please refer to the SCADA Basic online help for
more information (see the topic related to the KEY instruction).

A specific task is available in the Application Explorer to re-create all default function keys'
configuration.

Configuration
Environments >
Application Explorer

Configuration of line printers
Line printers can now be configured using the Application Explorer.

Configuration
Environments >
Application Explorer

Configuration of populations

Populations can now be configured using the Application Explorer.

As part of this feature, a population filter can be configured using an SQL query-like editor. In
addition, population filters can now include filter elements based on extended attributes 5 to
16.

Configuration
Environments >
Application Explorer

New Smart Generator - SG for MOXA® ioLogik

A Smart Generator for MOXA® ioLogik is now available. Based on network scanning and online
device discovery, it allows you to automate configuration of data acquisition and variables with
support for the ioLogik E1200 & E2500 series.

Configuration
Environments > Smart
Generators

New Smart Generator - SG for OPC (SPR # 65207, 64830, 64494)

A Smart Generator for OPC is now available to automate configuration of variables based on
browsing of OPC servers.

Configuration
Environments > Smart
Generators

New Smart Generator - SG for TIA Portal

A Smart Generator for TIA Portal is now available to automate configuration of data acquisition
& variables based on a TIA Portal project for Siemens PLC.

Configuration
Environments > Smart
Generators
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New data acquisition driver for Moxa® ioLogik controllers

A data acquisition driver for Moxa ioLogik controllers is now available - It supports controllers in
the E1200 & E2500 series.

Data Acquisition

Support for the OPC UA Gateway
PcVue now supports the OPC UA Gateway with built-in licensing. It includes:
® The OPC UA client gateway for data acquisition,

® The OPC UA server gateway for exposing PcVue variables to 3rd party UA clients.
See the Installation section of this Release Notes for more information.

Data Acquisition

Also in: 11.2.06055,
11.2.06055, 11.1.06102,
11.1.06102, 11.0.06094

Support for File Transfer services
The standard File Transfer services are now supported. This new feature includes:
® Afile transfer Helper on IEC 61850 devices nodes in the Application Explorer,

®  The Helper allows browsing files available in devices connected to the network, as well
as file Download, Upload and Deletion,
® A new SCADA Basic instruction named FILETRANSFER so that the File Transfer services
can be scripted,
®  Background retrieval and synchronization of files.
It permits handling files generated and/or stored in field devices, in particular disturbance
recording, files containing device settings or configuration.

Data Acquisition > IEC
61850 Client

Append mode

It is now possible to append new data to an existing export file (Excel and CSV), to seamlessly
aggregate data over successive exports.

Data Export

Web Deployment Console

A new tool is introduced to support WebVue server & web services deployment needs. The Web
Deployment Console (WDC) is designed to support a comprehensive list of scenarios for web
server deployment. It can be used side-by-side with IT admin tools:

®  For system administrators, it does not require any knowledge of the Web apps & web
services being deployed,

®  For automation engineers, it opens the door to web server deployments with limited
knowledge of the underlying IT technologies.

Using the Web Deployment Console, you will be able to:
® |nstall the Microsoft IIS web server components,
®  Set-up the connection to the underlying web back end,

®  Deploy the services you need to support Web & Mobile apps including WebVue,
TouchVue, the WebScheduler and the Web Services Toolkit.

The WDC also includes support for troubleshooting, as well as a re-deploy feature that turns an
update of the web server into a 1-click action.

Deployment tools >
Web Deployment
Console

Handling SQL Connections with the SV Manager SDK

Development kits > SV

A connection and request handler taking advantage of the pre-defined SQL Connections can be Manager Toolkit
used in Add-ons developed based on the SV Manager Toolkit SDK.
Labels associated to timestamp quality (SPR # 61549) General

From now on, it is possible to configure the labels corresponding to the timestamp quality. Such
labels can be displayed in the Log Viewer, the Alarm Viewer and Animations by using the
substitution character #x.
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SQL Connections General

Acting as a SQL bridge, SQL connections facilitate the connection of the Supervisor to 3rd party
systems. In particular, SQL connections are useful to exchange data with Enterprise systems
such as a MES, CMMS, ERP and Weather data providers.

SQL connections and the underlying SQL request handler can be used as a universal data
connector to any external data source provided that a compatible ADO.NET provider is
available. The module behind SQL connection handling helps you connect seamlessly to SQL
data sources. It includes:

®  Request routing inside the Supervisor's multi-station,

®  Support for single active server associations for redundancy,

®  Asynchronous command handling,

®  (Centralized connection strings at the project configuration level.

This SQL bridge supports a large variety of database commands including:
®  Select, Insert, Update and Delete queries,
®  Scalar, tabular and non-query requests,

® Requests on tables, views, stored procedure execution,

[ ]
Requests can be scripted in SCADA Basic by using the instructions SQL_COMMAND and
SQL_CONNECTION, and the underlying request handler can be used in Add-ons developed
based on the SV Manager Toolkit SDK.

User sessions & scope General > User
A comprehensive user session handling is now available. It includes session monitoring & audit, management
and with the concept of scope, the ability to isolate a variable’s value and associated behaviors

(events, thresholds, expressions...) within a user session.

System variables and a new SCADA Basic instruction named SESSION are also available so that

sessions can be scripted.

HMI variables HMI

HMI variables are a new kind of variables designed to be less resource-intensive than internal
variables. Managed locally on each station, they can be used to handle user inputs and
navigation activities, including WebVue. HMI variables are a complement to 1/0 and internal
variables that can be distributed across multi-station systems based on server and client lists.
HMI variables supersede the legacy percent variables and temporary variables.

HMI variables can be used in scripts, including SCADA Basic and VBA. They can be created and
deleted via SCADA Basic scripts by using the instruction VARIABLE (modes ADD_HMIBIT,
ADD_HMIREG, ADD_HMITXT and DEL_HMIVAR), making it easy to migrate applications taking
advantage of temporary variables.

New animations - Image on bit/register/text HMI > Animations
A series of new animations is available to switch images according to a bit, register or text value.

New animations on text value HMI > Animations

New animations are available to animate graphic elements according to a text value: Symbol on
Text, Colors on Text, Images on Text and Visibility on Texts.

Pie, Doughnut and Pyramid chart HMI > Chart control
A new chart control is available to represent data under the form of Pie, Doughnut and Pyramid

charts.

Textbox form control HMI > Form controls

A new form control for Textbox is available.
The new control supports scripting via SCADA Basic and VBA.

Grid control printing (SPR # 63235) HMI > Grid control

It is now possible to print a mimic containing a Grid control. Prior to this fix, Grid control could Also in: 11.2.06058,
not be printed out.

11.2.06058
Predefined station lists Networking
Several pre-defined station lists are now available when configuring variables:
®  System.AllStations, a client list containing all individual stations,
®  System.<StationName>, a server list containing only the indicated station.
Reference: PcVue 12 Release Notes Last update: November 3, 2025
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New SCADA Basic instructions Scripting > SCADA

New SCADA Basic instructions are available to support scripting of new features: Basic
File transfer handling: FILETRANSFER,

®  Pie, doughnut and pyramid chart control: PIE,
®  Session handling: SESSION,
®  Textbox form control: TEXTBOX.

Several new modes on existing instructions are also added, including enhancements to scripting
for form controls, the WEBVUE instruction...

Call-backs on mimic events Scripting > SCADA
The SCADA Basic function to call when a mimic is open can now be configured in mimic Basic
properties.

In addition, a SCADA Basic function can be called when a mimic is closed.

New instructions for handling of SQL Connections Scripting > SCADA
The instructions SQL_COMMAND and SQL_CONNECTION are now available for scripting SQL Basic

Connections.

As of version 12.0, the use of pre-configured Sql connections along with the SQL_CONNECTION

and SQL_COMMAND is preferred to using the verb SVSQL (based on ODBC).

New event on Mimic size change (SPR # 63877) Scripting > VBA
A new VBA event is available on Mimic objects. It is triggered when the size or zoom level of a Also in: 11.2.06062
mimic is modified:

Private Sub Mimic WindowSize (ByVal Height As

Long, ByVal Width As Long, ByVal ZoomRatio As

Long)

TouchVue new features and enhancements TouchVue
The TouchVue mobile app now supports simultaneous connection to multiple servers and is

able to display graphic mimics and symbols.

A re-designed interface makes it for a great user experience and better performances.

SCADA Basic support (SPR # 65697, 65588, 65432, 65373, 65147, 64658, Web Server Extensions
64642, 64636, 64635, 64634, 64633)

As part of the WebVue client re-design, several enhancements are brought to SCADA Basic
support when scripts are executed in the context of a WebVue session.

In addition, support for SCADA Basic instructions and modes when executed in the context of a
WebVue session is now detailed in the SCADA Basic section of the online help, instruction per
instruction. This includes specific indications such as:

®  Supported: The instruction or mode is supported if executed in the context of a
WebVue session,

®  Not-supported: The instruction or mode is not supported if executed in the context of
a WebVue session,

®  Partially supported: The instruction or mode is supported if executed in the context of
a WebVue session, but have a specific behavior worth being noticed compared to its
execution in the context of the desktop client. In some cases, the specific behavior is a
known limitation that may be cleared in the future, and in most cases, it is a desired
specific behavior due to the nature of the web client.

®  Not applicable: The instruction or mode is not applicable to WebVue (and therefore
not supported).

Web back end station Web Server Extensions
To allow for a better network segmentation, the Web back end station can now be deployed on

a different server than the Web server (lIS).

This permits deploying Web Server extensions in a network infrastructure taking advantage of a

DMZ.
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Upgrade Re-designed WebVue client Web Server Extensions

The web client, which was originally designed as a Java applet introduced to the market in the > WebVue
late 90’s, now takes full advantage of the latest web technologies. WebVue provides a graphic

interface to monitor and control your process from a web browser on any device. WebVue

combines user experience, security and ease of deployment.

New features and enhancements include:

No installation required on the web client side,

Cross-browser support, including desktop and mobile web browsers,
Secured communication over HTTPS,

Support for network segmentation,

Multi-tab support with a single license.

The technology stack includes HTML5, SVG and REST/JSON web services over web sockets and
OAuth.

The SCADA Basic instruction named WEBVUE have been reworked to fit the new web client
design.

WebVue deployment now requires the configuration of a Web & Mobile back end (using the
Application Explorer), and the use of the Web Deployment Console on the Web Server.
Some configuration settings are deprecated and no longer used. As part of the migration
process, we recommend you to check settings related to the Web Server Extensions to make
sure they fit your needs.
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2. Fixes

svmgrHisTrendPeriod - Out of bounds values incorrectly archived

When a variable value was out of bounds, the quality of the variable recorded was NS instead of

NS L>or NS L>.

Add-ons and Tools
Also in: 11.2.06064,
11.1.06112

Various fixes - symgrHisTrendPeriod (SPR # 63442, 63441)
Two new properties have been added to modify the behavior of the add-on:

®  UselocalTimestampForTrigger: To determine if the timestamp to set on trigger is
expressed in UTC time (1) or in Local time (0, default);

®  NotifyHistoricalOnly: To send VTQs to the archives only and bypass the runtime control

such as dead banding (1) or to execute the runtime control (0, default).

Add-ons and Tools
Also in: 11.2.06061,
11.2.06059, 11.1.06110,
11.1.06106

DB Import - Fatal error on import (SPR # 63701)

Under some circumstances, a fatal error could occur when importing data containing Null
values, or having the same character used as the decimal and field delimiter.

Add-ons and Tools
Also in: 11.2.06059,
11.1.06106, 11.0.06094

DBImport - Could not import exponential values (SPR # 62356)

The DBImport failed to import exponential values (e.g. -3.4E+2).

Add-ons and Tools
Also in: 11.2.06001,
11.1.06068, 11.0.06086

DBImport - Incorrect truncations (SPR # 62297)

When importing data with the DBImport, some fields were truncated to incorrect sizes. Such
truncations are now matching the constraints corresponding to the targeted HDS database
schema version.

Add-ons and Tools
Also in: 11.2.06001,
11.1.06066, 11.0.06085,
10.0SP2_Update

Could not create Alarm synthesis (SPR # 65667, 65666)

It was not possible to create Alarm Synthesis from a station that did not belong to the alarm
synthesis server list.

Alarms
Also in: 11.2.06079

Alarms with empty Domain/Nature not filtered by Population (SPR # Alarms
64998)
Alarms with an empty Domain and/or Nature were still displayed after applying a population
that contained filter on Domain and/or Nature. Text Attributes 03 to 16 were also impacted.
Several fixes & enhancements related to alarm synthesis (SPR # 65035, Alarms
65022, 65021, 65020, 64887) Also in: 11.2.06073,
The list of fixes & enhancements includes: 11.2.06073

®  |mproved handling of the @ character,

®  Prevent creation of 2 alarm synthesis with the same result variable and different

branches,

®  Enhanced input validation to prevent forbidden characters in the variable name.

Alarm masked by expression instead of masked by variable (SPR # Alarms

64822)

When an alarm was masked by a variable, it was incorrectly indicated as masked by an
expression.

Also in: 11.2.06071

Unmasked alarms remained NS (SPR # 64268)

Under some circumstances, alarms were not unmasked when their previous status was masked
by dependence. The issue occurred when the masking dependence had a transition from invalid
to valid.

Alarms
Also in: 11.2.06071

NS alarm counters not correctly initialized
The initial values were incorrect for NS alarm counters.

Alarms
Also in: 11.2.06068

Masking of alarms resulting from an expression (SPR # 63223)
User masking (via the Alarm Viewer or SCADA Basic instruction) of alarms that are the result of

an expression was not effective. The issue was not affecting masking by dependence (expression

or variable).

Alarms
Also in: 11.2.06056,
11.1.06102
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Audit counter not correctly updated (SPR # 64877)

After several days, the audit counter Target manager good response Ul counter not released
was not correctly updated. It was leading to the unnecessary activation of flow control, in
particular for OPC.

Audit
Also in: 11.2.06076,
11.1.06116

Client connections rejected (SPR # 62859, 62858)

Under some circumstances, client connections were rejected by the server. In particular with
redundant PcVue servers or on computers having multiple network interfaces.

Communication
interfaces > IEC 60870-
5-104 Outstation

Also in: 11.2.06034,
11.2.06034

Configuration not saved dynamically (SPR # 62858)

The configuration of IEC 104 Outstation was only saved on project shutdown, and not on the
Save action of the configuration environment.

Communication
interfaces > IEC 60870-
5-104 Outstation

Also in: 11.2.06034,
11.2.06034

Could not create IEC 104 Outstation in Chinese (SPR # 62787)

The dialog box to create an IEC 104 outstation never opened due to a translation issue. The
issue only occurred when running PcVue in Chinese.

Communication
interfaces > IEC 60870-
5-104 Outstation

Also in: 11.2.06030

Robustness when exposing a large number of items (SPR # 62379)
A freeze of Sv32.exe could occur at startup if the number of items exposed was large
(approximately over 2000). It was due to the subscription of the configured items.

Now the subscription is done at once upon sector start, and unsubscription at sector stop.

Communication
interfaces > IEC 60870-
5-104 Outstation

Also in: 11.2.06001,
11.2.06001

Fatal error on new client connection to the OPC Server

Under some circumstances, a fatal error was occurring when several OPC clients were trying to
connect to the OPC Server at the same time.

Communication
interfaces > OPC Server
Also in: 11.2.06076

Fatal error upon OPC group disposal (SPR # 64256)

Under some circumstances, a fatal error could occur when an OPC Group was incorrectly
disposed of by an OPC Client.

Communication
interfaces > OPC Server
Also in: 11.2.06071,
11.1.06115

Fatal error when adding an item (SPR # 62771)

A fatal error occurred when an OPC client was trying to add an item with the /tem/d set to NULL.

Communication
interfaces > OPC Server
Also in: 11.2.06031,
11.1.06091

Fatal error upon alarm deletion (SPR # 64152)

Under some circumstances, a fatal error could occur when deleting an alarm configured with
associated actions. The issue occurred particularly when synchronizing a configuration with the
Application Architect.

Configuration
Environments
Also in: 11.2.06076

Changing variable type (SPR # 65004, 64020, 61529)

Changing the type of a variable through Smart Generators or Application Architect was not
working properly. The initial type of the variable was kept.

Configuration
Environments

Fatal error on frame modification (SPR # 64748, 60724)

Under some circumstances, a fatal error could occur when modifying a frame.

Configuration
Environments
Also in: 11.2.06073
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Size limit of IEC 61850 configuration properties (SPR # 63761, 63760,
63759)

The max size and range of several properties of IEC 61850 devices were not correctly checked in
the Application Explorer and Application Architect:

Password (80 characters)

Local AP IP (19 characters)

® Remote AP IP ( 19 characters)

®  |ocal AE Qualifier (range [0..65000])

Configuration
Environments

Fatal error when trying to insert a variable in a SCADA Basic program
(SPR # 63971)

A fatal error could occur when opening the variable selector from the SCADA Basic Editor.

Configuration
Environments
Also in: 11.2.06063,
11.2.06063

Duplicated objects (SPR # 62097, 16924, 15998)

Under some circumstances, some configuration items were displayed twice in the Application
Explorer after creating, importing or editing them. Re-opening the Application Explorer was
solving the issue.

Configuration
Environments
Also in: 11.2.06058

Max period for cyclics (SPR # 61676)

The allowed range for a cyclic period was not defined. From now on, the range is enforced from
1 to 359 999 sec (99h 59min 59sec).

Configuration
Environments
Also in: 11.2.06035,
11.2.06035

Incorrect pre-selection in selectors (SPR # 58906)

Symbol, mimic, mimic template and program selectors have been improved to display and pre-
select the correct library and the correct item when being re-open.
The issue was affecting all configuration tools, in particular:

®  The Application Architect when changing a symbol or a mimic template already
defined/used in a template,

®  The Application Explorer when modifying a mimic action associated to an alarm,
®  Smart Generators such as the SG-CAD...

Configuration
Environments
Also in: 11.2.06025,
11.2.05000

Fatal error on SNMP variable generation (SPR # 65293)

A fatal error occurred when generating SNMP variables after the end of the trial period.

Configuration
Environments >
Application Architect
Also in: 11.2.06076

Mimic modifications lost upon synchronization (SPR # 65016)

When synchronizing a project, modifications in mimics were lost. Mimics were re-created
instead of being updated.

Configuration
Environments >
Application Architect
Also in: 11.2.06073

Properties not displayed

Some properties of variable items were not displayed when the source was substituted
(ScaledValue, DeviceMinimumValue, DeviceMaximumValue, DeadbandValue, DeadbandType).

Configuration
Environments >
Application Architect
Also in: 11.2.06073

Mimic generated in the wrong library

When a mimic was generated in a library, the friendly name of the library was used instead of its
directory path.

Configuration
Environments >
Application Architect

Could not create Associated Labels (SPR # 64224)

It was not possible to create Associated Labels that were defined by expressions.

Configuration
Environments >
Application Architect
Also in: 11.2.06064
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PcVue >

Could not insert global parameters in expressions (SPR # 63387)

Global parameters were not displayed and therefore could not be inserted when defining a
property by an expression. Inserting them manually was working properly.

Configuration
Environments >
Application Architect
Also in: 11.2.06057

Alarm Synthesis Server List not inherited by global parameter (SPR #
62988)

Global parameters affecting the Server List property were not applied properly to Alarm
Synthesis objects.

Configuration
Environments >
Application Architect
Also in: 11.2.06038

Incorrect symbol insertion with missing parameter value

When inserting a symbol which position is calculated with a parameter and the parameter value
is not given (either by input or by default value), the symbol position is by default set to upper-
left. A warning message is still displayed in the generation window ("missing parameter").

Configuration
Environments >
Application Architect
Also in: 11.2.06033

Global parameters not working with unmanaged SNMP devices
Global parameters were not working properly with unmanaged SNMP devices.

Configuration
Environments >
Application Architect
Also in: 11.2.06033,
11.1.06092

Could not create multiple instances at once (SPR # 62831)
Multiple instantiation of inherited templates was not possible.

Configuration
Environments >
Application Architect
Also in: 11.2.06031,
11.1.06091

Fatal error when resetting Initial Value
A fatal error was occurring when resetting the Initial Value property of a Register variable item.

Configuration
Environments >
Application Architect
Also in: 11.2.06026

Global parameter Client List applied to Cyclic and Event objects

When configuring a global parameter for the Client List property with targeted object type set to
Any, Cyclic and Event items were affected even if they should not. This was leading to a failure
of the generation.

Configuration
Environments >
Application Architect
Also in: 11.2.06026,
11.1.06085

Impossible to paste alarm behavior on threshold items (SPR # 62664)

It was not possible to paste an alarm behavior on a variable's threshold.

Configuration
Environments >
Application Architect
Also in: 11.2.06025

Setting Associated Labels on instances (SPR # 62644)

A fatal error was occurring when trying to set the Associated Labels of a variable at the
instances level.

Configuration
Environments >
Application Architect
Also in: 11.2.06025

Could not set inhibiting bit of trends (SPR # 62532)

An error was raised when generating after having changed the Inhibiting bit property of a trend
item in the Application Architect.

Configuration
Environments >
Application Architect
Also in: 11.2.06023,
11.1.06079
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PcVue >

Naming rule evaluation
The naming rule was not always correctly evaluated on mimic items.

Configuration
Environments >
Application Architect
Also in: 11.2.06022

Unused parameters (SPR # 62493)

Under some circumstances, a parameter removed from a template could remain visible in the
instance panel.

Configuration
Environments >
Application Architect
Also in: 11.2.06022

Incorrect generation of mimics and symbols (SPR # 62440)

Symbols and mimics were not properly generated when parameters were used to define some
of their properties.

Configuration
Environments >
Application Architect
Also in: 11.2.06022,
11.1.06076, 11.0.06087

Creation of alarm synthesis with branch and expression (SPR # 62351)

It was not possible to create an alarm synthesis using both a branch and an expression. Such a
configuration was working properly when using the Application Explorer.

Configuration
Environments >
Application Architect
Also in: 11.2.06010,
11.1.06073

Message Encoding property not editable (SPR # 62349)

The Message Encoding property of events of type e-mail was not editable.

Configuration
Environments >
Application Architect
Also in: 11.2.06001

Missing panels (SPR # 62639)

Under some circumstances, some panels were hidden due to an incorrect saving of the splitter
positions.

Configuration
Environments >
Application Architect
Also in: 11.1.06089,
11.1.06088

Selection lost in combo box (SPR # 65578)

Entering and leaving the edit mode in a combo box caused the selected value to be reset when
the combo box was in a tree view such as in settings dialog boxes or in the advanced property
tab of most configuration items.

In addition to improving the user experience, this fix also avoid losing configuration values in
cases the configuration element was not actually changed.

Configuration
Environments >
Application Explorer

Incomplete OPC Mapping (SPR # 65100)

Some links between OPC items and variables were missing in the Mapping dialog box, despite
having the link correctly configured within the variable configuration dialog box. This was due to
a case sensitiveness issue.

Configuration
Environments >
Application Explorer

Fatal error when browsing an OPC Server (SPR # 64988)

Under some circumstances, a fatal error could occur in the Application Explorer when browsing
an OPC DA3.0 Server with a multiple of 1000 items within the browsed branch.

Configuration
Environments >
Application Explorer

Fatal error with quick connections & disconnections (SPR # 62805)

A fatal error could occur in the Application Explorer when IEC 104 devices were quickly
connecting and disconnecting (due to network issues for example).

Configuration
Environments >
Application Explorer

Trends items after archive unit deletion (SPR # 63573)

Trends were not correctly removed when their associated archive unit was deleted.

Configuration
Environments >
Application Explorer
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PcVue >

Unable to add Threshold on Alarm Counter (SPR # 64482)

It was not possible to add Threshold behavior on System Alarm Counter such as
System.NoAckOn.All.Domain_*,

Configuration
Environments >
Application Explorer

Fatal error on Log list creation (SPR # 64564)

A fatal error could occur when creating a Log list when no default Database or Log table is
defined.

Configuration
Environments >
Application Explorer

Copying/Pasting user profile

When copying and pasting a user profile, the associated user are no longer copied.

Configuration
Environments >
Application Explorer

Loss of custom format for Register variables (SPR # 64153)

Custom format of register variables could be lost due to an improper initialization of the
corresponding property when re-opening the variable's configuration dialog box.

Configuration
Environments >
Application Explorer
Also in: 11.2.06068

Exception on pasting an item (SPR # 64083)
Under some circumstances, an exception was raised when pasting an item that had been
deleted after being copied.

Configuration
Environments >
Application Explorer

Thresholds behavior not refreshed (SPR # 64809, 64036, 60434, 59018,
59017, 58623, 48177)

Thresholds behaviors were not correctly refreshed in the Application Explorer when adding,
modifying or deleting them.

Configuration
Environments >
Application Explorer

Auto-completion in expression (SPR # 63968)

The auto-completion was not working properly when editing an expression.

Configuration
Environments >
Application Explorer
Also in: 11.2.06064,
11.1.06113

Fatal error when editing a population having more filter elements than
authorized (SPR # 63496)

A fatal error occurred when trying to edit a population having more filter elements than the
authorized limit (50). This could happen when a population is created using the SCADA Basic
instruction or by editing the configuration file. Now, the number of filter elements is enforced
correctly when creating a population via SCADA Basic and at loading time.

Configuration
Environments >
Application Explorer
Also in: 11.2.06058,
11.2.06058

Fatal error on branch deletion (SPR # 62189)

Under some circumstances, a fatal error could occur when deleting a branch containing a large
amount of sub-branches and variables.

Configuration
Environments >
Application Explorer

Variable modification not taken into account (SPR # 63186, 63185, 63076)

Some variable configuration modifications were not taken into account when several variable
configuration dialog boxes were opened at the same time.

Configuration
Environments >
Application Explorer
Also in: 11.2.06056

Variable browser not correctly resized (SPR # 62881)

Under some circumstances, the variable browser was not correctly resized after opening its
context menu.

Configuration
Environments >
Application Explorer
Also in: 11.2.06038
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PcVue >

Trends behavior not removed after deletion (SPR # 62536)

Application Explorer was not correctly refreshed after deleting a HDS trend when the archive
unit was set for read-only or when the connection to the database was in error.

Configuration
Environments >
Application Explorer
Also in: 11.2.06034,
11.1.06093, 11.0.06093,
10.0SP2_Update

Upgrade Linking Bit Associated Label to alarm variable and vice-versa
(SPR # 62606)

Prior to version 11.2, it was possible to link a Bit Associated Label to an alarm variable and an
Alarm Associated Label to a bit variable, which was no longer possible since 11.2.05001.

A new Compatibility setting is available to enable such a configuration. It is activated by default
when upgrading a project and deactivated with new projects.

Configuration
Environments >
Application Explorer
Also in: 11.2.06026

Missing icons added (SPR # 62513)

Several missing icons added in Labels configuration.

Configuration
Environments >
Application Explorer
Also in: 11.2.06026

Clipboard support for Associated Labels (SPR # 62514)

It is now possible to Copy/Cut/Paste Associated Labels configuration items.

Configuration
Environments >
Application Explorer
Also in: 11.2.06025

Inhibiting bit on events (SPR # 60551)
Removing the inhibiting bit behavior of an event was only deleting the bit variable. It now also
reset the inhibiting bit property of the event.

Configuration
Environments >
Application Explorer
Also in: 11.2.06022

Improved indications upon configuration saving (SPR # 58667)

The indications related to the configuration saving process have been improved. This includes a
specific message if a configuration file cannot be saved because it is open in another application
(such as Microsoft Excel or a text editor).

Configuration
Environments >
Application Explorer
Also in: 11.2.06022,
11.2.06022, 11.2.06022,
11.2.06022

Default filter on variable selector for trends (SPR # 61378)

The default filter on variable type was incorrect when the variable selector was used in the
context of trend configuration. Under some circumstances, text variables were displayed
instead of register variables.

Configuration
Environments >
Application Explorer
Also in: 11.2.06001

Fatal error of the Application Explorer (SPR # 62182, 62181)

A fatal error occurred when handling items having several contextual tasks in the Application
Explorer (tasks in the left panel). The issue was due to a leak of User system objects and could
happen after several thousand clicks.

Configuration
Environments >
Application Explorer
Also in: 11.2.06001

Additional child nodes in navigation tree (SPR # 62340, 62334)

Some child nodes were wrongly displayed in the navigation tree of the SNMP Manager and
BACnet.

Configuration
Environments >
Application Explorer
Also in: 11.2.06001,
11.2.06001
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PcVue >

Upgrade Log list transitions inverted (SPR # 62312)

After applying a modification on a database log list, the transitions "Change to 1" and "Change
to 0" were inverted.

Prior to this fix, the recorded events were the ones displayed at the opening of the
configuration window.

The Generic Import had the same issue.

This issue had no side effect in the many cases when both transitions "Change to 1" and
"Change to 0" were recorded in the same log list.

Configuration
Environments >
Application Explorer
Also in: 11.2.06001,
11.1.06066, 11.0.06086

XML Generic Import - Synchronization by drag & drop (SPR # 64770)

When dragging and dropping a file in the XML Generic Import smart generator dialog box, a
fatal error occurred if the file had already been imported once. Now it runs a synchronization.

Configuration
Environments > Smart
Generators

Fatal error when closing SG imports

A fatal error could occur when closing the Smart Generator imports list if a file was referred to
several times in the import references.

Configuration
Environments > Smart
Generators

Size of the Generation dialog increasing (SPR # 64477)

The size of Configuration Generation dialog was increasing after several generations, in
particular when generating from the Application Architect.

Configuration
Environments > Smart
Generators

Fatal error on DDE configuration import (SPR # 64553)

A fatal error could occur when importing an incomplete configuration of DDE Client.

Configuration
Environments > Smart
Generators

Duplicated items after import (SPR # 64077, 64076, 64075)

Under some circumstances, existing items were duplicated due to case sensitiveness issues.

Configuration
Environments > Smart
Generators

SG-BACnet - Missing variable after synchronization (SPR # 63801)

Under some circumstances, when synchronizing a project based on an EDE file, the first variable
declared was deleted. This was due to an incorrect formatting of the header line in the EDE

Configuration
Environments > Smart
Generators

SG-CAD - Image cropping (SPR # 63126)

Free cropping has been reworked and now correctly generates background images for mimics.

Configuration
Environments > Smart
Generators

Fatal error when importing variables (SPR # 63680)

Under some circumstances, a fatal error could occur after importing new variables when the
project was configured with the option Permanent scan for mimics activated.

Configuration
Environments > Smart
Generators

Also in: 11.2.06059

Generic Import - Compatibility of OnVariableExpressions items (SPR #
63111)

Since version 11.2, it was no longer possible to use the result variable name as the id of
OnVariableExpressions items.

Configuration
Environments > Smart
Generators

Also in: 11.2.06055

Generic Import - Trailing spaces removed in extended attributes (SPR #
63100)

Trailing space characters in extended attributes' values were removed when importing
configuration with the Generic Import. This regression appeared in the following versions:

® 11.0.06074
® 11.1.06033
® 11.2.05001

Configuration
Environments > Smart
Generators

Also in: 11.2.06047
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SG-Step7 - Fatal error when importing a large amount of variables (SPR
#61543)

Under some circumstances, a fatal error could occur when importing a Step7 configuration with
a large amount of variables (over 100 000). It was also linked to the computer's performances.

Configuration
Environments > Smart
Generators

Also in: 11.2.06038

SG-Unity - Fail to create new import (SPR # 62292)

A fatal error occurred when trying to create a new Unity import after the creation of an OPC
XML-DA server.

Configuration
Environments > Smart
Generators

Also in: 11.2.06036,
11.1.06094

Generic Import - Events not synchronized (SPR # 62824)

When using the Generic import, events were not correctly synchronized due to automatic
naming mechanism.

Configuration
Environments > Smart
Generators

Also in: 11.2.06035

SG-TwinCAT - Could not import undefined type arrays (SPR # 62940)

A fatal error occurred when importing a .tpy file containing an array with undefined type. From
now on, in such condition, the array is ignored during the import.

Configuration
Environments > Smart
Generators

Also in: 11.2.06035

Fatal error on property value update (SPR # 65801)

A fatal error could occur when a property value was updated on a client station from the
BACnet helper.

Data Acquisition >
BACnet Client
Also in: 11.2.06080

Fatal error when watchdog property not defined

Since version 11.2, a fatal error could occur when the watchdog property of BACnet device was
not defined.

Data Acquisition >
BACnet Client
Also in: 11.2.06080

Fatal error when retrieving Trend Log with on-demand reads (SPR #
65515)

Under some circumstances, a fatal error could occur when retrieving Trend Log or Notifications
with the on-demand read mechanism, in particular with configuration having many Trend Log
objects configured (>1000).

Data Acquisition >
BACnet Client
Also in: 11.2.06078,
11.2.06078

Fatal error when stopping BACnet communication (SPR # 65438)

Under some circumstances, a fatal error could occur at shutdown if the project took advantage
of BACnet Alarms.

Data Acquisition >
BACnet Client
Also in: 11.2.06076

Column notification-class in EDE file (SPR # 65083)

The column notification-class as specified in the EDE v2.3 spreadsheet is now supported.

Data Acquisition >
BACnet Client

Fatal error when loading large EDE file (SPR # 65013)

Under some circumstances, a fatal error could occur when loading large EDE files. From now on,
only the first 10000 lines of the file are loaded and a warning message will be displayed in the
Event Viewer if this limit is reached.

Data Acquisition >
BACnet Client

Fatal error upon acknowledgment notification (SPR # 65187)

Under some circumstances, a fatal error occurred due to a notification of type acknowledgment
event (ACK-NOTIFICATION).

Data Acquisition >
BACnet Client
Also in: 11.2.06075

Fatal error after multiple connections & disconnections (SPR # 65176)
A fatal error due to a deadlock could occur after multiple connections & disconnections.

Data Acquisition >
BACnet Client
Also in: 11.2.06073
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Time-out message with Trend Logs (SPR # 64891)
A time-out message was displayed at startup for all trended variables linked to a BACnet Trend
Log.

Data Acquisition >
BACnet Client
Also in: 11.2.06072

Fatal error upon alarm acknowledgement (SPR # 64600)

Under some circumstances, a fatal error could occur when processing alarm acknowledgement
in Notification-Class objects.

Data Acquisition >
BACnet Client
Also in: 11.2.06072

Trend Log not correctly retrieved after a switchover (SPR # 64824)

Under some circumstances, Trend Logs could be retrieved several times after a switchover in
case of data acquisition redundancy.

Data Acquisition >
BACnet Client
Also in: 11.2.06072,
11.2.06072

Empty object-type and var-type lists (SPR # 62962)

The lists of object-type and var-type were empty when the associated device was disconnected.

Data Acquisition >
BACnet Client

Truncated value sent for writing (SPR # 63995)

Under some circumstances, the value sent when writing a floating point number was truncated
(e.g.: 10.3 was sent as 10)

Data Acquisition >
BACnet Client
Also in: 11.2.06071

Parsing vendor-specific columns (SPR # 64479)

Fix of a fatal error occurring when parsing EDE files if a vendor-specific columns is located
before standard columns.

Data Acquisition >
BACnet Client
Also in: 11.2.06067

Device incorrectly considered as offline

Under some circumstances, devices were incorrectly displayed as offline. The issue occurred
with devices containing a large number of notification-class objects if their initialization was
taking longer than the configured time-out.

Data Acquisition >
BACnet Client
Also in: 11.2.06057

Fatal error at the end of the trial period
Under some circumstances, a fatal error could occur at the end of the trial period.

Data Acquisition >
BACnet Client

Fatal error on writing time-out (SPR # 63276)

Under some circumstances, fatal errors could occur in case of time-out after sending writes
command.

Data Acquisition >
BACnet Client

Also in: 11.2.06059,
11.2.06055, 11.1.06106

Fatal error after stopping BACnet communication

Under some circumstance, a fatal error could occur when stopping the BACnet communication,
in particular when notification-class were operating.

Data Acquisition >
BACnet Client
Also in: 11.2.06056

Datatype Egress-Time not recognized
Properties of type Egress-Time were not correctly detected when browsing devices.

Data Acquisition >
BACnet Client
Also in: 11.2.06055

Unable to write to enumerated proprietary property
It was not possible to write a proprietary property if its BACnet datatype was "enumerated".

Data Acquisition >
BACnet Client
Also in: 11.2.06055

Unable to write XML data to SetPoint-Reference & Accumulator-Record

It was not possible to write XML value in SetPoint-Reference and Accumulator-Record datatypes
properties.

Data Acquisition >
BACnet Client
Also in: 11.2.06055
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PcVue >

Incorrect value retrieved for the Accumulator object (SPR # 63021) Data Acquisition >

The retrieved value after calculation kept the same datatype as the present-value property BACnet Client

(unsigned integer) leading to rounded values (e.g. value "3.0" was retrieved instead of "3.4" for .

example). AlSO n: 11206039,
11.2.06038

ADPU size limitation (SPR # 63022) Data Acquisition >

The max APDU size in advanced settings of device is now limited to 1476 (as defined in the BACnet Client

standard), except in mode “Display Advanced Features” where it can be adjusted up to 100 000. -

In addition, it is no longer required to restart the device to apply APDU length modifications. Also in: 11.2.06038

Failed to write Boolean properties (SPR # 62950, 62937) Data Acquisition >

It was not possible to write Bit variables linked to a BACnet property of type Boolean (such as BACnet Client

out-of-service).

Also in: 11.2.06035

Associated labels not refreshed (SPR # 61820) Data Acquisition >

After a configuration modification, associated labels linked to Schedule objects were not BACnet Client
correctly refreshed in the Application Explorer. i
! o ’ Also in: 11.2.06034

Could not read UCS_2 character type (SPR # 62833) Data Acquisition >
A fatal error was occurring when reading properties encoded with UCS_2 character type. BACnet Client

Also in: 11.2.06034

Handling of duplicated Deviceld (SPR # 62904, 62709, 62221) Data Acquisition >
A fatal error could occur when stopping a network in case of duplicate Deviceld on the network. BACnet Client

Also in: 11.2.06034

Using reserved and proprietary properties (SPR # 62926, 62734) Data Acquisition >

It is now possible to view and map variables on properties whose identifier is in the reserved but  BACnet Client
undefined range (as per the BACnet standard). -

Proprietary properties are also displayed in the mapping editor and variables can be map on Also in: 11.2.06034,
them. 11.2.06034, 11.2.06034
In such cases, values will be handled correctly at runtime if the property type is standard and o o
supported (as per the PICS).

Improved robustness of Trend Log property reading (SPR # 62785) Data Acquisition >
A fatal error of Sv32.exe could occur when receiving an incorrect response to a request for BACnet Client
reading some properties of Trend Log and Trend Log Multiple objects. The issue could occur at .

initialization time, or when using the Trend Log Helper. Also in: 11.2.06030
Incorrect day in Schedule helpers Data Acquisition >
In the Helper for Schedule objects, "Monday" was written in front of each days of BACnet Client

BACnetDailySchedule arrays. .
/ Y Also in: 11.2.06026

Invalid variables for some object types (SPR # 61072) Data Acquisition >

When a variable was mapped at the object level on an object of type Calendar, Group, BACnet Client
Averaging or Command, it was never initialized properly and its status was always NS_COM. .
Also in: 11.2.06026

Fatal error on reinit message Data Acquisition >
Under some circumstances, a fatal error could occur, when sending a re-initialization message BACnet Client
to a device protected by a password. .

’ yep Also in: 11.2.06025
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PcVue >

Several fixes & enhancements (SPR # 62581, 62576)

The list of fixes & enhancements includes:
®  New traces and audit counters for COV subscription and unsubscription,
®  General enhancement of COV subscriptions handling,

®  COV unsubscriptions were not always sent, in particular in case of communication
failure or manual stop of the network,

The minimum COV subscription lifetime is now 10 mn,

A fatal error was occurring in the Application Explorer when applying reset property
from EDE mapping,

®  Incorrect look-up of Trend Log & Trend Log Multiple in case a variable was mapped on
a BACnet object and its Present Value was trend logged at the device level. The
consequence was that the Trend Log buffer was never retrieved. The look-up was
correct when the variable was mapped on the trended BACnet object property.

Data Acquisition >
BACnet Client

Also in: 11.2.06023,
11.2.06023, 11.2.06023,
11.2.06023, 11.2.06023,
11.2.06023, 11.2.06023,
11.2.06023, 11.2.06023

Several fixes & enhancements related to BACnet (SPR # 62580, 62574,
62573, 62561, 62554, 62552, 62551, 62252, 62244)
The list of fixes & enhancements includes:

®  Fixed dialog box resizing issues in the Helpers,

® |mproved persistency of the Mapping Editor dialog box sizes,

®  When a variable is mapped on a BACnet object, its status is now set to NS if the status-
flag is "bad" (was set to NS-COM),

®  Fix of regression - The Scale property was not taken into account properly when
calculating the value of Accumulator objects,

®  Trend Log buffer retrieval from the Helpers is now working properly when used from a
PcVue client station (remote BACnet data acquisition server),

® Improved fallback in case a read of a Trend Log buffer returns a "value-out-of-range"
error.
This error is returned if PcVue is trying to read buffer sequence-number that are no
longer available in the device. In such a situation, the buffer read is retried by
requesting data based on the timestamp of the older record available in the Trend Log
buffer.
In particular, Trend Log buffers are retrieved by sequence-number at start-up (if
available),

® Anew setting is available to indicate whether Trend Log buffer reads via the Helpers
have to be stored in the archives or not. This setting defaults to False,

Improved tracing of Trend Log record storage in the archives,
In the Helpers, the selection of a Trend Log object was causing a useless read of its
buffer,

® At startup or upon reconnection, a first record was stored in the archives based on real
time values,

®  Under some circumstances, a fatal error could occur when shutting down PcVue while
a BACnet network was already in the stop phase,

®  Writing of one bit within a bitstring based on field extraction (as defined at the time of
mapping) was not working properly.

Data Acquisition >
BACnet Client

Also in: 11.2.06022,
11.2.06022, 11.2.06022,
11.2.06022, 11.2.06022,
11.2.06022, 11.2.06022,
11.2.06022, 11.2.06022,
11.2.06022, 11.2.06022,
11.2.06022, 11.2.06022,
11.2.06022, 11.2.06022,
11.2.06022, 11.2.06022

Trend Log records retrieval (SPR # 62387, 62370)

Trend Log records were not all retrieved and displayed in the Helper when several ReadRange
requests were necessary to process the request.

It was a known issue since version 11.2.05001.

Data Acquisition >
BACnet Client

Also in: 11.2.06010,
11.2.06010, 11.2.06001,
11.2.06001

Failure on Read requests (SPR # 62437)

Under some circumstances, read requests could fail due to a time-out when the device did not
support segmentation. It occurred in particular when reading properties returning large result
sets such as the object-list (Device object) or recipient-list (Notification Class object).

This issue happened in many circumstances when using the SCADA Engine simulator.

To avoid such a situation, a new setting can be edited in the file C\VarConf.dat to set the time-
out of read requests. Its default value is now 60 s (was 30 s).

Data Acquisition >
BACnet Client

Also in: 11.2.06010,
11.2.06001, 11.2.06001,
11.2.06001

Fatal error on network stop (SPR # 62229)

A fatal error was occurring when stopping a Network with a disconnected Device.

Data Acquisition >
BACnet Client
Also in: 11.2.06001
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PcVue >

Values not always refreshed in the BACnet mapping editor (SPR #
62197)

The value of properties displayed in the BACnet mapping editor was not always refreshed when
opening the dialog box.
It was a known issue since version 11.2.05001.

Data Acquisition >
BACnet Client
Also in: 11.2.06001

EDE mapping (SPR # 62229)

Several fixes have been implemented for the EDE mapping. In particular, proprietary objects and
alarm configuration are now properly supported.

Data Acquisition >
BACnet Client
Also in: 11.2.06001,
11.2.06001

Truncated description (SPR # 62193)

Some texts comprising double-quote characters were truncated, in particular in the object-
description properties.

Data Acquisition >
BACnet Client
Also in: 11.2.06001,
11.2.06001

Fatal error with complex-event-type notifications (SPR # 62861)

A fatal error occurred upon reception of a notification of type complex-event-type with no
parameter.

Data Acquisition >
BACnet Client
Also in: 11.2.05000

Fatal error with multiple connection/disconnection (SPR # 64497)

A fatal error was occurring in the Application Explorer in case of multiple fast
connection/disconnection.

Data Acquisition >
DNP3 Client
Also in: 11.2.06068

Fatal error when sending freeze commands
A fatal error occurred when sending a freeze command to a disconnected device.

Data Acquisition >
DNP3 Client
Also in: 11.2.06064

Incorrect device status on passive servers

In an association of type single active server, the device status displayed on passive servers was
incorrect. The status as seen by the active server was displayed.

Data Acquisition >
DNP3 Client
Also in: 11.2.06064

Fatal error with offline devices (SPR # 63750)

Under some circumstances, a fatal error could occur when the DNP3 driver was trying to check
the IIN bits of an offline device. The issue could happen when the communication was lost while
checking the IIN.

Data Acquisition >
DNP3 Client
Also in: 11.2.06060

Historical buffer not retrieved at startup (SPR # 62803)

At startup, only the last change was read and not the full buffer.

Data Acquisition >
DNP3 Client
Also in: 11.2.06037

Fatal error with periodic clock synch (SPR # 63227)

A fatal error could occur at start-up when a sector was configured to use UTC timestamps while
also configured to periodically send clock synchronization commands.

The issue was a regression introduced recently in PcVue 11.2.0.06054.

Data Acquisition > IEC

60870-5 Client
Also in: 11.2.06055

Fatal error with multiple write commands (SPR # 62402)

Under some circumstances, a fatal error could occur when several write commands were
processed at the same time.

Data Acquisition > IEC

60870-5 Client
Also in: 11.2.06055,
11.1.06102
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PcVue >

Various fixes & enhancements to the IEC 104 driver (SPR # 63189, 62402)

The list of fixes & enhancements includes:

®  Under some circumstances, the use of commands such as Reset, Clock synch and Test
from the Application Explorer could cause the PcVue main process to shut down due to
watchdog detection,

®  The Reset, Clock synch and Test commands can now be executed from a PcVue client
station or a passive data acquisition server. Until this enhancement, it could be
successfully executed only from the active data acquisition server,

®  Fix of a fatal error occurring at network startup. The issue only occurred with
configurations comprising a large amount of sectors.

Data Acquisition > IEC
60870-5 Client

Also in: 11.2.06054,
11.2.06054, 11.2.06054,
11.2.06054, 11.1.06099

Abnormal long execution time for SBO with Single Point (SPR # 62854)

It could take up to 10 sec to execute a Select Before Operate action when using the
corresponding SCADA Basic instruction with a Single Point. It did not occur with other data

types.

Data Acquisition > IEC
60870-5 Client
Also in: 11.2.06038

Fatal error on network start (SPR # 62402)

Under some circumstances, a fatal error could occur when starting an IEC 104 network. The
issue could be reproduced when a large number of sectors was configured.

Data Acquisition > IEC
60870-5 Client

Also in: 11.2.06024,
11.1.06080

Gl, Cl and ClockSync sent only once

The GlI, Cl and ClockSync commands were sent only once.

Data Acquisition > IEC
60870-5 Client

Also in: 11.2.06024,
11.1.06080

Inconsistent timestamp and quality after switchover
Timestamp source and quality were lost after a switchover in a single active association.

Data Acquisition > IEC
60870-5 Client

Also in: 11.2.06001,
11.1.06070

Handling of invalid timestamp

Invalid timestamps received from |IEC 104 devices were interpreted as valid. Prior to this fix, only
the unsync qualifier was taken into account to update the timestamp quality.

Data Acquisition > IEC
60870-5 Client

Also in: 11.2.06001,
11.1.06069

Could not write bitstring (SPR # 65771)

Under some circumstances, it was not possible to write data attributes of type bitstring, when
its size was modified in the device. The same issue occurred with data attributes of type
octetstring.

Data Acquisition > IEC
61850 Client
Also in: 11.2.06080

Command property not enabled when variable created from the
Mapping dialog box (SPR # 65111)

When creating a variable from the mapping dialog box (map on a new variable), the variable
was not flagged 'Commandable’ even if the Common Data Class type required a commandable
variable.

Data Acquisition > IEC
61850 Client

Double-Point On and Off value identical (SPR # 63762)

It was possible to configure the same ON and OFF values for double-point. Now when setting
ON to [10], OFF is automatically set to [01] and vice-versa.

Data Acquisition > IEC
61850 Client

Command locked if control model is SBOw or DEw

Commands with control models SBOw and DEw were locked when they the controlled value
was not of type boolean.

Data Acquisition > IEC
61850 Client
Also in: 11.2.06068

Incorrect connection state for Data Report groups

Under some circumstances, the connection state of Data Report group was not accurate. This
issue mainly occurs with slow connection.

Data Acquisition > IEC
61850 Client

Duplicate declaration of BRCB & URCB (SPR # 61065)

It was possible to configure several URCB/BRCB referring to the same physical one.

Data Acquisition > IEC
61850 Client
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PcVue >

Fatal error with Write command on SPC (SPR # 64111)

Under some circumstances, a fatal error could occur after sending a Write command on an SPC
data object.

Data Acquisition > IEC
61850 Client
Also in: 11.2.06064

Password with special characters (SPR # 64065)

It was not possible to define a password with special characters such as !,?,* or S.

Data Acquisition > IEC
61850 Client

Fatal error on SBOw and SBO command (SPR # 63265)

Since version 11.2.06040, some random fatal errors could occur when sending SBOw and SBO
commands.

Data Acquisition > IEC
61850 Client
Also in: 11.2.06055

SBO and DE could not be executed from client stations (SPR # 61175,
59161)

The SBO and DE commands can now be executed from client stations, even if using the SCADA
Basic instruction M61850.

Data Acquisition > IEC
61850 Client
Also in: 11.2.06040

Timestamp incorrectly updated (SPR # 62731, 62688)

When processing a change of a data object with a bad timestamp, the local acquisition
timestamp was wrongly used in case the value did not change. From now on, in such situation,
the timestamp is updated only if the value has changed.

Data Acquisition > IEC
61850 Client

Also in: 11.2.06035,
11.1.06093

Robustness in handling Entryld

Under some circumstances, a fatal error could occur due to concurrent access to internal
resources used to handle the Entryld of BRCB.

Data Acquisition > IEC
61850 Client

Also in: 11.2.06034,
11.2.06034, 11.1.06093,
11.1.06093, 10.0SP2

Incorrect value retrieved for t data attribute (SPR # 62851)

The displayed value was incorrect when a text variable was mapped on a t data attribute
(timestamp).

Data Acquisition > IEC
61850 Client

Also in: 11.2.06031,
11.1.06091, 11.0.06093

IEC 61850 & IEC 61400-25 catalogs updated (SPR # 62592, 62501)

The IEC 61850 catalog has been updated to fix a series of issues and enabling mapping of
complex CDCs from the mapping dialog box (61400-25's SPV and alike).

These changes also fix some issues when specializing or extending the catalog in a project's
specific catalog file.

Data Acquisition > IEC
61850 Client

Also in: 11.2.06026,
11.2.06025, 11.2.06024,
11.2.06023, 11.2.06023,
11.2.06023, 11.1.06082,
11.1.06081, 11.1.06080,
11.1.06078, 11.1.06078,
11.1.06078

Could not read data attribute

Under some circumstances, it was not possible to read a data attribute. The issue could occur
when the attribute to read belonged to an object that was part of an array (or one of its parent
object).

Data Acquisition > IEC
61850 Client

Also in: 11.2.06026,
11.1.06084

Enumala did not work with IEC 61850 (SPR # 62659)

The Enumala feature was not working properly with variables mapped on IEC 61850 data.

Data Acquisition > IEC
61850 Client

Also in: 11.2.06025,
11.1.06081
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PcVue >

Connection failure (SPR # 62500)

Connection to a device was failing and leading to a critical error on the network when there was
no DataSet configured on the device on the PcVue side.

Data Acquisition > IEC
61850 Client

Also in: 11.2.06022,
11.1.06074

Connection failure with the IEDScout
Connection to the IEDScout (OMICRON) was failing when using Edition 2 behavior.

Data Acquisition > IEC
61850 Client

Also in: 11.2.06010,
11.1.06073

Data acquisition redundancy (SPR # 65719)

The redundancy was not correctly handled. Despite becoming passive after a switchover, the
formerly active server was still processing read and write commands.

Data Acquisition > KNX
Also in: 11.2.06080

Values could remain NS COM (SPR # 64505)

When, at driver startup, the initial read request of a variable failed due to network issues, the
variable's status was remaining NS COM until the next value change was received. Now the
initial read is retried until the gateway respond.

Data Acquisition > KNX
Also in: 11.2.06067

KNX unsolicited traffic not received (SPR # 62508)

When configuring a KNX interface with only unsolicited data (e.g. without polled data), it was
deactivated after a time-period of 2 minutes without traffic.

Data Acquisition > KNX
Also in: 11.2.06022,
11.1.06074

Variables remained NS COM (SPR # 62889, 62835, 62722)

Due to missing information when reading the LonWorks' types catalog, some references were
not resolved and the variable remained NS COM (such as variables mapped to SCPTsetPnts
data).

Data Acquisition > LNS
Also in: 11.2.06033,
11.1.06090, 11.0.06093

Could not read variables value (SPR # 62722)

Since versions 11.0.06081, 11.1.06048 and 11.2.05001, some enumerated variables types were
remaining invalid (NS COM).

Data Acquisition > LNS
Also in: 11.2.06026,
11.1.06087, 11.0.06092

Fatal error on LNS startup (SPR # 62459)

While reading the LNS catalog, a format error exception was not properly handled, leading to a
fatal error.

Data Acquisition > LNS
Also in: 11.2.06023,
11.1.06079, 11.0.06089

Values remained NS after end of simulation (SPR # 63949)

When variables were set to simulated mode and back again to real-time, they remained with
quality NS until the next data change. This issue only occurred with OPC variables in particular
scenarios when the simulated mode was changed while the OPC server was disconnected.

Data Acquisition > OPC
Client

Also in: 11.2.06073,
11.2.06073

Incorrect timestamp after reconnection (SPR # 62622)

After a disconnection/reconnection to an OPC server, timestamp of variables which value had
not changed in the meantime were set with the timestamp of the reconnection instead of the
timestamp of the previous known valid change.

Data Acquisition > OPC
Client
Also in: 11.2.06026

Incomplete items list in the mapping dialog box (SPR # 62553)

When browsing an OPC server, only the first 1000 items were retrieved and displayed.
The issue only occurred with OPC Servers supporting the OPC DA 3.0 browsing interface.

Data Acquisition > OPC
Client

Also in: 11.2.06026,
11.2.06026, 11.1.06101,
11.1.06101

Fatal error when sending a recipe (SPR # 62661)

A fatal error was occurring when sending a recipe containing exclusively OPC variables mapped
on a deleted OPC Group or OPC Server. This could happen when manually editing the
configuration of the OPC Server.

Data Acquisition > OPC
Client

Also in: 11.2.06025,
11.1.06081, 11.0.06090
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PcVue >

Support for special characters in OPC Itemld (SPR # 64811, 64594) Data Acquisition > OPC

The configuration of OPC Items containing some special characters was incorrectly saved. The UA Gateway Client
characters ", ', &, < and > are now escaped to be correctly saved and interpreted. .
0 ’ 0 Also in: 11.2.06072,

11.2.06072
Driver XBUS-IP-SLAVE - Fatal error when stopping communication (SPR Data Acquisition >
# 65320) Other built-in drivers
A fatal error occurred when stopping communication using the Xbus IP-Slave driver. Also in: 11.2.06076
Driver Ferromatik - Fatal error with several networks Data Acquisition >
A fatal error was occurring when more than 20 networks were configured with this driver. Other built-in drivers

Also in: 11.2.06068

Fatal error when starting communication (SPR # 63288) Data Acquisition >

Under some circumstances, a fatal error could occur when the file C\Comm.dat was malformed  Qther built-in drivers
and the file CTEMP\Comm.dat was read-only.

Driver XBUS-IP-MASTER - Error 108 (SPR # 63930) Data Acquisition >

The error 108 occurred when the equipment was sending more data than requested. Now such  Qther built-in drivers
frames are accepted, but only the requested data length is processed, and only if the first

receive packet has a correct transaction Id. Also in: 11.2.06062,
11.2.06062
Variable not NS after Equipment stopped (SPR # 62816) Data Acquisition >

Under some circumstances, some variables could remain with quality Good instead of being NS Qther built-in drivers
after their associated Equipment was stopped.

Driver XBUS-IP-MASTER - Fatal error upon connection close (SPR # Data Acquisition >
63177) Other built-in drivers
A fatal error could occur when a device was configured with the property Close connection on Also in: 11.2.06054,

passive station activated.
Such configuration is used when the data acquisition architecture includes serial to IP converters 11.1.06099, 11.0.06093
with a limited max number of simultaneous TCP connections.

Driver XBUS-IP-MASTER - Fatal error using verb CIMWAY mode CFG Data Acquisition >

(SPR # 63085) Other built-in drivers
A fatal error could occur when using the SCADA Basic verb CIMWAY mode CFG if the param Also in: 11.2.06046
string exceeded 65 characters. '

8 11.2.06045
Fatal error when stopping CimWay (SPR # 63009) Data Acquisition >
A fatal error was occurring when stopping a CimWay driver while having pending write Other built-in drivers
commands. From now on, the stop request is suspended until all queued write commands are .
Thread leak when stopping communication (SPR # 63018) Data Acquisition >
A thread leak of 1 thread per device was occurring when stopping CimWay communication Other built-in drivers

using the SCADA Basic instruction CIMWAY/("OFF"). Also in: 11.2.06038

Driver XBUS-IP-MASTER - Message time-out (SPR # 62948) Data Acquisition >
The Message time-out management has been improved for better performances: Other built-in drivers
®  No longer played at start-up, which speeds up the start-up process, Also in: 11.2.06036,

®  Only played when the previous request is valid and within the Message time-out 11.1.06094, 11.0.06093

period, no longer all the time,
®  Only played once and not at every SendReceive period.

System status variables of frame always invalid (SPR # 62793) Data Acquisition >
The System variables for the status of frames were always set to NS even when frames were Other built-in drivers
started and working properly. .

Also in: 11.2.06033,

11.1.06092, 11.0.06093
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PcVue >

Driver XBUS-IP-SLAVE - Fatal error on Modbus function code 3 (SPR #
62439)

Under some circumstances, a fatal error could occur when responding to a request for registers
with the Modbus function code 3.

Data Acquisition >

Other built-in drivers

Also in: 11.2.06024,
11.1.06080

Driver TwinCat - Error when writing a float value (SPR # 62375)

A fatal error occurred when trying to write a float value with a frame size larger than 350 floats.

Data Acquisition >

Other built-in drivers

Also in: 11.2.06001,
11.1.06068

Fatal error when editing ICMP variable (SPR # 65424)

A fatal error occurred when editing an ICMP variable configured without polling group.

Data Acquisition >
SNMP Manager

Automatic conversion of numeric values (SPR # 63529)

String values can now be automatically converted to register values even when including
decimal and/or thousand separators.
Examples:

® 12,000.45=12000.45
® 12.000.45=12000.45
® 12,00045=12,00045
® 12.00045=12.00045

Data Acquisition >
SNMP Manager
Also in: 11.2.06059

Unable to stop project (SPR # 63672)

Under some circumstances, project did not stop when more than 64 devices were configured
with ping activated for status handling.

Data Acquisition >
SNMP Manager
Also in: 11.2.06059

Fatal error at startup (SPR # 63199)

Under some circumstances, a fatal error could occur at startup. It was due to the automatic
creation of a folder used by the SNMP Manager at the root of the system partition instead of
within the PER folder. When not run with administrative privileges, the system prevented the
folder creation, leading to the fatal error.

Data Acquisition >
SNMP Manager
Also in: 11.2.06054,

11.2.06054, 11.1.06099

Fatal error on SNMP Manager startup (SPR # 63215)

A fatal error could occur if the file mib_index was malformed, in particular if it contained a Null
character.

Data Acquisition >
SNMP Manager
Also in: 11.2.06054,
11.1.06100

Invalid started device counter (SPR # 62579)

The system variable and audit counters indicating the number of started devices was incorrect
in case of dynamic host resolution.

Data Acquisition >
SNMP Manager
Also in: 11.2.06026,
11.1.06078

SNMP devices without variables indicated as connected (SPR # 62577)

Devices using SNMP v3 without any variable mapped were always indicated as connected.

Data Acquisition >
SNMP Manager
Also in: 11.2.06026,
11.1.06078

Device defined with hostname not reachable (SPR # 62483)
When a device was defined using its hostname, it was not refreshed if the hostname could not
be resolved at startup (DNS not available). A restart of the project was necessary in such a
situation.
Two options have been added to the properties of a device:

®  Aresolution period for the hostname to cyclically check the IP address,

®  An option to resolve the hostname after a disconnection. If not activated, the initial
resolved IP address is used at reconnection time.

Data Acquisition >
SNMP Manager
Also in: 11.2.06022,
11.1.06074
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PcVue >

Variable value not refreshed (SPR # 62481)

When a device using SNMP v3 returns an engineTime equals to O at the first frame request,
variables configured as Trap with Ad'hoc sync were not correctly refreshed.

Data Acquisition >
SNMP Manager
Also in: 11.2.06022,
11.1.06074

Fatal error upon generation of an export (SPR # 65841, 65036)

A fatal error could occur when generating an export with a time-period greater than the
authorized limit. It is no longer possible to set the time period value out of bounds.

Data Export
Also in: 11.2.06080

Multiple Log lists in a Log page (SPR # 64579)

Under some circumstances, it was possible to configure multiple Log lists in a Log page. Now,
when associating a Log list to a Log page, the previous one is correctly removed.

Data Export

Columns not properly removed (SPR # 64986, 64826)

Removing columns from a Log page was not working properly. After having applied the removal,
the columns were still present and moved at the end of the list.

Data Export
Also in: 11.2.06073,
11.2.06073

Fatal error when generating an export with a log page (SPR # 64848)

Under some circumstances, a fatal error could occur when generating an export with a log page.

Data Export
Also in: 11.2.06071,
11.1.06116, 11.0.06097

Incorrect aggregated statistics (SPR # 64864, 64737, 64124)

When calculating aggregated statistics, the initial value was not taken into account when not
synchronized with statistic period start time, and NS values were not correctly managed. With
low frequency value changes, it was leading to erroneous calculation.

Data Export

Editing Trends and Log lists from Data Export (SPR # 63888)

It is no longer possible to modify Trends and Log lists directly from the Data Export
configuration. The properties of the associated items are still displayed, but they can no longer
be changed.

Data Export

Data export trace mask overridden (SPR # 64399)

Trace levels were not properly saved. Saving a trend page trace mask was causing an override of
the parent data export trace mask.

Data Export
Also in: 11.2.06066

Variable name in Trend pages was always exported (SPR # 63256)

In Trend pages configuration, the property "Show variable name" was not correctly loaded and
always active. As a consequence, variables names were always exported.

Data Export
Also in: 11.2.06064

Export disappear after creation (SPR # 63937)

Exports configured were disappearing right after their creation, when they were configured with
a sever list to which the station did not belong.

Data Export
Also in: 11.2.06063

Incorrect Occurrence and Duration statistics (SPR # 63324, 62949)

Under some circumstances, Occurrence and Duration statistics were incorrect when the archive
setting Log only alarm on/off was activated,

Data Export

Statistical data when using "Log only alarm on/off changes in log lists"
(SPR # 64469, 63324, 62949, 62815)

Log pages statistics configuration and export were not correctly handled when the project
setting Archives.Log only alarm on/off changes in log lists was activated.

Data Export

Also in: 11.2.06066,
11.2.06061, 11.2.06058,
11.2.06056, 11.1.06103

Unsupported characters (SPR # 63858, 63696)

Some characters such as # (hash), / (slash), "(quote) or, (comma) were not correctly interpreted
in data export configuration when used in various properties (File Name, Sheet Name...) or in
expressions.

The issue was for example obvious when reloading a data export item where one of the
property was defined by an expression including at least 2 parameters separated by a comma -
The expression was truncated after the first comma.

Data Export

Also in: 11.2.06061,
11.2.06059, 11.1.06106,
11.0.06095, 11.0.06094

Incorrect aggregated statistics in export (SPR # 63863)

Under some circumstances, when exporting a Trend Page with aggregated statistics, the last
values were incorrect. The issue could occur with HDS archive units when the exported trend
had no valid value at the end of the period. In such conditions, the last valid aggregated data
was wrongly duplicated until the end of the period.

Data Export
Also in: 11.2.06061,
11.1.06110, 11.0.06095

Reference: PcVue 12 Release Notes
Copyright ©2024 - ARC Informatique. All rights reserved — LI N0 H I3

Last update: November 3, 2025

Page 63/119



4
PcVue >

Incorrect export dates (SPR # 63695) Data Export

The following expression elements were not processed properly and were returning an incorrect  Alsg in: 11.2.06059
date:

Export.StartDate.Year
Export.StartDate.Hours
Export.StartDate.Minutes
Export.EndDate.Year
Export.EndDate.Hours
Export.EndDate.Minutes

Cancelling an export (SPR # 48217) Data Export

The Cancel action when an export was in progress was not properly handled.

Incorrect duration calculation (SPR # 63041) Data Export

The duration stat for logged events could be wrong due to an incorrect calculation of the initial  Also in: 11.2.06056,

state in the calculated period. 11.2.06056, 11.2.06046,
11.1.06103, 11.0.06094

Trends not pasted when pasting a Trend page (SPR # 62696) Data Export
When copying and pasting a Trend page, the associated Trends were not copied properly. Also in: 11.2.06039
Next and Finish buttons remained enabled after an export was Data Export
cancelled (SPR # 62958) Also in: 11.2.06036

When canceling an export operation in the wizard, the Next and Finish buttons were not
disabled. Clicking on the Next button was leading to a fatal error.

First point in aggregated values (SPR # 62366) Data Export

When exporting aggregated values, the first value was incorrect because the previous valuewas  Also in: 11.2.06035
not correctly taken into account.

For instance, with a 1 min sampling period between 10h00 and 10h10, the first row will contain

all values between 10h00 to 10h00.59.999 plus the previous value of the point if it exists. In

addition, the last row will contain values between 10h09 and 10h09.59.999.

Memory leak Data Export
Fix of a memory leak when exporting aggregated values. Also in: 11.2.06035,

11.1.06093, 11.0.06093

Incorrect samples with weekly period (SPR # 62896) Data Export

Some incorrect samples were generated when exporting trends with the sampling period setto  Also in: 11.2.06034

Week. '

11.1.06093, 11.0.06093

Matrix formula lost (SPR # 62795) Data Export

Matrix formula were lost when exporting data. Also in: 11.2.06031

Empty export for logs Data Export

Since versions 11.1.06087 and 11.2.06026, exporting logs was no longer working and always Also in: 11.2.06030

returned an empty export. '
e 11.1.06089

Folder creation upon generation (SPR # 61877) Data Export

When generating a csv export, any necessary folder is created correctly as part of the Also in: 11.2.06010

generation. Until this fix, the csv file export could be aborted due to the failure of the folder ’

creation. 11.2.06001

It was a known issue since version 11.2.05001.

Maximum number of points reached (SPR # 62184) Data Export

The message indicating that the maximum number of points is reached was not always Also in: 11.2.05000

prompted by the wizard.
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Incorrect aggregated values and statistics (SPR # 62274, 62149)

Under some circumstances, some aggregated values and statistics were wrong in the export, in
particular the duration of alarms and number of occurrences. This was due to different Time
Zones between the station generating the exports and the station hosting the archive unit.
This issue was a regression due to changes done on July 2014, and also affected version 11.0
and 11.1.

Data Export

Also in: 11.2.05000,
11.2.05000, 11.1.06065,
11.1.06064, 11.0.06085,
11.0.06084

Memory leak with function SetDataSet (SPR # 64852)

Updating a Text variable with the method SetDataSet caused a small memory leak.

Development kits > SV
Manager Toolkit
Also in: 11.2.06082

Fatal error on project shutdown

On project shutdown, a fatal error could occur in particular cases when a variable subscription
response was being received while shutting down.

Development kits > SV
Manager Toolkit
Also in: 11.2.06063

Upgrade Incorrect value for inhibition bit of log lists (SPR # 62332)

The InhibitingCondition property of LogFilter in Free, ODBC and Proprietary units was wrongly
interpreted during import.
Prior to this fix the following values had to be used:

®  (Oto activate the inhibition bit

Development kits >
XML Generic Import
Toolkit

Also in: 11.2.06001,

® .1 to deactivate the inhibition bit 11.2.06001
The default value was correct.
Modal warning message in service mode (SPR # 64976) General

When running the Supervisor as a Windows service, some messages typically displayed in
interactive user sessions were not disabled, leading to a fatal error. These messages were
warnings related to:

®  The number of GDI objects

®  The number of User objects

®  The percentage of used memory
®  The number of opened mimics

Also in: 11.2.06072

Freeze during startup - Alarm Manager (SPR # 64576)

Under some circumstances, PcVue could freeze during project startup when loading the Alarm
manager.

General
Also in: 11.2.06068

Could not insert variable in a Recipe (SPR # 64296)

An improper message was displayed when trying to insert a variable defined by another variable
in a recipe. It was only occurring when both variable had a minimum value different from 0.

General
Also in: 11.2.06064,
11.2.06064, 11.2.06064

ncorrect language in window's title
| tla a dow's titl

At startup and on language change, the title of the PcVue main window and the event viewer
were not correctly updated according to the display language.

General

Also in: 11.2.06057,
11.2.06057, 11.1.06105,
11.1.06105

SMS and Email events - Various fixes and enhancements (SPR # 63697,
63527, 63093)
The list of fixes & enhancements includes:
® Anincorrect error message was displayed in the Event Viewer when trying to send a
message to an unknown user or with an unknown SMS/Email profile;
®  Checking the existence of users and profiles have been improved before sending
messages;
Messages queuing reworked in case of sending error/failure;
Customization of modem configuration is now possible through several new settings:
XON/XOFF, CTS handshaking, DSR handshaking, DSR sensitivity, DTR circuit, RTS circuit
and Set RTS signal.

General

Also in: 11.2.06060,
11.2.06060, 11.2.06058,
11.2.06055, 11.2.06054,
11.2.06054, 11.2.06054,
11.1.06102

Fatal error few minutes after a configuration modification (SPR # 63152)

Under some circumstances, a fatal error could occur few minutes after a configuration
modification. It could happen in case of a networking application having flow regulation
activated during the modification. The fatal error occurred when the regulation stopped, if a
modified object was still in the regulation queue.

General
Also in: 11.2.06048,
11.1.06098
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Consecutive emails not sent (SPR # 63086) General

Some emails were lost when sending several of them almost simultaneously via event actionsor  Alsg in: 11.2.06047

SCADA Basic. It was only possible to send one email per event and per millisecond. ’
P ’ 0 11.2.06047

SMS sent continuously (SPR # 63075) General

When sending SMS to multiple recipients, including an incorrect one, first recipients defined Also in: 11.2.06045,

before it were receiving continuously the SMS, while recipients defined after the incorrect one

were never receiving the SMS. 11.1.06098

Unable to run as a service General

Under some circumstances, when an unhandled exception occurred in the services Also in: 11.2.06039,

svCoreDaemon or svCoreSessionHost, the process hosting them was no longer responding. The

Service Control Manager was then terminating the process after the usual 30-second time-out 11.2.06038

and logged the following error message:

"Error 1053: The service did not respond to the start or control request in a timely fashion".

Additional diagnostics messages have been added to traces in such a situation.

Email template values field options (SPR # 63000) General

Email template values field options were not correctly handled as described in the help:

®  Not defined by the template - The template does not provide information for that field.
This is the default setting.

®  |mposed by the template - The text that you enter will be used in any message where
the template is used and cannot be changed there.

®  Suggested by the template. The text that you enter will be used in any message where
the template is used but can be edited there.

Also in: 11.2.06038

Fatal error caused by large email messages (SPR # 62965)

Sending an email message longer than 10240 characters was causing a fatal error. From now on,
such messages are truncated.

General
Also in: 11.2.06038

Incorrect email address format (SPR # 62999)

Under some circumstances, a fatal error could occur when sending emails to an invalid email
address used in one of the following fields: sender, reply-to, to, cc, bcc.

The dialog boxes now prevent typing in such addresses, it can happens when manually editing
configuration files, using a project developed with an earlier version or using substitution
characters.

General
Also in: 11.2.06038

Libraries' modification rights (SPR # 62957)

From now on, new libraries are created with modification rights given to all users. Previously,
they were dependent on the profile.

General

Also in: 11.2.06038,
11.2.06037, 11.1.06095,
11.1.06094

"Open context mimic" setting not saved (SPR # 62978) General

The HMI option Open context mimic was not correctly reloaded when a mimic was open via Also in: 11.2.06038,
SCADA Basic at project startup. 11.1.06095
Missing system variables STATUS and STATUSCOMP (SPR # 62626, General

62394)

The system variables STATUS and STATUSCOMP are now always created automatically. The
associated setting to create them has been removed.
Automatic creation of these variables for an existing project can be done by saving variables.

Also in: 11.2.06035

Email testing with profile (SPR # 62755)

It was not possible to send a test email with a specific account profile. It was working fine when
indicating directly an email address.

General
Also in: 11.2.06027,
11.1.06088
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Upgrade Support for secured connections to email servers (SPR # 62558,
59910)

To cope with the wider deployment of secured email servers, more choices are now offered to
support secure connections when configuring an E-mail account to:

o No secure connection,

®  Explicit TLS (STARTTLS),

® Implicit TLS (SSL/TLS).
Please note that since version 10.0, changes occurred leading to support for only Implicit TLS in

some versions, and only Explicit TLS in some other versions. You should verify your configuration
in case of migration.

General

Also in: 11.2.06023,
11.2.06023, 11.1.06079,
11.1.06078

SNMP Agent option not active (SPR # 62490)

The license option allowing the use of the SNMP Agent was not correctly detected.

General > Licensing
Also in: 11.2.06022

Automatic logoff warning message displayed too briefly (SPR # 65210,
65129)

The warning message before automatic logoff was not properly handled. The configured
duration was ignored and the warning was displayed only one second before disappearing.

General > User
management
Also in: 11.2.06073

Priority wrongly given to Active Directory users (SPR # 64637)

Since version 11.2.06063, when a built-in user had the same login name as a user from the
Active Directory, the priority was given to the Active Directory user instead of the built-in user.

General > User
management
Also in: 11.2.06071

Station-dependent profile no longer working with Active Directory users
(SPR # 64377)

When an Active Directory user is applied different profiles according to the PcVue station it
connects to, the correct profile is now applied. Until this fix, the first profile was always
enforced.

General > User
management
Also in: 11.2.06071

Windows User group containing a "." (SPR # 63814, 16655)

It was not possible to associate a Windows User Group containing a '.' (dot) character to a user
profile.

General > User
management
Also in: 11.2.06060

Failed to edit DEFUSER details (SPR # 63440)

It was not possible to edit the DEFUSER details (First Name, Last Name...). An improper
validation rule required to set a password, which was wrong for the default user.

General > User
management

Also in: 11.2.06058,
11.2.06058

Unable to open Variable properties dialog box (SPR # 63069)

Since version 11.2.05001, users having the DEFPROFILE were not able to open the variable
properties dialog box when accessed from an animation, even if granted developments
privileges.

General > User
management
Also in: 11.2.06055

Station dependent User profiles not applied with Active Directory (SPR #
64637, 64377, 62981)

The association of specific User profiles for different stations was not correctly applied when
using Active Directory groups. The first found profile was applied on every stations.

General > User
management
Also in: 11.2.06042

Unexpected automatic user logoff (SPR # 61964, 60807, 60795)

User activity is now tracked at the Windows session level to avoid automatic logoff when a user
is using the configuration tools. Until this fix, only the activity in mimics was tracked, leading to
situations where the user could be automatically logged out of the Application Explorer (or
Application Architect).

General > User
management

Also in: 11.2.06033,
11.1.06092, 11.0.06092

Password change requested at startup (SPR # 62708)

Since version 11.2.06023, a dialog box requesting to change user's password was displayed at
project startup. It was occurring when user was automatically logged in with SCADA Basic
instruction and when strong password option was activated. The issue occurred in particular
when launching the QuickStart sample project.

General > User
management
Also in: 11.2.06026
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Excessive CPU consumption (SPR # 62596)

When the user.dat file was encrypted, it was reloaded every second even if no change occurred.

General > User
management

Also in: 11.2.06023,
11.2.06023, 11.1.06078,
11.0.06089

Defaults items for Databases, Tables and Trend groups (SPR # 65306)

Fix of the handling of the Set as default property for Databases, Tables and Trend groups to
ensure there is a default item in all situations.

Historical data

ODBC - Could not store deferred attributes (SPR # 65190)

Deferred attributes can now be archived in ODBC archive units.

Historical data
Also in: 11.2.06080,
11.2.06080, 11.2.06080

Deadband ignored if value out of range (SPR # 65308)

Deadband configured on a register variable was not taken into account when the variable was
out of range (NS L> or NS L<). It was leading to unnecessary archive records.

Historical data
Also in: 11.2.06076,
11.1.06117

Fatal error when reading recent proprietary archives (SPR # 65103,
64663)

Under some circumstances, a fatal error could occur when requesting log or trend data
recorded recently in a proprietary archive unit.

Historical data
Also in: 11.2.06073

Free Archive Unit created on consumer stations (SPR # 64411)

When exiting a project, Free Archive Unit files were generated on consumer stations instead of
only on producer stations.

Historical data
Also in: 11.2.06071

File histo.sav not flushed upon exit (SPR # 64037)

Under some circumstances, the file histo.sav may not be correctly flushed on project exit. The
issue occurred only when the Archive folder had been modified and if trends were configured
on the archive unit.

Historical data
Also in: 11.2.06068

Unable to read comma character (SPR # 64291, 64136, 61173)

The comma character was not correctly interpreted in the Log Viewer when used in some
events/fields such as "failed log attempt" or variable description.

Historical data
Also in: 11.2.06067

Checkstructure parameter not taken into account (SPR # 64258)

The Checkstructure setting that can only be directly edited in the \C\HDSConf.dat file, was not
correctly taken into account.

It can be set to 0 to disable schema verification when loading the HDS, and thus enabling a given
version of the product to archive data in a database created with a more recent version. Note
that it may lead to incompatibility format issues and data loss.

Historical data
Also in: 11.2.06064

Unable to read old archive files (SPR # 63967)

Since version 11.0, it was no longer possible to read old proprietary archives files (format with
extension .idx) if the option "without attribute" was activated on the archive unit. This option is
no longer editable in the configuration dialog boxes and is deactivated by default in new
projects since version 11.0.

Historical data

Also in: 11.2.06063,
11.2.06063, 11.1.06112,
11.0.06097

Handling of the trend invalid point on communication loss (SPR # 63742)
Prior to this fix, on a communication failure, an invalid point was always recorded in the archives
for each trend upon communication loss. When communication was restored, an attempt to
record the retrieved value was done. In the particular case of HDS, it was leading to primary key
violation when the VTQ did not changed during the communication loss.

From now on, the invalid point is recorded only when the communication is restored, and if the
variable's VTQ is different.

Historical data
Also in: 11.2.06060,
11.1.06109

HDS stopped recording (SPR # 16941)

Under some circumstances, the HDS was no longer recording data when the temporary file .hds
was over 2 Go. Now, when the file reaches such a size, an error message is displayed in the
event viewer and the file is no longer processed, meaning it has to be manually imported in the
database.

Historical data
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Fatal error of the HDS in case of overflow (SPR # 65968)

Under some circumstances, a fatal error of the HDS could occur when it was both in an overflow
situation due to Insert requests and heavily solicited with Select requests by PcVue. The fix
consists in a better control over the switchover to another PcVue archive producer station, i.e.
set the availability rate to 0 when the HDS does not respond to PcVue requests in a timely
fashion.

Historical data
Also in: 11.2.06081,
11.2.06081

Filtering with multiple Populations (SPR # 63137)

Requesting historical data from a Database archive unit with a filter while more than one
populations were applied was not returning the correct set of records.

Historical data
Also in: 11.2.06055,
11.1.06101

Failed to start project (SPR # 63210)

Under some circumstances, it was no longer possible to start a project, due to an infinite loop in
the loading of the archive manager. This issue was a regression and only occurred with existing
proprietary archive unit when a trended variable did not have any record stored in the archives.

Historical data
Also in: 11.2.06054

Use of negative filter in Log Viewer (SPR # 62497)

When archiving logs in a HDS archive unit, it was not possible to apply a filter for retrieving
empty fields or negative filter such as #A3="" or #A1!=Domain1.

Historical data
Also in: 11.2.06039,
11.1.06097

Field ValueTriggeringThreshold in HDS databases (SPR # 62614)

An additional field named ValueTriggeringThreshold is now available when selecting the
property Threshold in Trend and Log tables.

Historical data
Also in: 11.2.06038,
11.1.06096

HDS Databases update (SPR # 62324)

As documented, from now on, when upgrading a project to version 11.2, if a HDS database is
larger than 10 Gb, the HDS loading is aborted and an error message is traced.

As part of the migration process, databases' schema has to be updated using the T-SQL scripts
provided in the file bin\UpgradeDatabase.sql before starting PcVue and the HDS.

It was a known issue since version 11.2.05001 - The T-SQL scripts were not up to date for
upgrading to 11.2.

[Edit 11.2.060030] - The scripts in earlier updates were still incorrect.

Historical data

Also in: 11.2.06030,
11.2.06030, 11.2.06010,
11.2.06001

Could not filter logs by both domain and nature (SPR # 62702, 62497)

Since versions 11.1.06029 and 11.2.05001, when using HDS archive units, it was no longer
possible to apply a filter with a combination of both a domain and a nature.

Historical data
Also in: 11.2.06026,
11.1.06087

Incorrect register value recorded with threshold events (SPR # 62614)

The register value recorded alongside a threshold event (bit or alarm) was incorrect. The trigger
value was registered instead of the current value of the register when the threshold was
triggered.

The issue only affected HDS archive units.

Historical data
Also in: 11.2.06026,
11.1.06082

Trends remained invalid after project startup (SPR # 62165)

When using HDS archives units, invalid points were recorded at project exit (quality=64). Under
some circumstances, no valid point were recorded at project startup, in particular with
timestamped data or when archive and data acquisition servers are on separate machines, due
to a primary key violation (identical VTQ). Thus, trends were wrongly displayed as invalid in the
Trend Viewer. This behavior was also occurring in case of networking failure (quality = 24).
From now on, the invalid points are recorded at project startup, only if the data has changed in
the meantime.

Historical data

Also in: 11.2.06023,
11.2.06023, 11.1.06072,
11.1.06072

Filtering extended attributes with space characters did not work (SPR #
61117, 61112)

It was not possible to apply a filter to retrieve historical data (for example with SCADA Basic
instructions SVLOG or LOGVIEWER) when conditions on extended attributes contained space
characters.

Now it works correctly if enclosed in quotation marks.

e.g.: =(#A5=="xy z"))

Historical data
Also in: 11.2.05000,
11.1.06029

Error messages no longer prompted in preview mode (SPR # 65133)

Error messages such as missing mimic template are no longer prompted when a mimic is loaded
to be displayed in preview mode.

Such message prompts could occur when loading mimics in the following contexts: File.Open
dialog box, mimic selector, Application Explorer...

HMI
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GDI object leak (SPR # 65069)

Fix of a GDI object leak. Up to 4 GDI objects were leaked when closing a mimic.

HMI
Also in: 11.2.06073

Toolbars and menus could not be clicked (SPR # 63884) HMI

Under some circumstances, toolbars and menus could not be clicked when positioned over a

Map Control.

Template mimic size not retrieved HMI

The property Keep the mimic template size was not working when the mimic template size was

higher than the initial mimic size.

Loss of the color palette (SPR # 64107) HMI

Under some circumstances, the color palette was not correctly initialized, leading to the Also in: 11.2.06064

replacement of indexed colors by fixed colors. ’
P / 11.1.06113

Editing symbol with the Graphic Explorer (SPR # 63857) HMI

Under some circumstances, a fatal error could occur when editing nested symbols using the
Graphic Explorer.

Also in: 11.2.06064

Fatal error at startup (SPR # 63747)

Under some circumstances, a fatal error could occur when at startup a mimic was opened via
SCADA Basic. The issue only occurred if the mimic had both the Navigator activated and SCADA
Basic function executed on the Before open callback. The fatal error appeared only after
switching the mimic to the design mode.

HMI
Also in: 11.2.06064

Removed unnecessary Save prompt (SPR # 63823)

When a mimic containing ActiveX controls was switch to design mode, and then back to runtime
mode, a prompt asking for saving the mimic was displayed even if no change was to be saved.
From now on, built-in ActiveX and controls no longer cause this prompt. The message will still
be raised if the mimic contains a third-party ActiveX for which there is no guarantee that
configuration change is correctly transmitted to the ActiveX container.

HMI
Also in: 11.2.06063

Fatal error when loading a mimic (SPR # 63956) HMI
Under some circumstances, a fatal error occurred when loading a mimic containing an ActiveX. Also in: 11.2.06063
The issue occurred when the ActiveX was not installed properly on the computer and configured ’
with the property Save properties as text activated. 11.2.06063
Check box list and Option button list not selectable (SPR # 63057) HMI
Under some circumstances, the selectable items (check box or radio button) could disappear Also in: 11.2.06062
when changing the font of the control. '
ene 11.2.06062
Function keys not effective (SPR # 61582) HMI
Under some circumstances, function keys (F2...) were not effective. The issue could occur when  Also in: 11.2.06034
the graphic item having the focus was a component such as a Trend Viewer or a Combo box. '
11.1.06092
Virtual keypad not opened in the correct region (SPR # 62585) HMI
The Virtual keypad was not always opened in the correct region, in particular with a 4-screen Also in: 11.2.06031
configuration. !
¢ 11.1.06089
Mouse wheel behavior reversed (SPR # 62647) HMI
The mouse wheel behavior when zooming was reversed compared to usual implementations. Also in: 11.2.06025,
11.1.06081
Inadequate suggested name for "Save as" actions (SPR # 61890) HMI

Suggested names for mimics and symbols when using "Save as" were inadequate and could lead
to overwriting existing objects.

Also in: 11.2.06022,
11.2.06022, 11.1.06074,
11.1.06072

Warning icon not always displayed (SPR # 62421)

Under some circumstances, the warning icon was not displayed on objects having missing or
non-existing variables in animations.

HMI
Also in: 11.2.06022,
11.1.06074
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Alarms not displayed

Under some circumstances, new alarms were not displayed in the Alarm viewer after an alarm
was removed from the list. In particular, the issue occurred when the list of potential alarms to
display was greater than the buffer size.

HMI > Alarm viewer
Also in: 11.2.06074

Maintenance filter button in toolbar not saved
The "Maintenance filter" toolbar button was lost when saving mimics in ASCIl mode.

HMI > Alarm viewer
Also in: 11.2.06038,
11.1.06095

Missing alarms after zooming or scrolling (SPR # 62764)

Under some circumstances, when scrolling or zooming with the mouse wheel in an Alarm
Viewer, some lines were disappearing.

HMI > Alarm viewer
Also in: 11.2.06031,
11.1.06088

Could not select lines (SPR # 62506)

Since versions 11.1.06048 and 11.2.05000, it was no longer possible to select a line in the Alarm
Viewer when the viewer was configured to display context mimics and context mimic was left
undefined.

HMI > Alarm viewer
Also in: 11.2.06022,
11.1.06075

Unable to remove animation Visibility on Variable presence and
Visibility on Text (SPR # 65505)

It was not possible to remove animations of type Visibility on Variable Presence and Visibility on
Text from graphic objects.

HMI > Animations
Also in: 11.2.06078

Incorrect value sent with Send Register animation (SPR # 63471)
Incorrect values were sent with the Send Register animation. The issue occurred when the
animation was configured with both "direct send" and "variable copy", and only if the source
variable was in an invalid state.

HMI > Animations

Max size of comments for tooltips (SPR # 63245)

The maximum size of the comment in the animation is now 255 characters (was 80).

When several animations are configured on the same object, their concatenated total length is
now limited to 2500 characters (was 80).

HMI > Animations
Also in: 11.2.06061,
11.2.06061

'Send bit' animation on 3D object not working well (SPR # 63053)

Animations Send bit created for graphic objects of a 3D model did not work. Only the last one in
the model's hierarchy was working properly.

HMI > Animations
Also in: 11.2.06054

Mouse wheel in combo box leads to fatal error (SPR # 60767)

Under some circumstances, a fatal error could occur when using the mouse wheel to scroll a
combo box control for several seconds.

HMI > Animations
Also in: 11.2.06038,
11.2.06036, 11.1.06094,
11.1.06094

Fatal error when selecting new item in a Tree view Control (SPR #
62832)

Under some circumstances, a fatal error was occurring when rapidly changing the index value in
the Tree view Control (e.g. by clicking on different items).

HMI > Animations
Also in: 11.2.06036,
11.1.06094

Instruction WINDOW, mode OPEN - partly working with animation Run
macro (SPR # 61939)

Animations Run macro executing the instruction WINDOW mode OPEN in a mimic saved in ASCII
format failed if the mimic name passed as argument included a simple quotes.

HMI > Animations
Also in: 11.2.06025,
11.2.06023, 11.2.05000,
11.1.06081

Incorrect error message on interlock condition (SPR # 62372)

The error message prompted when the interlock condition was defined by an expression was
incorrect.

HMI > Animations
Also in: 11.2.06022,
11.1.06072

Axes properties not saved (SPR # 64045)

When using the ASCII format, the axes properties of Chart control were not correctly saved.

HMI > Chart control
Also in: 11.2.06064,
11.1.06113
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OnSelect event not triggered (SPR # 64932)

The OnSelect event of listbox controls was not triggered after loading items with the SCADA
Basic instruction LISTBOX, mode LOAD.

HMI > Form controls

Relative path not properly handled (SPR # 64132)

Relative paths other than \TP were not correctly handled in Form controls (Combo-box, List-box,
Check-box list, Option-button list and Tree-view). Only absolute paths were recognized. As of
now, relative paths to any of the project sub-folder can be handled correctly in a relative way,
and folders outside the project are handled as absolute.

HMI > Form controls
Also in: 11.2.06070

Unselect all items in listbox (SPR # 64491, 64490)

It was not possible to unselect all the items in a listbox Form control.

HMI > Form controls

Default font not restored (SPR # 63978)

Unchecking the custom font in Form Controls was not restoring the default font.

HMI > Form controls

Fatal error with incorrect file (SPR # 64026, 16215)

A fatal error could occur when a Form Control was configured to load a file with an incorrect
format.

HMI > Form controls

Animations misconfigured after reordering tree view nodes
When reordering nodes in a Tree view control, the animations were wrongly reassigned.

HMI > Form controls

File full path not displayed

In the content tab of the Form controls, only the file name was displayed (instead of its full path)
when not located in the TP directory of the project.

HMI > Form controls

Selection not triggered for OptionList and CheckList (SPR # 63318)
The linked variables (User Data, Index and State) were not updated when selecting an item
without changing its state. The variables were only updated when the state (checked/not
checked) of an item was changed.

HMI > Form controls

Tree View - Selection notification when switching to runtime mode (SPR
# 63313)

A selection notification was triggered when switching from edit to runtime mode, even if the
selection did not change in the meantime.

HMI > Form controls

Moving items in a tree view control (SPR # 63497, 59554)

It was not possible to reorganize root items in a tree view control. In addition, animations were
lost when moving items.

HMI > Form controls
Also in: 11.2.06058

User data not updated after loading a file (SPR # 61351)

The UserData was not updated when the content of a List box was reloaded from a file defined
by a variable.

HMI > Form controls
Also in: 11.2.06058,
11.2.06058

Tree View selection not changed upon UserData update (SPR # 63230)

Updating the variable linked to UserData of a tree view was not updating the selected item of
the tree view.

HMI > Form controls

Data and Index not initialized in form controls (SPR # 63211)

In the form controls - Check box list, List box, Option button list and Tree view - the Index and
User Data values were not set according to the default selection at initialization stage.

HMI > Form controls
Also in: 11.2.06055,
11.2.06054

Fatal error when changing Z-order (SPR # 62393)

Under some circumstances, a fatal error could occur when changing the Z-order of graphic items
in @ mimic having a symbol with VBA code inside.

HMI > Graphics
Also in: 11.2.06037,
11.1.06094
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Rotation angle (SPR # 62482)

The rotation angle is now saved in the mimics.

Previously, when applying a rotation, the graphic items were rotated directly, and the rotation
angle was reset to 0. After successive rotations, the graphic items could be distorted due to
rounding calculation.

HMI > Graphics

Also in: 11.2.06024,
11.2.06023, 11.2.06023,
11.2.06023, 11.2.06023,
11.2.06023, 11.1.06080,
11.1.06079, 11.1.06079,
11.1.06079, 11.1.06079,
11.1.06078

Invisible border for Tree view (SPR # 62527)

It was not possible to make borders invisible for the Tree View control.

HMI > Graphics
Also in: 11.2.06022,
11.1.06076

Value formatting in historical mode (SPR # 63356, 63207)

It is now possible to configure the formatting of register values when using the Historical mode.
In particular, the number of digits and heading/trailing zeros.

HMI > Grid control
Also in: 11.2.06056,
11.2.06056, 11.2.06056,
11.2.06056, 11.2.06056,
11.2.06056, 11.2.06056

Incorrect export in demo mode

Exporting data from the Grid control while in demo mode was generating a file with only one
correct line out of two.

HMI > Grid control
Also in: 11.2.06035,
11.1.06094

Manual configuration of thresholds

Unchecking the automatic mode was not effective, preventing from entering specific values for
thresholds. Even if the automatic mode was unchecked, the fields for entering threshold values
remained greyed.

HMI > Grid control
Also in: 11.2.06022,
11.2.06010, 11.1.06073

Thresholds in branched mimics

When using the Grid control in historical mode in a branched mimic, thresholds were not
correctly retrieved, causing an incorrect coloring of the cells.

HMI > Grid control
Also in: 11.2.06022,
11.2.06010, 11.1.06072

Fatal error when no trend is configured (SPR # 62564)

A fatal error was occurring when opening the Data Export Wizard from the Grid Control
configured in Historical mode with no trend configured.

HMI > Grid control
Also in: 11.2.06022,
11.1.06077

Fatal error with mouse wheel (SPR # 64914)

Under some circumstances, a fatal error could occur when scrolling quickly using the mouse
wheel in a Log Viewer.

HMI > Log viewer
Also in: 11.2.06072,
11.1.06118

Fatal error with Free log lists (SPR # 64108)

A fatal error was occurring when a Log viewer was configured with a log list defined in a Free
archive unit. As Free archive units are write only, they cannot be used in log viewers. Such a
configuration now returns an empty Log viewer.

HMI > Log viewer
Also in: 11.2.06064

Login/Logoff filter always active (SPR # 63048)

In the Log Viewer filter configuration, the "Login/Logoff" filter option was not correctly saved
and always restored as selected.

HMI > Log viewer
Also in: 11.2.06041,
11.1.06097

Filtering of Login, Logoff and Login failure events in Log Viewer lost
(SPR # 62404)

The Login, Logoff and Login failure events filters were lost when navigating in the list of logged
events. These filters can only be applied by SCADA Basic or VBA.

HMI > Log viewer
Also in: 11.2.06023,
11.2.06023, 11.1.06079,
11.1.06079

Markers not displayed (SPR # 65085)

Markers were hidden after using the instruction MAPDISPLAY mode LOADMARKERS. They were
refreshed after moving, zooming or clicking in the map.

HMI > Map control
Also in: 11.2.06081
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Map markers Editor - Zoom level modified upon marker insertion (SPR #
64011)

In the Map markers editor, when an invisible layer was selected, the zoom level was
automatically set to the layers' max level, every time a marked was inserted.

HMI > Map control

Missing symbol not indicated (SPR # 61510)

As of now, a warning is displayed at design time if a symbol used for a marker is missing.

HMI > Map control

Unable to validate Map positioning animation (SPR # 61930)

It was not possible to select No change in the Zoom level property of the animation Map
positioning.

HMI > Map control

VBA code embedded in symbol not executed (SPR # 61897)

VBA code embedded in a symbol was not correctly loaded and executed when used as a marker.

HMI > Map control

Map markers editor - Automatic zoom on layer double-click (SPR #
64015)

In the Map markers editor, the zoom level was not correctly set when double-clicking on a layer
to adapt the display to show all the markers.

HMI > Map control

Map markers editor - Duplicated layers after copy/paste (SPR # 64014)

An additional layer was inserted after a copy/paste action of a non-default layer.

HMI > Map control

Map markers editor - Inserting a marker in a dynamic layer (SPR #
63954)

In the Map markers editor, toolbar buttons to insert makers were not disabled when a dynamic
layer was selected.

HMI > Map control

Symbols displayed incorrectly (SPR # 64263)

Symbols were not correctly displayed when crossing the Map control border. It was only
occurring with symbols including rectangle with dotted border.

HMI > Map control

Fatal error when resizing a Map control (SPR # 64558)

Under some circumstances, a fatal error could occur when resizing a Map control at design time.

HMI > Map control
Also in: 11.2.06097

Dotted border around symbols (SPR # 64263)

A dotted border was incorrectly displayed around symbols.

HMI > Map control
Also in: 11.2.06081

Markers not displayed after provider change (SPR # 64521)

Under some circumstances, when changing the map provider at runtime (for example with
SCADA Basic instruction), some markers could disappear. The issue occurred when the layer
levels of markers did not include the minimal zoom level of the map. Markers' were properly
refreshed and displayed after moving the map or updating the zoom level.

HMI > Map control
Also in: 11.2.06068

Marker position modified when switching from runtime to design mode
(SPR # 63804)

Under some circumstances, the position of symbol markers in the Map Control was wrongly
modified when switching from runtime to design mode.

HMI > Map control
Also in: 11.2.06062,
11.2.06060

Improper default zoom limits (SPR # 62683)

When creating a new .gpx file (markers) or a new layer, the zoom limits of the default layer are
now applied by default. Until this fix, it was possible to introduce zoom limits discrepancies,
because the zoom range [1..20] was used by default.

HMI > Map control
Also in: 11.2.06060

Incorrect markers position in Remote Desktop sessions (SPR # 63378)

Under some circumstances, when running in a Remote Desktop Session, markers were wrongly
positioned top-left in the map control. The issue only occurred after disconnecting and
reconnecting to a session. Re-opening the associated mimic was repositioning markers
correctly.

HMI > Map control
Also in: 11.2.06058

Map not correctly displayed with local cache

Under some circumstances, local map tiles were not correctly displayed after loading and/or
using the Map position animation. In particular, the issue could occur when the map was loaded
with a zoom level that was not selected at the time the map had been locally cached.

HMI > Map control
Also in: 11.2.06056,
11.1.06103

Reference: PcVue 12 Release Notes
Copyright ©2024 - ARC Informatique. All rights reserved — LI N0 H I3

Last update: November 3, 2025
Page 74/119



4
PcVue >

Markers position and visibility not refreshed properly (SPR # 63203,
62727)

Visibility of markers of type Symbol was not always correctly maintained with regards to layer
visibility, position changes and zoom modification.
Performance of marker rendering is also improved.

HMI > Map control
Also in: 11.2.06056,
11.2.06056, 11.2.06056,
11.2.06056

OpenStreetMap cached map

Following a previous fix to disable OpenStreetMap maps due to license restrictions, a fatal error
was occurring when using such a map stored in the local cache.

HMI > Map control
Also in: 11.2.06034

Access to OpenStreetMap tiles blocked

OpenStreetMap has blocked online access to their tile servers from 3rd party applications. The
OpenStreetMap provider was therefore no longer usable and has been removed from the list of
available map providers.

HMI > Map control
Also in: 11.2.06027

Fatal error after a marker disappeared (SPR # 62724)

Under some circumstances, a fatal error could occur after a marker disappeared from the visible
area (due to zooming or map scrolling), in case it had an opened popup linked to it.

HMI > Map control
Also in: 11.2.06027

Impossible to save GPX file

The Save button was always disabled when editing an existing GPX file with the Map Marker
Editor.

HMI > Map control
Also in: 11.2.06027

Several fixes & enhancements of the Marker editor (SPR # 62681)
The list of fixes & enhancements includes:
®  Under some circumstances, the preview was not working for Symbols markers,

®  Upon selection of a marker on the map, the marker properties were not displayed if
the marker was not in an expanded part of the tree view in the right-side panel,

®  Under some circumstances, the Save button could stay greyed after changing a user
data or a property.

HMI > Map control
Also in: 11.2.06026

Truncated value in semi-log mode (SPR # 65347)

Values displayed at the cursor in semi-log mode could be truncated.

HMI > Trend viewer
Also in: 11.2.06076

Scientific notation in scales (SPR # 64696)

Scales were not using the scientific notation with large values.

HMI > Trend viewer
Also in: 11.2.06072

Incorrect trend displayed after modification (SPR # 64766)

When changing the displayed trend at runtime, it could happen that the curve and the cursor
values were not updated. The issue occurred when the newly selected trend was not associated
to an archive unit.

HMI > Trend viewer
Also in: 11.2.06071,
11.2.06071, 11.1.06115,
11.1.06115

Minimal value displayed

From now on, the minimal value the Trend Viewer can display is 10e-30 (was 10e-15). Values
lower than this limit are rounded to 0.

HMI > Trend viewer
Also in: 11.2.06071,
11.1.06115

Value lower than e10-6 not displayed

Value lower than e10-6 were displayed as 0.

HMI > Trend viewer

Truncated value in scale (SPR # 64657)

Under some circumstances, value displayed in scale were truncated when using scientific
notation.

HMI > Trend viewer
Also in: 11.2.06070,
11.1.06114

Label field not updated in the legend (SPR # 64577)

When changing the displayed variable in the Trend Viewer, the associated Label field in the
legend was not updated when it was configured to use the variable's description (Label left
empty at design-time).

HMI > Trend viewer
Also in: 11.2.06068,
11.2.06068

Value with e-10 not correctly displayed

When using the scientific notation, the particular case of e-10 was not correctly displayed. The
trailing zero was removed and the value wrongly displayed as e-1.

HMI > Trend viewer
Also in: 11.2.06064,
11.1.06113
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Small values not correctly displayed in the legend (SPR # 63856, 63670)  HMI > Trend viewer
Small values, lower than 0.001 where displayed as O in the legend. They are now displayed using  Alsgo in: 11.2.06061,

sclentific notation. 11.2.06059, 11.2.06059,
11.1.06110, 11.1.06107,

11.1.06106
Curve color not updated (SPR # 62998) HMI > Trend viewer
Curve were not immediately updated when modifying curve color with the SCADA Basic Also in: 11.2.06038,
instruction TREND, mode SETCOLOR.

11.1.06095
Invalid point displayed with Points curve type HMI > Trend viewer
When curve type was set to "points”, both valid and invalid values were displayed and could be  Also in: 11.2.06031,
wrongly interpreted. From now on, only valid points are displayed.

11.1.06091
Language for variable descriptions in the legend (SPR # 62311) HMI > Trend viewer
Variable descriptions were not dynamically changed when switching the project language. Also in: 11.2.06001,

11.1.06066
Trends not well displayed (SPR # 62319) HMI > Trend viewer

Trends were not correctly displayed when scales were larger than the display area of the trends.  A|sg in: 11.2.06001,
11.1.06066, 11.0.06085

Online printing not working (SPR # 60929, 27775) Miscellaneous

Online printing was not working when no Proprietary archive unit was configured.

Fatal error when editing expression (SPR # 63694) Miscellaneous
Under some circumstances, a fatal error could occur after several modifications of an existing

expression, when some of the modifications were incorrect.

All kind of expressions were affected: Expression on variable, template expression and

expression in animations.

System variables for printers remained invalid (SPR # 62839) Miscellaneous
Since version 10.0, system variables for printers were no longer initialized at startup and Also in: 11.2.06031
remained invalid (NS).

Incorrect error message in three-level architectures (SPR # 65191) Networking

In a three-level architecture, some incorrect messages were displayed at the gateway level Also in: 11.2.06076

regarding the archiving. Despite the error messages, logs were correctly routed.

Fatal error on network message processing (SPR # 65030) Networking

Under some circumstances, a fatal error could occur when a network message containing data Also in: 11.2.06072,
changes larger than 32 Kb was being processed. 11.1.06116

Incorrect project version in RDS session (SPR # 63655, 62583) Networking

Under some circumstances, projects started in a Remote Desktop Session were loaded with an Also in: 11.2.06060,
incorrect version. The issue could occur due to incorrect user permissions on the project folder.

From now on, a warning is displayed when the user has improper permissions and project 11.2.06060, 11.2.06060,
startup is aborted. 11.1.06109, 11.0.06094
Unable to modify the activation trigger of an alarm (SPR # 63724) Networking

It was no longer possible to modify the activation trigger of an alarm (positive or negative) from  Alsg in: 11.2.06059
the Application Explorer or by import (Smart Generator, Generic Import, Application Architect) if

the station belonged to a single-active association. It can now be done on the active station of

the association.

Status NS L> and NS L< not correctly distributed to client stations (SPR  Networking
# 63592) Also in: 11.2.06059,

Under some circumstances, the status NS L>and NS L< were not correctly transmitted to client 11.1.06106
stations and were simply interpreted as NS. As a consequence, the associated value was not
displayed on client stations.
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Variables indicated as NS in mimics

Under some circumstances, some variable values could be displayed as NS in animations and as
valid values in the Application Explorer.

The issue could only occur in a specific scenario after a time-out on a variable subscription and
the fact that flow regulation was active when the first subsequent subscription response was
received.

Erroneous messages removed (SPR # 62955)

Under some circumstances, false error messages were displayed when a HDS trend variable was
produced by a station and archived by another station. The issue could be reproduced when a
variable was timestamped at the source level, with the Trend group period set to 0 sec. The
following messages were displayed:

5,W,,5582,,2,Send ask refresh for OPC.BitO1l
variable

5,W,,5586,,2,Station number=4 retry number=1 Time
Out=20s

5,W,,5582,,2,Send ask refresh for OPC.BitO1l
variable

5,W,,5586,,2,Station number=4 retry number=2 Time
Out=20s

These messages had no impact on the system behavior.

Networking
Also in: 9.0SP3,
11.2.06027, 11.1.06088,
11.0.06092,
10.0SP2_Update
Networking

Also in: 11.2.06036,
11.1.06094

Alarm synthesis not updated (SPR # 64619, 64483)

Under some circumstances, alarm syntheses were not updated due to multiple use of the result
variable. It was possible to configure several alarm syntheses having the same result variable. In
such a situation, only the last created or loaded was executed. The error handling is also
improved to better warn user when creating an Alarm Synthesis from the Application Explorer,
Application Architect or Generic Import.

Real time data
Also in: 11.2.06072

Template Expression using a variable several times (SPR # 64525)
Under some circumstance, a fatal error could occur when modifying an Expression template.
The issue occurred only when the calculated expression contained a reference to a given
variable more than once.

Real time data
Also in: 11.2.06067

Unknown variable in expression
Under some circumstances, a fatal error could occur when an unknown variable was used in an
expression.

Real time data
Also in: 11.2.06066

Consecutive writes not all sent

Under some circumstances, when the option Write only if the value is different was activated,
consecutive write instructions done in SCADA Basic were not correctly managed if the initial
value was used in the sequence.

For instance, with an initial value set to 1 and the following sequence:

Variable = 2;
Variable = 1;
Variable = 3;
Variable = 1;

Only values 2 and 3 were sent.

Real time data

NS COM status not correctly refreshed (SPR # 63869)

Under some circumstances, the status of a variable was wrongly set to NS instead of NS COM
after a communication loss. The issue occurred if the variable was previously in status Out of
range (NS L>or NS L<).

Real time data
Also in: 11.2.06061,
11.1.06110

DNP3 and IEC104 system variables remained invalid (SPR # 60107)

System variables linked to IEC104 and DNP3 data acquisition drivers could remain invalid at
startup when the option Activate at start-up was not checked.

Real time data
Also in: 11.2.06038,
11.1.06095

Handling of corrupted persistent data (SPR # 62906, 62757)

Improved handling of the files VariablesSaved.dat and AlarmSaved.dat if they are corrupted.
From now on, backup copies are used in replacement.

Real time data
Also in: 11.2.06034

Fatal error upon variable deletion

Under some circumstances, a fatal error could occur upon variable deletion. The issue occurred
if a variable mapped on an equipment data acquisition driver was deleted after a command was
sent and before the command acknowledgement was processed.

Real time data
Also in: 11.2.06031,
11.1.06091
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Timestamp discrepancy after a communication restart (SPR # 62733)

In case of a single active server association, when restarting the communication on the active
server, the timestamp type and value could differ on the active server compared to client
stations. It was occurring with saved variables when the setting Use the local timestamp upon
device reconnection was enabled. In such condition the timestamp type and value was set to the
local SV timestamp on the active server instead of the last known PLC timestamp, as it is on
client stations.

Real time data
Also in: 11.2.06031,
11.1.06088

Alarm synthesis not loaded

When several synthesis had the same criteria (same extended attributes value for example) and
the only difference was the branch, only the first one was correctly loaded, others were ignored.

Real time data
Also in: 11.2.06024,
11.1.06080

Truncated associated labels (SPR # 58811)

Following the modification of the maximum length of associated labels to 255 characters, such
labels were wrongly truncated:

®  When using the #E substitution in the alarm and log viewers,
®  When used as part of a log list filter on proprietary log lists.

Real time data
Also in: 11.2.06023

Incorrect expression result after a server switchover (SPR # 62566)

Under some circumstances, in a single active server association, expressions could be incorrect
after a switch from passive to active.

Real time data
Also in: 11.2.06023,
11.1.06078

'$' character not recognized in expressions (SPR # 62505)

The '$' character was not recognized as a part of a variable name. Thus expressions using
synthesis such as @System.NoAckOn.ALL.Domain_$ were not considered valid.

Real time data
Also in: 11.2.06022,
11.1.06075

Filtering on numerical values for Text attributes (SPR # 62594)

Since version 11.2.05001, filters applied to Alarm and Log Viewers comprising numerical values
for text attributes were no longer working (if executed in SCADA Basic or in VBA).

Scripting
Also in: 11.2.06023

Instruction WINDOW modes CURRENTNAME and CURRENTBRANCH -

Returned an invalid value (SPR # 65817)

The SCADA Basic instruction WINDOW with the modes CURRENTMIMIC and CURRENTBRANCH
generated an "incompatible type" error when no mimic was opened.

Scripting > SCADA
Basic

Instruction WINDOW mode SELECTTAB - Incorrect return value on error

The mode SELECTTAB of the instruction WINDOW returned 1 instead of 0 when the index of the
tab was out of range.

Scripting > SCADA
Basic

Instruction WINDOW mode ZOOM - Mimic back in the foreground

A mimic was brought to the foreground after setting its zoom level from a value lower to 100 to
a value greater than 100 with the instruction WINDOW with the mode ZOOM.

Scripting > SCADA
Basic

Fatal error with instruction VARIABLE mode IMPORTBUFFER

Under some circumstances, a fatal error could occur when using the instruction VARIABLE mode
IMPORTBUFFER.

Scripting > SCADA
Basic
Also in: 11.2.06079

Instructions LOGDISPLAY & ALARMDISPLAY modes GETLINES &

GETSELECTEDLINES - Did not work (SPR # 65392)

The modes GETLINES and GETSELECTEDLINES of instructions LOGDISPLAY and ALARMDISPLAY
did not work properly. The parameter LineStart was ignored and always considered equal to 1.
As a consequence, the first line was always returned.

Scripting > SCADA
Basic
Also in: 11.2.06076

Incorrect Intellisense for instruction BACNET mode LOG_RETRIEVAL
The Intellisense for the instruction BACNET mode LOG_RETRIEVAL of was incorrect.

Scripting > SCADA
Basic

BRANCHE is a reserved word (SPR # 65039)

It is no longer possible to use BRANCHE as a function or a variable name.

Scripting > SCADA
Basic

Instruction MAPCONTROL - Incorrect return type (SPR # 65057)

The return type for the SCADA Basic instruction MAPCONTROL was inconsistent. In case of
error, some return types were not the one expected. For instance, the success return type of
the mode GETZOOM is double, and in case of error, the instruction was returning an integer.

Scripting > SCADA
Basic
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Intellisense of instruction TRACE (SPR # 64804)
The instruction TRACE was not correctly highlighted in the SCADA Basic Editor.

Scripting > SCADA
Basic

Line numbering not correctly refreshed (SPR # 64805, 63774, 63773)

Under some circumstances, the line numbering in the SCADA Basic Editor was not correctly
refreshed, in particular once activated or with numbers only comprised between 1 and 11.

Scripting > SCADA
Basic

Upgrade Instruction BACNET mode LOG_RETRIEVAL - Incorrect
timestamp type (SPR # 63604)

Timestamps used with the instruction BACNET mode LOG_RETRIEVAL were UTC instead of local.

Scripting > SCADA
Basic

Instructions ALARMDISPLAY and LOGDISPLAY mode ISLINEVISIBLE -

Incorrect return value (SPR # 64693)

The mode ISLINEVISIBLE of instructions ALARMDISPLAY and LOGDISPLAY returned -1 instead of
0 when the line to retrieve was not visible. The issue occurred when the viewer was configured
with a buffer size larger than the number of lines it could display.

Scripting > SCADA
Basic

Instruction CHART mode LINE_CLEAR - Always returned 0 (SPR #

64723)

The mode LINE_CLEAR of the instruction CHART always returned 0 even when executed
successfully.

Scripting > SCADA
Basic

Instruction CHART mode RANGE_REMOVEPOINT - Did not work (SPR #

64721)

The mode RANGE_REMOVEPOINT of the instruction CHART was adding points instead of
deleting them.

Scripting > SCADA
Basic

Instruction CHART mode SETENDTIMEPERIOD - Did not work (SPR #

64726)

The mode SETENDTIMEPERIOD of the instruction CHART was not recognized as valid nor
executed.

Scripting > SCADA
Basic

Instruction TOC - Support for type LONGLONG (SPR # 64639)

The TOC instruction returned an empty string when the input argument was of type LONGLONG.

Scripting > SCADA
Basic

Instruction EVENT mode DEL - Did not work (SPR # 63999)
The SCADA Basic instruction EVENT mode DEL did not work properly.

Scripting > SCADA
Basic
Also in: 11.2.06068

LOGDISPLAY filtering modes not waiting EXECUTE (SPR # 64548)

Under some circumstances, the SCADA Basic instructions to modify the filter applied to a Log
Viewer could be executed immediately instead of waiting for the EXECUTE command. This issue
was occurring when the Log Viewer was configured with the auto-refresh mode.

Scripting > SCADA
Basic

Also in: 11.2.06068,
11.1.06114

Intellisense for instruction OPC (SPR # 64373)

The Intellisense for the instruction OPC modes SETTRACE, RESETTTRACE, PUTMASKTRACE and
SAVEMASKTRACE was incorrect.

Scripting > SCADA
Basic

Instruction WINDOW mode GETSUBWINDOW - Did not work with #U

and #l (SPR # 64005, 63017)

Incorrect results were returned when using the instructions WINDOW mode GETSUBWINDOW
with submodes #U and #I.

Scripting > SCADA
Basic

Instruction HISTORY - Failed to import (SPR # 64158, 64157)

Since version 11.2, trend values were not properly imported when using the instruction
HISTORY with the mode IMPORTTREND and the VarFlag parameter set to 1.

Scripting > SCADA
Basic
Also in: 11.2.06064

Instruction SELECTOR - Returned negative color values (SPR # 63744)

The modes GETCELLBACKCOLOR and GETCELLTEXTCOLOR of the instruction SELECTOR were
returning negative values for some colors (greater than the hex value Ox7FFF).

Scripting > SCADA
Basic
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Instruction STATION_FILTER mode APPLY - Incorrect population name

(SPR # 64024)

No error was returned when using the instruction STATION_FILTER mode APPLY with an
unknown population.

Scripting > SCADA
Basic

Error management related to Form Controls (SPR # 63727, 63411, 63381,
63380, 63372, 63369, 63368, 63367)

Several SCADA Basic instructions and modes related to Form Controls were not handling errors
correctly:

CHECKLIST, modes LOAD, INSERT and SETSTATE,
COMBOBOX, modes LOAD, INSERT and SETSELECTED,
LISTBOX, modes LOAD and INSERT,

OPTIONLIST, modes LOAD, INSERT and SETSTATE,

TREEVIEW, modes LOAD, INSERT, SETSELECTED, EXPANDNODE, COLLAPSENODE and
REMOVENODE.

Scripting > SCADA
Basic

Instruction BUFTOEXCEL mode MERGE - Did not work (SPR # 63520)

The mode MERGE of the instruction BUFTOEXCEL did not work correctly and generated a
corrupted file.

Scripting > SCADA
Basic

Instruction KEY - Various fixes & enhancements (SPR # 63962, 63722,
63690, 63684, 63683, 63682, 63428, 63426)

It includes:

Intellisense for modes DELSTD and DELCLK were inverted,

Intellisense for modes ADDCLK and ADDSTD were incorrect,

Success return value of all modes was 0 instead of 1,

Incorrect return values were not all handled properly,

New argument DelAllMode for modes DEL and DELALL,

Fixed a compatibility issue with project version control.

Scripting > SCADA
Basic

Variable substitution not working (SPR # 63793)

Under some circumstances, variables substitutions were not working in SCADA Basic programs,
in particular with multiple substitutions in the same function.

Scripting > SCADA
Basic

Also in: 11.2.06062,
11.2.06062

Instruction TREND mode SETPERIOD - New argument (SPR # 63582)

A new argument named ForceHistoricalRequest has been added to the SCADA Basic instruction
TREND, mode SETPERIOD. When set to 1, a request to the archives is executed to refresh the
buffer for the newly set time-period, otherwise, the buffer is not modified. .

TREND ("SETPERIOD", Window, Branch, Identity,
Duration[, ForceHistoricalRequest])

Executing this instruction without setting this argument could lead to partially rendered curves
because the buffer may not contain data for the new period.

Scripting > SCADA
Basic
Also in: 11.2.06060,

11.2.06060, 11.2.06059,
11.1.06108, 11.1.06108,

11.1.06106

Instruction RECIPE mode NETWORKBROADCAST (SPR # 63124)

When using the instruction RECIPE mode NETWORKBROADCAST, the status variable allowing
controlling the correct execution was never refreshed. It was always in status NS.

Scripting > SCADA
Basic
Also in: 11.2.06054

Intellisense for instruction M104

The Intellisense for the instruction M104 mode STPV_COMMAND was incorrect. The online help
was correct.

Scripting > SCADA
Basic

Also in: 11.2.06046,
11.2.06046

Instruction CIMWAY mode CFG / EQT_ADDRESS - no longer working

with Modbus devices (SPR # 62913)

The instruction CIMWAY mode CFG sub-mode EQT_ADDRESS was no longer working with XBUS-
IP-MASTER driver. This regression was introduced in the following versions:

® 11.2.06026
® 11.1.06086
® 11.0.06092

Scripting > SCADA
Basic
Also in: 11.2.06046,

11.2.06046, 11.2.06035,
11.1.06093, 11.0.06093
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Instructions HEX and CONVERT - Support for 64-bit values (SPR #

62671, 17452)

Instructions HEX and CONVERT (modes BINTOA, OCTOTOA, HEXTOA and BCDTOA) were not
correctly processing 64-bit values (>= 2147483648).

Scripting > SCADA
Basic

Also in: 11.2.06043,
11.2.06034, 11.1.06097,
11.1.06092, 11.1.06092,
11.0.06093, 11.0.06093,
11.0.06093

Instruction TREND mode THRESHOLD_GETMODE - Wrong return code
(SPR # 62879)

When a curve was configured in threshold auto mode but without associated threshold to the
variable, then the function was returning -1 instead of 0.

Scripting > SCADA
Basic

Also in: 11.2.06036,
11.1.06094

SCADA Basic Editor - Line numbers moving (SPR # 62697, 61932, 60539,
59463)

Under some circumstances, the lines numbers were moving. The issue occurred when the file
was starting with several carriage returns.

Scripting > SCADA
Basic
Also in: 11.2.06035

Instruction M61850 modes SBOW_SELECT and SBO_SELECT - Incorrect

return type (SPR # 62903)

The type of the Value argument for the instruction M61850 modes SBOW_SELECT and
SBO_SELECT was incorrect. It is now of type Integer for consistency with the equivalent
instructions for IEC 104 and DNP (was String).

For compatibility with existing projects, support for the Value argument of type String remains.

Scripting > SCADA
Basic
Also in: 11.2.06034

Instructions FOPEN and FCLOSE - Could not open/close files (SPR #

62914)
Since version 11.2.05000, the instructions FOPEN and FCLOSE were no longer working properly.

Scripting > SCADA
Basic
Also in: 11.2.06034

Instruction ASCIIFIELD was limited to 256 fields (SPR # 62670)

The SCADA Basic instruction ASCIIFIELD was limited to 256 fields and could cause a heap
corruption if handling a larger buffer. From now on, the instruction is no longer limited in
number of fields.

Scripting > SCADA
Basic

Also in: 11.2.06034,
11.1.06093

Instruction SVSQL with a SQL Server database (SPR # 62899)

A fatal error could occur when using the instruction SVSQL to query a SQL Server database. It
only happened when the "SQL Server" ODBC driver was used. It did not happen with the "SQL
Server Native Client" ODBC driver.

Scripting > SCADA
Basic

Also in: 11.2.06034,
11.1.06092, 11.0.06093

Instruction CIMWAY - Fail to handle frames (SPR # 62716)

Since version 11.2.05001, modes of the instruction CIMWAY applying to a frame were no longer
working properly, including:

STOP

START
READFRAME
SCANMDF
READAFTERWRITE

Scripting > SCADA
Basic

Also in: 11.2.06030,
11.2.06026, 11.1.06089,
11.0.06092

Instruction SVTREND mode GETTREND - Incorrect extraction (SPR #
62700)

Under some circumstances, when retrieving sampled values, some data were incorrectly
extracted.

This instruction is deprecated and its usage is discouraged. Use EXPORT_TREND mode
GETSAMPLE instead.

Scripting > SCADA
Basic

Also in: 11.2.06026,
11.1.06087, 11.0.06092,
10.0SP2_Update
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Instruction M61850 modes START DATAGROUP & STOP_DATAGROUP

(SPR # 62725)

The modes START_DATAGROUP and STOP_DATAGROUP are now operational as indicated in the
help. They replace the previous modes START_GROUP and STOP_GROUP those are now
deprecated and kept for compatibility only.

Scripting > SCADA
Basic

Also in: 11.2.06026,
11.1.06086

Opening a program from a missing library (SPR # 62417)

When trying to open/edit a SCADA Basic program from a missing library, the legacy SCADA Basic
Editor was opened instead of raising a warning. From now on, an error message is displayed in
the event viewer.

Scripting > SCADA
Basic

Also in: 11.2.06023,
11.2.06023, 11.2.06023

Instruction TREEVIEW mode GETROOT - Did not work (SPR # 62542)
The SCADA Basic instruction TREEVIEW mode GETROOT did not work properly.

Scripting > SCADA
Basic

Also in: 11.2.06022,
11.1.06076

Instruction VARIABLE mode SETLONGLABEL - Missing Intellisense
(SPR # 62429)

The auto-completion was missing for the SCADA Basic instruction VARIABLE mode
SETLONGLABEL.

Scripting > SCADA
Basic

Also in: 11.2.06022,
11.1.06072

Instruction SVTREND - Robustness (SPR # 62293)

Since version 11.1, a fatal error occurred when using the instruction SVTREND if the Begin or
End datetime was earlier than the first record of the database. A similar issue occurred when
the returned buffer was empty.

Scripting > SCADA
Basic

Also in: 11.2.06001,
11.2.06001, 11.1.06066,
11.1.06066, 11.0.06086,
11.0.06086

Embedded VBA scripts on event not executed (SPR # 62631, 62604)

When a symbol embedding VBA script was inserted several times, the events subscribed within
(on variables or graphical items) were fired only for the first instance.

Scripting > VBA
Also in: 11.2.06024,
11.1.06080

Embedded object renaming upon insertion of symbol (SPR # 60947)

When inserting a symbol several times in a mimic, its embedded objects were renamed
(numbered copy). From now on, embedded objects are no longer renamed.

Scripting > VBA

Also in: 11.2.06022,
11.2.06022, 11.1.06076,
11.1.06072

Robustness of VBA method Execute

Calling the VBA method Execute on a Log viewer object now returns an error if such a call is
already being processed.

Scripting > VBA
Also in: 11.2.06022,
11.2.06022, 11.1.06073

Exception returned when requesting RealTimeData services (SPR #
63144)

The RealTimeData Browsing, Read and GetProperties services were returning an exception
when trying to retrieve information about a variable having an xml reserved character in its
description (for example: <, >, &, ', "...). Characters are now escaped properly.

Web Server Extensions
> Web Services Toolkit
Also in: 11.2.06054,
11.1.06098

Wrong deferred attributes returned (SPR # 62963)

It was not possible to read deferred attributes of several variables at once. The first retrieved
value was wrongly duplicated for all the other variables.

Web Server Extensions
> Web Services Toolkit
Also in: 11.2.06038,
11.1.06095
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Branches and variables browsing (SPR # 62726, 62444, 62443, 62380) Web Server Extensions
When requesting branches and variables having a specific branch, all branches and variables > Web Services Toolkit
containing the specified text were returned. .
For example, with these variables: Also in: 11.2.06030,
®  @Test.B1 11.2.06030, 11.2.06030,
® @Test.B2 11.2.06022, 11.2.06001,
® @TestlBl 11.1.06090, 11.1.06069,
v olestlBl 11.0.06092

When requesting with the branch "Test", only the first 2 ones are now returned. Until the fix,
the 4 variables were returned.

In addition, when the description of a variable was empty, the full variable's name was displayed
instead of only the leaf as described in the help.

Both issues had consequences on installation browsing and variable view in TouchVue and the
Web Services Toolkit.

Popup mimic not correctly positioned (SPR # 65963, 65962) Web Server Extensions
Popup mimics were not correctly positioned when the opening button was at the edge of the > WebVue

parent mimic.

Handle leak with Trend viewer Web Server Extensions
Two handles were lost every time a WebVue mimic containing a Trend viewer was closed. > WebVue

Also in: 11.2.06066

Alarms and logs incorrectly returned (SPR # 62814) Web Server Extensions
Alarms and Logs were incorrectly returned when some text properties (associated label, > WebVue
description...) contained a comma. .

ption... Also in: 11.2.06031,

11.1.06091, 11.1.06091,

11.1.06091
Could not filter log list by Domain or Nature (SPR # 62550) Web Server Extensions
Requests to HDS log lists were not correctly processed when filtering on Domain or Nature. > WebVue
Also in: 11.2.06023,
11.1.06078
Texts in mimics not correctly displayed (SPR # 62569) Web Server Extensions
Texts in mimics generated with the Smart Generator for FactoryLink® were not correctly > WebVue
displaved Also in: 11.2.06023,
11.1.06078

Could not filter Domain and Nature having the same name (SPR # 62374) Web Server Extensions

Filtering in the Alarm and Log Viewers in WebVue was not working properly if the configuration >~ WebVue
included the same name for both a Domain and a Nature. When applying such a filter on a

nature, it was wrongly filtered against the domain criteria. Also in: 11.2.06010,
11.2.06001, 11.1.06072,
11.1.06069

Inconsistent cursor position and date & time (SPR # 61757) Web Server Extensions

In the Trend Viewer, the date & time in Cursor mode was incorrect when some configured scales > \WebVue

were hidden. Also in: 11.2.06001

Fatal error when executing the SCADA Basic instruction WINDOW mode Web Server Extensions

CURRENTNAME > WebVue

A fatal error occurred when executing the SCADA Basic instruction WINDOW mode Also in: 11.2.06001

CURRENTNAME in a WebVue context. '
11.1.06065

Unable to save exception interval (SPR # 63364, 63335) WebScheduler

Under some circumstances, it was not possible to save exception intervals. The issue occurred Also in: 11.2.06056

with BACnet schedules after deleting an existing exception based on the AnyMonth wildcard. ’
11.2.06056
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Could not read BACnet Schedule without standard week or exception
period (SPR # 62842)

A fatal error was occurring when, in a Schedule object, the weekly-schedule or the exception-
period property was missing. According to the BACnet standard, both properties are optional
but at least one of the two must be present.

WebScheduler
Also in: 11.2.06037

Improved robustness (SPR # 62557)

Improved handling to make sure all pending Http requests are closed when navigating away
from the start page.

WebScheduler
Also in: 11.2.06026,
11.2.06026, 11.1.06086

Edition of recurring intervals (SPR # 62435, 61793, 61792, 61766, 61765)

The edition of recurring intervals for BACnet Calendar objects was not correctly handled.
Depending on the recurrence pattern, it could lead to one or more of the following
consequences:

Additional occurrences displayed,
® Additional occurrences inserted in the Calendar object,
® |ncorrect datetime of the last occurrence,
®  Next intervals only displayed in edition mode.

WebScheduler
Also in: 11.2.06010,
11.2.06010, 11.2.06001

Access rights enforcement (SPR # 62407) WebScheduler
When navigating and editing schedules in multiview, an issue related to user rights enforcement  Also in: 11.2.06010,
was preventing from saving modifications even if the user was granted such authorizations.

In addition, access to the standard week, special days behavior, effective period and properties 11.2.06001

pages was checked against the CalendarRead right instead of the StandardWeekRead right.

Wrong default label for intervals on Cron schedules (SPR # 62384) WebScheduler

The default mode was always 1 (=Active). From now on, the default mode depends on the send-
mode of the schedule. It is O (=Inactive) for Bit Cmd to 1 and 1 (=Active) for Bit Cmd to 0.
It was a regression in version 11.2 that did not affect earlier versions.

Also in: 11.2.06001
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3.  Critical fixes

Alarm behaviors not saved (SPR # 63263)

Since version 11.2.05001, behaviors associated to alarm variables were not automatically saved
when leaving the project.

Communication
interfaces
Also in: 11.2.06055

Event actions not saved upon shutdown (SPR # 63960, 63789)

Under some circumstances, modification to Event actions were not saved when shutting down
the project.

Configuration

Environments >
Application Explorer
Also in: 11.2.06064

Failed fast synchronization was not rolled back (SPR # 61684)

After a failed fast synchronization, the reference file was not rolled back leading to a
discrepancy with the actual configuration. Subsequent fast synchronizations were then
considered as successful. It was then necessary to execute a full synchronization to regenerate
this reference file.

This was affecting all of the Smart Generators able to execute fast synchronization and the
Application Architect.

Configuration

Environments > Smart

Generators
Also in: 11.2.06066

Improper redundancy switchovers (SPR # 65321)
When a server station belonged to more than one associations, a switchover of one association
to which it belonged could cause the other associations to also switchover. This could have
severe side effects, in particular if associations were used for data acquisition, in particular:

® |EC 61850: Communication with devices could be halted,

®  BACnet: Communication for Notification class, Schedule, Calendar and Log objects
could be halted,

®  SNMP: Values already processed by an active server could be replayed on a passive
server.

Data Acquisition
Also in: 11.2.06075,
11.2.06075

Trend-Log buffer lost at startup (SPR # 63268)

At startup, the first retrieval of Trend-Log buffer could be performed before the subscription to
the HDS, leading to the loss of the retrieved values.

Data Acquisition >
BACnet Client
Also in: 11.2.06055

Data exchanges frozen (SPR # 62581)

Under some circumstances, data exchanges could freeze, leading to situations where values
were no longer updated. In addition, browsing and helpers did not work properly in such cases.
The issue could occur on projects with a large number of BACnet variables and significant
network traffic. It was related to computer clock & timer resolution.

Data Acquisition >
BACnet Client
Also in: 11.2.06054

Wrong BBMD started (SPR # 63174)

Under some circumstances, a wrong BBMD list could be started when an application comprised
more than 1 BACnet network.

Data Acquisition >
BACnet Client
Also in: 11.2.06054

COV re-subscription issue

Under some circumstances, COV re-subscription messages were not sent, leading to situations
where one or more BACnet device stopped sending value changes while PcVue was expecting
them (and failed to detect the abnormal situation). The symptom was that values were no
longer refreshed for one or more device, but remained valid. Stopping and starting PcVue was
required to recover up-to-date values, stopping and starting BACnet communication objects was
not enough.

Data Acquisition >
BACnet Client
Also in: 11.2.06048

Fatal error when using Schedule and Trend Log objects (SPR # 62800)

In networked architectures, a network overload could occur due to undesired messages being
sent back and forth between PcVue clients and PcVue data acquisition server when handling
schedule or trend log configuration items.

At some point, a fatal error occurred on the PcVue server side.

The issue occurred in a scenario when at least one PcVue client was already running at the
moment a data acquisition server was started. The same could occur when re-connecting or re-
starting a BACnet network (or BACnet device) when at least one PcVue client was already
running.

Data Acquisition >
BACnet Client
Also in: 11.2.06030
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Alarm/event initialization (SPR # 62740, 62738)

The alarm/event initialization was not working properly for some event types. A series of fixes &
enhancements have been done to the BACnet alarming handling including:

®  Some event types were not taken into account at initialization: ChangeOfBitstring,
ChangeOfCharacterstring, ChangeOfLifeSafety, ChangeOfState and
ChangeOfStatusFlags,

® At the time of mapping a variable to a BACnet alarm/event, the device level timestamp
was not retrieved,

®  Using the Mapping Editor in online mode, it is now possible to map alarms directly on
event-enrollment objects. The same could already be achieved from the variable dialog
box,

® |tisalso possible when using the Mapping Editor in offline mode, except that all event-
types are displayed and it is up to the application designer to pick up the correct one
(EDE files do not include enough information about events).

Data Acquisition >
BACnet Client

Also in: 11.2.06026,
11.2.06026, 11.2.06026,
11.2.06026, 11.2.06026

BRCB buffer purged on reconnection (SPR # 62804)

Upon reconnection after a communication failure, the buffer of BRCB was purged, leading to a
data loss.

Data Acquisition > IEC
61850 Client

Also in: 11.2.06030,
11.1.06090

Buffer overflow loop on reporting (SPR # 62704)

Fix of an interop issue related to the buffer overflow handling.

The behavior was not correct with devices indicating buffer overflow after a purge of the buffer
and was dependent on the level of implementation of tissues #278, #329 and #453 by device
vendors.

The handling has been changed to avoid an infinite loop in the following scenario: (1) reception
of a buffer overflow indication, (2) disable report, (3) purge buffer, (4) enable report, (5)
reception of the buffer overflow indication.

Data Acquisition > IEC
61850 Client

Also in: 11.2.06026,
11.1.06085

Driver XBUS-IP-MASTER - Fatal error when using shared connections
(SPR # 63085)

A fatal error could occur when stopping and restarting devices if they were configured to share
the same connection.

Data Acquisition >
Other built-in drivers
Also in: 11.2.06046,
11.2.06045

Driver XBUS-IP-MASTER - Value discrepancies (SPR # 62791)

Since versions 11.0.06087, 11.1.06084 and 11.2.06026, discrepancies could occur on received
data due to multiple requests being sent if the delay of the response from the PLC is greater
than 1 sec and the time-out configured on the node is greater than 1 sec.

In this context, the acquired values may be wrongly interpreted on the PcVue side. As a
consequence, monitored values may be wrong, thresholds or alarms may not trigger or trigger
false positive.

Data Acquisition >
Other built-in drivers
Also in: 11.2.06030,
11.1.06090, 11.0.06092

Partial log data export (SPR # 65933, 65905)

Exported log data was improperly limited to 150 lines per log page.

Data Export
Also in: 11.2.06081

Multiple clicks on the Save Button (SPR # 63194, 62768)

A fatal error could occur when the saving process was called several times and already in
progress.

General
Also in: 11.2.06033

Unknown user in User.dat file (SPR # 65312, 65235)

When the Advanced security strategy was activated, an attempt to login in with an invalid user
account was causing the creation of a dummy user in the built-in user directory.

General > User
management
Also in: 11.2.06074

Cannot login when domain server is not reachable (SPR # 63309)

Despite having activated the setting "cache the credentials", it was not possible to login with a
Microsoft Windows User when the domain server was not reachable.

General > User
management

Also in: 11.2.06060,
11.2.06058, 11.2.06058

Could not login after strong password setting activation (SPR # 16676)
After activation of the setting Impose strong password, users with "simple" password were no
longer able to login. From now on, when this setting is activated, users with a "simple" password
are requested to change it at next login.

General > User
management
Also in: 11.2.06023
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Incorrect optional columns configuration saved (SPR # 61950)
Under some circumstances, columns configured in the HDS were not correctly saved.

Historical data

Fatal error on HDS switchover (SPR # 64016)

Under some circumstances, a fatal error could occur after a switchover of HDS servers. The issue
could be reproduced with a single-active HDS server association with a large amount of data to
record at the time of the switchover.

Historical data
Also in: 11.2.06071,
11.2.06071

Histo.sav file incorrectly loaded (SPR # 64074)

When the histo.sav was read at startup, trend values with quality 192 were incorrectly
interpreted as if their value was 52428 leading to incorrect records in the archives. This issue
only affected proprietary archives units.

Historical data
Also in: 11.2.06071,
11.2.06071

Administrative privileges no longer required (SPR # 61058)

Since changes brought in with Microsoft SQL Server 2008 R2, administrative privileges on the
SQL Server instance were required to connect to a SQL database using the HDS. The issue
resided in evolutions of the Microsoft SQL-DMO library. The HDS implementation has been
changed to take advantage of the more recent Microsoft SQL-SMO library that does not require
such high privileges on the SQL Server instance.

The Database Manager and the Replication Manager have also been changed accordingly.

Historical data
Also in: 11.2.06060,
11.2.06058

Backup files lost (SPR # 61941)

It was possible to configure several proprietary archives unit configured with the same backup
directory. In such a configuration, some backup files were lost due to file being overridden. Now
the Application Explorer prevents such configuration, and an error message is displayed at
project startup if need be.

Historical data

Prevent wrong backup folder configuration (SPR # 61941)

This fix prevent from using the same backup folder for several proprietary archive units.
Using the same backup folder for different archive units causes backup files of one unit to be
overridden by files from other units, leading to unrecoverable data losses.

Historical data

Contingent shrink for databases (SPR # 62710)

The contingent shrink mechanism was not working efficiently with large databases (over 10 Gb).
It has been redesigned to fasten its execution and hence minimize the time window during
which blocking database operations are performed.

Note that the contingent shrink should be executed only as a last resort to free disk space.
While being executed, the data recording is not guaranteed. The usage of Maintenance Plan to
delete smaller amounts of records on a regular basis is recommended to free space without
taking the risk of blocking database recording.

Historical data

Also in: 11.2.06027,
11.2.05000, 11.1.06090,
11.1.06087, 11.0.06093,
11.0.06093

Early events at startup not recorded in log lists (SPR # 62646)

When the compatibility setting enabling the recording of events from all stations was activated,
some early events during the startup could fail to be recorded by a remote archive server
because they occurred before the connection to the source station was established.

The issue could be reproduced with Login events in case the Windows user auto-logon was
enabled.

Historical data
Also in: 11.2.06026,
11.1.06084

HDS redundancy regression (SPR # 62649)

Since versions 11.1.06072 and 11.2.06010, in an architecture with a single active historical
server association, when a server switched from passive to active, it failed to record data to the
database. As a consequence, no new record were stored by the HDS. It was mandatory to
restart all the servers of the association to resume recording.

Historical data
Also in: 11.2.06024,
11.1.06081

Email and SMS sent multiple times (SPR # 65316, 65072, 65002)

Under some circumstances, Email and SMS were sent multiple times.

Miscellaneous
Also in: 11.2.06076

Upgrade Fully qualified domain names not recognized (SPR # 63160)
Since versions 11.1.06077 and 11.2.06020, fully qualified domain names were no longer
recognized as valid station names in the networking configuration. Only IP addresses could be
used.

Networking

Also in: 11.2.06054,
11.2.06054, 11.1.06099,
11.1.06099

Regression on network messaging between servers

Since version 11.0.06044 and 11.1.05000, when a distributed attribute was modified at least
twice in less than 200 ms, new values were sent back and forth between the active and passive
servers of the producing association.

Networking
Also in: 11.2.06001,
11.1.06071, 11.0.06086
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Inconsistent configuration on servers Networking

A fatal error of a data acquisition server was occurring in case of an inconsistent configuration Also in: 11.2.06001
between servers, when a bit variable was configured as a temporized alarm on a server and as a '
simple bit on another server. 11.1.06070, 11.0.06086

Support for double back-slash in expressions Real time data

Expressions including a double back-slash to display it on multiple lines in the expression editor  Alsg in: 11.2.06001,
failed to load, and the result variable was never updated at runtime.
The issue was a regression following modifications in the expression engine in version 11.1. 11.1.06075

Multimode timetables - Various fixes and enhancements (SPR # 64289)  WebScheduler
The list of fixes & enhancements includes: Also in: 11.2.06066,

®  (Critical: Under some circumstances, multimode timetables were displayed with the 11.2.06066. 11.2.06066
wrong mode when not all modes were used in at least one interval; o ! o
®  When deleting more than one exception interval at once, the operation failed and a
misleading error message was displayed;
®  The button to navigate backward in time in the Calendar view could be disabled,
preventing from coming back to the current week. The button to go to 'Today' was
working properly in these circumstances.
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4. Enhancements

License Utility - Display .lic file content (SPR # 64048)

The License Utility is now able to display the content of .lic files prior to updating/upgrading a
license.

Add-ons and Tools
Also in: 11.2.06064,
11.2.06064

User privileges to access audits

Users can now access the Audit information in the Application Explorer if they are granted
Diagnostics permissions in their profile.

Until this change, audits were only accessible to users having development permissions.

Audit

Time Sync request handling (SPR # 65668)

It is now possible to acknowledge positively a Time Sync request even if the service is not
supported. This change improves interoperability with IEC 104 clients that do not handle
negative ack properly. In all cases, the computer clock is not changed.

Communication
interfaces > IEC 60870-
5-104 Outstation

Also in: 11.2.06079

Invalid timestamp quality

It is now possible to set the timestamp quality of the items exposed by the IEC 104 Outstation
when using the SCADA Basic instruction SYSTEM with the mode SETSYNCHRONIZEDCLOCK. This
instruction is global and is applied to all the items exposed by the IEC 104 Outstation.

Communication
interfaces > IEC 60870-
5-104 Outstation

Also in: 11.2.06001

SnapshotPeriod range modified
The range for the SnapshotPeriod setting is now limited to [50 ms, 10 min].

Communication
interfaces > SNMP
Agent

Also in: 11.2.06071

Status bar (SPR # 62890)

Additional information is displayed in the status bar at the bottom of the Application Explorer
and Application Architect:

®  Current user,

L4 Current station name,

®  Total number of 1/0 variables configured,
®  Max number of I/O variables.

Configuration
Environments

Sorting of the Tpl_Instances file

The elements in the file Templates\Tpl_Instances.xml are now sorted, which enables easier file
comparison between multiple versions of a project.

Configuration
Environments >
Application Architect

Local branch for symbols (SPR # 63193)

It is now possible to configure a local branch for symbols.

Configuration
Environments >
Application Architect

Generate mimics in libraries (SPR # 62862)

It is now possible to indicate if a mimic has to be generated in the local, common or shared
library.

Configuration
Environments >
Application Architect

Reorganization of the intermediate file

The intermediate file generated by the Application Architect has been reorganized to group and
sort elements in a more efficient way regarding the import performances.

Configuration
Environments >
Application Architect

New function support in expressions - StrLen
It is now possible to use the function StrLen in expressions to get the length of a string.
Syntaxx. Int = StrLen (String)

Configuration
Environments >
Application Architect
Also in: 11.2.06034

Reference: PcVue 12 Release Notes
Copyright ©2024 - ARC Informatique. All rights reserved — LI N0 H I3

Last update: November 3, 2025

Page 89/119



4
PcVue >

SNMP Manager mapping editor (SPR # 62368)
The mapping editor for the SNMP Manager now supports array objects.

Configuration
Environments >
Application Architect
Also in: 11.2.06010,
11.2.06001

OPC items list (SPR # 58687)
The OPC items are now sorted alphabetically in the Mapping dialog box.

Configuration
Environments >
Application Explorer

Custom Expression property of OPC variables (SPR # 17042)

It is now possible to edit the property Custom Expression of OPC variables in the Advanced tab
of the variables properties dialog. This property was already available by editing the
C\Varexp.dat file.

Configuration
Environments >
Application Explorer

Initialization Bit of Chronometer (SPR # 16517)

The Initialization bit variable of a Chronometer behavior is now optional

Configuration
Environments >
Application Explorer

Configurable default associated labels

Some labels that used to be hard-coded are now fully configurable to allow for a greater
customization. This includes labels associated to user actions (login, logout...), timestamp
quality...

Configuration
Environments >
Application Explorer

LonWorks items list

LonWorks items (Networks and Nodes) are now sorted alphabetically in the Application
Explorer.

Configuration
Environments >
Application Explorer

Station without node (SPR # 62063)

When creating a new station in the Networking configuration, canceling the node creation was
not cancelling the station creation leading to a station configured without a node.

Configuration
Environments >
Application Explorer

Paste items from context menus (SPR # 61660, 16515)

It is now possible to paste branches and variables from context menus.

Configuration
Environments >
Application Explorer
Also in: 11.2.06026

HMI for settings related to Event and Cyclic actions

Following the addition of settings allowing executing event and cyclic actions on all servers or
only the active servers of an association, these settings can now be changed via the Application
Explorer HMI.

Configuration
Environments >
Application Explorer
Also in: 11.2.06001

Several fixes & enhancements of the BACnet Smart Generator (SPR #
63820, 63817, 63807, 63803, 63800, 63799, 63797, 63792)

The list of fixes and enhancements incudes:

Select variables dialog box reworked to reduce flickering in list views,

Fixed several issues with the selection persistency for devices and automation objects,
Fixed an issue when replacing characters in automation object names,

Fixed a validation issue of BACnet Device Id for IEIEJ import. Values outside of the
range [0..4194303] are no longer allowed,

® |mproved progress notification upon parsing of input file.

Configuration
Environments > Smart
Generators

Selecting Smart Generators to display (SPR # 62834)

It is now possible to select which Smart Generators are available in the right-side menu Import
references of the Smart Generators main window.

Configuration
Environments > Smart
Generators
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Imports list (SPR # 63082) Configuration
The list of imports is now sorted alphabetically. Environments > Smart
Generators

Also in: 11.2.06055

Handling of time tagged data Data Acquisition
It is now possible to set how to handle the timestamp upon reconnection to OPC servers: Also in: 11.2.06001,
®  Use of the local station timestamp, 11.1.06067

®  Use of the last known timestamp.
The new setting named Use Local Timestamp Upon Reconnection is available as part of the OPC
Client settings.
It is set to true for existing project, and defaults to false for new projects.
Similar settings already existed for the IEC 104 client and DNP3 drivers.

Support for UTF-8 and OEM encoding for EDE files (SPR # 65095, 64376) Data Acquisition >

It is now possible to load EDE files with ANSI, UTF-8 or OEM encoding. Previously, only ANSI BACnet Client
encoding was supported.

Property selected by default in Helper (SPR # 62936) Data Acquisition >

When creating a List of property reference in the BACnet Helper, the property selected by BACnet Client
default is now present-value instead of the first in alphabetical order.

Configurable column mapping for EDE files (SPR # 63340) Data Acquisition >

From now on, it is possible to select how the loading of each EDE file is handled, either withthe  BACnet Client
automatic detection mode, or with a customized mode by selecting: .
Also in: 11.2.06066,

®  The column delimiter;

®  The column header's names. 11.2.06066, 11.2.06064,
11.2.06064, 11.2.06064,
11.2.06064, 11.2.06064,
11.2.06064, 11.2.06064,

11.2.06064
EDE mapping coloration Data Acquisition >
In the EDE mapping dialog box, properties are now displayed in red when read request failed. BACnet Client
Support for the time-delay-normal property Data Acquisition >
The BACnet driver now supports the property time-delay-normal (id 356). BACnet Client
Execute Read request after Write request Data Acquisition >
From now on, it is possible to execute a synchronization read request on a BACnet object or BACnet Client

property that has been updated by a write request. .

Such behavior can be configured at device level with the advanced property Writing.Synchronize Also in: 11.2.06041,
values after writing (enabled by default). 11.2.06039

It has been designed to ensure user awareness in cases where the command is successfully

executed end-to-end, but, because there is already a higher priority command, the command

issued from PcVue is not reflected in the object value.

Prevent mapping of unknown objects Data Acquisition >

It is no longer possible to map variables on BACnet objects that are of an unknown type (e.g. BACnet Client
object type Id in the range of Proprietary or Reserved object types for example). .
Also in: 11.2.06037

Reading specific index of a BACnetArray (SPR # 62817) Data Acquisition >

From now on, it is possible to map a variable onto a specific index of a property of type BACnet Client
BACnetArray (such as priority-array or weekly-schedule properties) by specifying BACnetArray(x) .

in the advanced property Field of the variable, where x corresponds to the 1-based index in the Also in: 11.2.06035,
array. If the specified index is higher than the array size or if the value cannot be converted 11.2.06035. 11.2.06035
(according to the variable type), the quality of the variable will be set to NS_FMT. Index O can be ’

used to get the size of array.

This syntax only applicable to BACnetArray, it is not applicable to properties of type BACnetList.

Incorrect list of properties when browsing Data Acquisition >

When the service ReadPropertyMultiple with a property reference set to ALL is not supported by BACnet Client

the requested device, the property list defined in the built-in XML catalog is used instead of the .
default one. Also in: 11.2.06031
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Max segments accepted increased to 64

The max number of segments accepted has been increased to 64 (was 16) to improve the
interoperability with some devices that were not considering this capability element correctly.

Data Acquisition >
BACnet Client
Also in: 11.2.06026

Clear Restart 1IN and Refresh Attributes (SPR # 64640)

It is now possible to configure if a request to clear IIN1.7 (Restart IIN) and Refresh Attributes
need to be sent when a connection to a device is established.

Data Acquisition >
DNP3 Client
Also in: 11.2.06071

Time zone overridden

Under some circumstances, it happens that the time zone sent by the device is incorrect (i.e.:
misconfiguration). To avoid erroneous data reading and recording, a new advanced property is
available at variable level to enable overriding the time zone sent by the device.

Data Acquisition >
DNP3 Client
Also in: 11.2.06064

DNP3 time synchronization

A new advanced property named Synchronization type is available on DNP3 devices. It allows
defining whether time synch messages sent by PcVue should be formatted as defined by the
DNP3 LAN or DNP3 Serial standards (defaults to LAN). This new option allows support for
devices that only support DNP3 Serial time synch messages over TCP.

Data Acquisition >
DNP3 Client
Also in: 11.2.06055

DNP3 device redundancy support

In addition to data acquisition server redundancy, the DNP3 client driver now also supports
device redundancy.

Data Acquisition >
DNP3 Client
Also in: 11.2.06043,

11.2.06043, 11.2.06041,
11.2.06039, 11.2.06038,
11.2.06038, 11.2.06036,
11.2.06036, 11.2.06036,
11.2.06036, 11.2.06035,

11.2.06034, 11.1.06097

Support for the ONLINE flag

The flag ONLINE of DNP3 objects was not taken into account in the status of variables. It is now
taken into account in addition to the COMM_LOST flag.

Data Acquisition >
DNP3 Client

Also in: 11.2.06022,
11.1.06075

Improved connection management

In order to avoid multiple connections/disconnections, the communication is stopped after 3
connections and disconnections in less than a second, and restarted after 30 seconds. Such a
behavior could be generated by an erroneous configuration in the project and could cause
network traffic overload.

Data Acquisition > IEC
60870-5 Client
Also in: 11.2.06038,
11.1.06095

New time zone property (SPR # 62568)

It is now possible to configure the time zone (Local or UTC) used by a Sector for timestamped
data. It can be set in the advanced properties of Sectors.

Data Acquisition > IEC
60870-5 Client
Also in: 11.2.06023,
11.1.06079
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SCADA Basic instructions to change global settings (SPR # 58835)

New modes are available for the SCADA Basic instruction M61850 to modify the IEC 61850
global settings by script:

M61850("SET_GLOBAL_ORCAT", <Value>)

where <Value> can be "not-supported", "bay-control", "station-control", "remote-control",
"automatic-bay", "automatic-station", "automatic-remote", "maintenance" or "process".
Defines the value used for the OrCat parameter when sending Controls
M61850("SET_GLOBAL_ORIDENT", <Value>)

where <Value> can be "00","01","10" or"11".

Defines the value used for the Orldent parameter when sending Controls.
M61850("SET_GLOBAL_TEST", <Value>)

where <Value> can be 0 or 1.

When set to 1, all controls sent will be by default flagged as "Test".
M61850("SET_GLOBAL_CHECK", <SynchroCheck_Value>, <InterlockCheck_Value>)

where <SynchroCheck_Value> and <InterlockCheck_Value> can be 0 or 1.

When <SynchroCheck_Value> is set to 1, all controls sent will be by default flagged for synchro-
check.

When <InterlockCheck_Value> is set to 1, all controls sent will be by default flagged for
interlock-check.

M61850("SET_GLOBAL_CHECK", <Value>)

where <Value> can be "00","01","10" or "11".

Similar to the previous mode with the following value definitions:

"00" SynchroCheck_Value =0 and InterlockCheck_Value =0

"01" SynchroCheck_Value =0 and InterlockCheck_Value =1

"10" SynchroCheck_Value =1 and InterlockCheck_Value =0

"11" SynchroCheck_Value =1 and InterlockCheck_Value =1

Data Acquisition > IEC
61850 Client

Support for Report Control Block reservation (SPR # 61065, 60875)

Control Block Reservation is now supported for URCB and BRCB, including RCB reservation in
redundant data acquisition architectures.

Data Acquisition > IEC
61850 Client

Double-point configuration at device level (SPR # 62993)

It is now possible to configure at device level how double-points should be interpreted
([01]/[10] or [10]/[01] for true/false). This setting overrides the one which was already available
in the global IEC 61850 settings.

Data Acquisition > IEC
61850 Client

Also in: 11.2.06055,
11.2.06055

Port configuration (SPR # 61675)

It is now possible to customize the TCP port for connecting to IEC 61850 devices. The new
property is available in the device's advanced properties.

Data Acquisition > IEC
61850 Client

Also in: 11.2.06046,
11.2.06046

Support for 3V16, 4V16, 3F16 and 4F16 data formats (SPR # 65791)
The KNX add-on now supports the 3V16, 4V16, 3F16 and 4F16 data formats.

Data Acquisition > KNX
Also in: 11.2.06080,
11.2.06080

New setting for initial read at startup (SPR # 64505)

A new setting named InitialReadltemsNumber is available in the KNX configuration file. It
specifies the maximum number of items refreshed at once on project start-up. The driver
refreshes all the items flagged as R at the rate of TimeOutInSec*30s until all the items are read.
Default value is 200.

Data Acquisition > KNX
Also in: 11.2.06068

Non-compliant OPC group name (SPR # 63246, 63147)

A new advanced property named OPC group name imposed by the server is now available. It is
designed to solve interop issues when an OPC server imposes a group name that cannot be the
name of a configuration item in PcVue (due to special characters or name length). As an
example, taking advantage of timestamping at the PLC level with Schneider Electric OFS requires
using an OPC group named ##TSEventsGroup##.

Data Acquisition > OPC
Client

Also in: 11.2.06055,
11.2.06054

IP Mewtocol - Several enhancements (SPR # 65393, 65277)
The list of enhancements includes:
Data range is increased from 999 to 65535,

® New equipment supported : FP2SH-LAN (no IP header),
®  Support for the bridge feature up to 3 levels for FPX-LAN,
®  Sjze of frames is increased from 30 to 500 words.

Data Acquisition >
Other built-in drivers
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Mitsubishi TCP/IP - Maximum address range for R and D data (SPR #
63996)

The maximum address range of D and R data for Mitsubishi Q series PLC is now 65535 (was
12287).

Data Acquisition >
Other built-in drivers
Also in: 11.2.06064

UTF-8 and MSDOS PC-8 support for text variables (SPR # 61431)

Support for UTF-8 and MS DOS PC-8 encoding for text variables mapped on CimWay frames. The
encoding can be set in the advanced properties of the corresponding variables.

In case of UTF-8, it is possible to indicate a byte size (from the source) that may differ from the
text variable size.

Data Acquisition >
Other built-in drivers
Also in: 11.2.06026

Driver XBUS-IP-MASTER - Several enhancements (SPR # 62301)

Several enhancements of the XBUS-IP-MASTER driver to better support IP to modem converters,
including:

® |mproved handling of the connection time-out and retry,
® |nformation frame enhanced with timeout and retry values:
. INFO 0004: max Timeout value,
° INFO 0005: current Timeout value,
. INFO 0006: max number of retries,
. INFO 0007: current number of retries,

® |mproved management of the serialization of several devices using the same
connection channel,
®  New option at device level to indicate if it is a Fixed timeout or Standard device:
*  When Standard is selected, the time-out is not played if the
corresponding socket is not opened on the device (default value),

. When Fixed timeout is selected, the timeout is forced even if the socket is
not opened.
In addition, new submodes are available for the SCADA Basic instruction CIMWAY, mode
SENDMSG:

®  To enable the usage of a specific connection channel to a device:
CIMWAY ("SENDMSG", NetworkName, "EnableConnectio
n;EgtName; CnxNb")
® To disable the usage of a specific connection channel to a device:
CIMWAY ("SENDMSG", NetworkName, "DisableConnect
ion;EgtName; CnxNb")
®  To activate CWAudit traces on the selected communication object:

CIMWAY ("SENDMSG", ObjectName, "TraceOn")

®  To deactivate CWAudit traces of the selected communication object:

CIMWAY ("SENDMSG", ObjectName, "TraceOff")

Data Acquisition >
Other built-in drivers
Also in: 11.2.06026,
11.2.06026, 11.2.06026,
11.2.06026, 11.2.06026,
11.2.06026, 11.1.06086,
11.1.06084, 11.1.06084,
11.1.06084, 11.1.06084,
11.1.06084, 11.0.06092,
11.0.06090, 11.0.06090,
11.0.06089, 11.0.06087,
11.0.06087

Driver XBUS-IP-MASTER - Default slave Id (SPR # 62357)

In order to follow official recommendations, the default slave Id is now 255 (was 1).
While discouraged, it is now also possible to configure a slave Id equal to 0.

Data Acquisition >
Other built-in drivers
Also in: 11.2.06001,
11.1.06068

New extraction string

A new extraction string NOTENUM(xSySz) is available for bit variables. It enables setting a bit
variable to 1 when the source item value is not contained in the given enumeration (here x or y
orz).

Data Acquisition >
SNMP Manager

Configuring alarm on Trap of type text (SPR # 63262)

It is now possible to configure an alarm on a trap of type text. In such case, the Field property
has to be set to StrCmpare(<string>), where <string> matches the text that will trigger the
alarm.

Data Acquisition >
SNMP Manager
Also in: 11.2.06058,
11.2.06056

Max size of authentication and encryption keys (SPR # 62918)

From now on, the maximum size of authentication and encryption keys is 255 characters (was
30).

Data Acquisition >
SNMP Manager
Also in: 11.2.06034,
11.1.06093
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Enhanced Command reception

The handling of command reception has been improved to enhance performances. Until this
change, all the configured devices were processed. From now on, only the devices having
pending commands are.

In addition, a device was not able to receive traps while waiting for a command reception. Both
actions are now dealt with separately to avoid any delay in traps handling.

Data Acquisition >
SNMP Manager
Also in: 11.2.06026,
11.1.06079

Exporting previous point (SPR # 64448)

When exporting trends in raw mode, it is now possible to include the last point prior to the
export period.

Data Export

Support for special characters in settings (SPR # 63475)

Characters '#' and '/' are now supported as part of the replacement strings for unknown and
non-significant data.

This enhancement allows the use of the replacement string '#N/A' (without quotes) which is by
default interpreted by Microsoft Excel as a non-significant value (including formula...).

Data Export
Also in: 11.2.06064

Filtering logs (SPR # 63382)

In addition to filtering event types, it is now possible to apply an additional filter based on
extended attributes to a Log list when exporting it.

Data Export

Improved filtering of logged data export (SPR # 63382)

When using data export for logged events, it is now possible to filter according to all usual
variable attributes including Domain, Nature and Extended Attributes.

A new tab named Attributes is available on Log Filter items to configure the expression filter to
be applied to the associated log page.

Data Export
Also in: 11.2.06061

Date and time format

It is now possible to configure date and time:
®  Dateonly,
®  Time only,

® Dante and Time.
A new argument has been added to the SCADA Basic instruction EXPORT_TREND.

Data Export

Export of interval start and end timestamps

It is now possible to export both the start and end date and time of each interval in aggregated
statistics.

Data Export

Out of memory fatal error when exporting (SPR # 63447, 61990)

Under some circumstances, when exporting a large amount of trends or on a long period with
short sampling, an Out of memory exception could be raised. To prevent such a situation, new
settings have been added to Exports.

Data Export

Start date and End date on the same line
Start date and end date are now displayed on the same line for aggregated statistics.

Data Export

Starting position of exported data
It is now possible to indicate for each export page the starting position of the data in the page.

Data Export

Data Export limits (SPR # 62613)

In order to ensure nominal performances, the number of items that can be configured for the
Data Export is now limited to:

Data Export
Also in: 11.2.06026,

o 100 exports 11.1.06085
® 10 pages per export
® 100 trends per page

These limits can be modified in the file \C\svConf.dat. Warning messages are displayed in the

Event Viewer when these limits are reached.

Performances may degrade when exceeding default limits.

Number of GDI & USER objects, Desktop heap General

It is now possible to use the SV Core Management Console to change the size of the desktop

heap and to set the maximum number of GDI and User objects that can be created per-process.

Changing these Windows system-level settings is sometimes necessary to handle more mimics
when a PcVue web back end runs as a Windows service.

Changing these settings is sensitive; in particular, setting the desktop heap to a value too high
can put the system in a no-boot situation due to the Windows kernel not being able to allocate
memory properly to even get Session 0 set up.

Also in: 11.2.06073,
11.2.06073, 11.2.06073,
11.2.06073, 11.2.06073
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Improved mechanism for detecting running Sv32 instances

The detection mechanism of running instances of the Sv32.exe process has been improved. It is
mainly useful with RDS-based architecture. In addition, new diagnostic messages related to this
mechanism have been added.

General

Also in: 11.2.06026,
11.2.06026, 11.1.06087,
11.1.06087, 11.0.06092,
11.0.06092

Change for dev licenses
Development licenses now offer up to 4 hours of continuous data acquisition.

General > Licensing

User password length (SPR # 64047)

The maximum password length is now 127 characters (was 16)

General > User
management
Also in: 11.2.06064

Filtering Active Directory User Groups (SPR # 62674)

When associating a User profile to an Active Directory User Group, it is now possible to filter the
AD User Groups. This feature is particularly interesting when there is plenty of User Groups.

General > User
management

Also in: 11.2.06026,
11.2.06026, 11.2.06026,
11.1.06082, 11.1.06082,
11.1.06082, 11.0.06090

Excluding files by extension (SPR # 63198)

When managing project versions, it is now possible to exclude files depending on their
extensions.
For instance, to exclude all xml files of the C directory, use the following syntax:

f1=C\*.xml

General > Version
management

Unable to load project from Central folder (SPR # 62583)

When the Windows user does not have the correct permission on the USR folder, loading a
project from the Central folder could fail. Now a warning message box is displayed in such a
situation.

General > Version
management

Decreasing station priority on HDS failure

The availability rate is now automatically set to 0 when the HDS is not answering requests. As a
consequence, requests are automatically redirected to a server having a higher availability rate.

Historical data

Log on/off alarm changes setting (SPR # 63324, 61669, 61564, 17211)
The archive global setting Log only on/off alarm changes in log lists is now read-only when an
archive unit with a log list is configured. Changing this setting while having already archived
alarms leads to misinterpretation of archived data.

Historical data

ODBC archives - Compatibility with MySQL and MariaDB (SPR # 63386)

It is now possible to set a specific column delimiter to be used in the handling of ODBC
databases. In particular, it enables the usage of MySQL and MariaDB database engines.

Historical data

Also in: 11.2.06059,
11.2.06058, 11.2.06058,
11.1.06106, 11.1.06106

Max length of names for archive configuration items increased
Max length for names of archive configuration items are now:

®  Archive unit name is now up to 80 characters (was 12), except for ODBC,
HDS Database name is now up to 100 characters (was 32),
HDS Table name is now up to 45 characters (was 32),
HDS Trend group name is now up to 100 characters (was 32),
Log list name is 100 characters is now up to (was 12), except for ODBC.

Historical data

Invalid points for trends after communication failure (SPR # 62964)

From now on, invalid points are no longer recorded for trends in case of communication failure,
in particular with networking architecture having separated servers for data acquisition and
archiving.

When communication is recovered, if the VTQ has changed, then an invalid point with the
timestamp of the start of the communication failure and the new VTQ is recorded.

Historical data
Also in: 11.2.06038,
11.1.06096
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Filtering by username (#N) (SPR # 62427)

From now on, it is possible to filter archived HDS and proprietary log lists by User name (#N). A
new column and a new attribute have been added to their respective configuration.

Historical data
Also in: 11.2.06037

Deletion of referenced Log table (SPR # 62910)

From now on, it is no longer possible to delete a Log table when it is referenced by a Log list.
Allowing such deletion was leading to configuration inconsistency and logs were no longer
recorded without notice.

Historical data
Also in: 11.2.06035,
11.1.06093

Low resource warning system for GDI and USER objects
Rework on the low resource warning system for both GDI and USER objects:

®  Changed the GDI and USER object monitoring configuration to use a percentage of the
resource limit rather than an absolute value,

®  Changed the message displayed in the warning dialog box when the application
exceeds the maximum resources allocated to it,

® Added monitoring of USER objects by default for new projects.

HMI

Also in: 11.2.06073,
11.2.06073, 11.2.06073,
11.2.06073, 11.2.06073

Empty comments in exported translations (SPR # 64154) HMI
When exporting mimic and symbol resources for translations, empty comments are no longer
exported.
List of available SCADA Basic functions (SPR # 63269) HMI
The list of available functions in a program is now displayed when configuring:
® A Run Program animation,
®  Form Controls,
®  OnOpen and OnClose functions in mimic properties.
Default export folder (SPR # 64190, 61952) HMI
The default export folder when exporting data from the wizard of the Trend viewer or the Grid
Control is now configurable with the setting Data Export Wizard.Working folder.
It defaults to the Documents folder of the currently logged Windows user
(C:\Users\<UserName>\Documents).
Default filter of image selector HMI
By default, the image selector now displays all files (was only displaying .bmp files).
Image picker and file types HMI
The image picker now displays all files by default, instead of only *.bmp files. Also in: 11.2.06054,
11.1.06099
Dialog boxes' position reset (SPR # 62719) HMI

The position of dialog boxes is now reset automatically when they are detected in a non-visible
part of the desktop workspace.

Such issues occur when changing operating system display setting, for example when switching
from 2 screens to 1.

Also in: 11.2.06038,
11.2.06038, 11.2.06038,
11.2.06038

Configurable Navigator's border color and thickness (SPR # 62306)

It is now possible to configure the border color and thickness of the Navigator from the menu
Preference/Colors.

HMI

Also in: 11.2.06022,
11.2.06022, 11.1.06072,
11.1.06072

Variable substitution dialog box (SPR # 62304) HMI

The dialog box to configure variable substitutions on a symbol has been enhanced. It is now a Also in: 11.2.06001

sizable window and supports column resizing for a better display. '
o ¢ e 11.1.06071

Default value for property "Original size" of symbols (SPR # 62304) HMI

A new HMI option named Mimics.Symbols."Original size" selected when inserting symbol is Also in: 11.2.06001

available to indicate whether the Original size property shall be ticked or not when inserting a '

symbol in a mimic. 11.1.06067

Disabling right-click in the workspace (SPR # 62022) HMI

A new HMI option named Mimics.Context menus.Disable workspace right click popup menu is Also in: 11.2.06001

available. 11.1.06061 ’

When activated, the context menu will not be displayed on right-click on the workspace.
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Replacement text for AlaOn, AlaOff & AlaAck substitution characters
(SPR # 61869)

A new HMI option named Mimics.Animations.Replacement symbol if alarm timestamp does not
exist is available to customize the replacement text for the substitution characters of type
#xxxAlaOn, #xxxAlaOff and #xxxAlaAck, when the corresponding timestamp does not exist.

HMI > Alarm viewer
Also in: 11.2.06001,
11.2.06001, 11.2.06001,
11.1.06067, 11.1.06067,
11.1.06067

Enhanced text animations
Enhancements include the ability to use pre-defined labels associated to an enumeration.

HMI > Animations

Case sensitive comparison in text animations

A new HMI global option allows using case sensitive comparison in animations based on text
value (defaults to Non-sensitive case comparison). The option is named Enable case sensitivity
for animations that compare text strings and is available in the Animation category.

HMI > Animations

Keyboard shortcut for Run Program and Run Macro (SPR # 63103)

It is now possible to configure keyboard shortcut accelerators for the animations Run Program
and Run Macro.

HMI > Animations

Enumeration associated labels in Text animations (SPR # 63878)

It is now possible to use the Enumeration Associated Labels in text animations. Prior to this
enhancement, they were only usable in the WebScheduler.

HMI > Animations
Also in: 11.2.06062,
11.2.06062, 11.2.06062

Tooltips for wrapped labels in Form controls (SPR # 62586)

Worapped labels are now fully displayed as tooltips in Form controls.

HMI > Form controls
Also in: 11.2.06064

Branch selection for symbol in branched-mimic (SPR # 64130)

Now, the selection of the local branch of a symbol takes into account the context branch of the
mimic if any.

HMI > Graphics

Selected layers of pasted graphical object (SPR # 61084)

From now on, when copying and pasting a graphical object, layers configured in the original
object are also copied. Previously, layers were set according to the displayed ones at the
moment of the pasting.

HMI > Graphics

New sorting option in historical mode

It is now possible to sort data according to their timestamp. It defaults to newest data on top of
the list.

HMI > Grid control

Ability to display statistical data

The Grid control Historical mode is now able to display sampled trend and statistical data, in
addition to raw data. Used in conjunction with the Data Export wizard, users can now export
any trend data in their preferred format.

HMI > Grid control

Disabling command sending (SPR # 63424)

It is now possible to disable the possibility for the user to send commands in Variable tracking
mode.

HMI > Grid control
Also in: 11.2.06058,
11.1.06105

Enumeration labels in the Log viewer

It is now possible to display enumeration labels configured for Register and Text variables in the
Log viewer.

HMI > Log viewer

Automatic refresh period (SPR # 62995)

The minimum value of the Automatic refresh period property is now 1 sec (was 5).

HMI > Log viewer
Also in: 11.2.06038,
11.1.06095

Initial position of the map (SPR # 64012)

When inserting a Map control or modifying the provider, the initial position and zoom level are
now identical to the ones used when the map was cached with the Map Cache Creator.

HMI > Map control

Markers visibility

It is now possible to link the visibility of a marker to a variable.

HMI > Map control
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Support for external GPX files (SPR # 63249)

It is now possible to configure dynamic layers linked to external GPX files. A URI property can be
defined at the layer level in the Map Markers Editor to indicate its source.

HMI > Map control

Centering symbol markers on anchor (SPR # 64254)

It is now possible to configure whether symbol markers shall be positioned according to their
anchor or to their center.

HMI > Map control
Also in: 11.2.06068

Embedding Markers and Local Map into the project folder

It is now possible to store the configuration of markers and map cache into the local GIS folder
of a project (could only be stored in the Common folder until this change). As for other graphical
objects, the local folder is referenced by a starting '/' in the file name.

HMI > Map control
Also in: 11.2.06058,
11.2.06058, 11.2.06057

Max length for description (SPR # 65149)

The maximum length of trend description is now 255 characters (was 60).

HMI > Trend viewer
Also in: 11.2.06074

Scientific notation (SPR # 64657)

Scientific notation was always used in the legend and scale areas when value was greater than
100 000. It is now possible to configure if this formatting has to be used or not.

HMI > Trend viewer
Also in: 11.2.06070,
11.2.06067

Trend Viewer - Support for 16 curves

The trend viewer now supports up to 16 curves simultaneously.

As part of this evolution, colors for the trend viewer can be pre-configured using the color
preferences.

HMI > Trend viewer

Time-axis limits (SPR # 63088)

From now on, it is possible to configure the horizontal axis period and time capacity buffer from
1 to 14400 for each time unit: Seconds, minutes, hours, days (was 3600).

HMI > Trend viewer
Also in: 11.2.06055,
11.2.06054, 11.1.06101,
11.1.06101

Max number of points

The maximum number of points that can be retrieved to draw a trend curve is now up to 48000
(was 12000).

HMI > Trend viewer
Also in: 11.2.06039

Upgrade Backup/restore of the file Settings.ini

In order to ensure proper update of the product at installation time, the file \Bin\Settings.ini is

now explicitly deleted upon uninstallation.

Because this file potentially stores important settings such as the configuration of Thread pools
and Web thread pools, it is important that you back up this file prior to uninstallation and make
sure you restore those settings that are key to your project set-up after installation.

Installation

New system variables (SPR # 65265)
The list of new system variables includes:

®  @System.Localhost.Environment.RunningAsService: Indicates if PcVue is running as a
Windows service,

®  @System.Localhost.Environment.RunninglnRemoteDesktopSession: Indicates if PcVue
is running in a remote desktop session,

®  For compatibility, the variable @System.WTS is kept updated if it exists, but it is no
longer created and shall no longer be used.

Miscellaneous

Accuracy of timer for cyclic functions
Improved accuracy of the timer used for cyclic functions.

Miscellaneous
Also in: 11.2.06073

Syntax control (SPR # 64583, 64413, 16442)

The syntax control has been reinforced for new projects. While it was only executed at design
time in earlier versions, syntax control can now also be executed when loading a project.

For compatibility purpose, the new setting is only activated for new projects. It is recommended
to activate it on projects developed with earlier versions. The setting in named Syntax check and
is available in the section Advanced.Compatibility.Syntax.

Miscellaneous
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Description property limited to 255 characters (SPR # 61530)

The description property of various items are now limited to 255 characters (was 80).
It includes:

Archives Units and associated objects,

Alarm synthesis,

Alarm Associated actions,

Messages items (profile, templates, SMS and Email),
Function keys,

Cyclic,

Events,

Expressions (template and on variable),

Miscellaneous

Enhanced robustness upon archive server switchover

The robustness of the switchover mechanism has been improved for archive server association
when configured as single active. In addition, traces have been added to better monitor
switchover.

Networking

Also in: 11.2.06010,
11.2.06010, 11.1.06072,
11.1.06072, 11.0.06087,
11.0.06087

Expression without a variable (SPR # 60832, 60831)

From now on, expressions defined without a variable are evaluated and no longer remain NS. It
applies to expressions on variable and expressions in animations.

Real time data

Chrono now limited to 1h (SPR # 48048)

Period of a Chrono variable is now limited to 1h (was 655 sec).

Real time data

Notification of timestamp change

It is now possible to configure whether the Alarm Manager and the User Interface shall be
notified when only the timestamp changes.

The new settings are located in the file C\VarConf.dat:
[DeviceTimestampChangeNotification]
ToAlarmManager=1

ToUserInterfaceManager=1

For both settings, the value 1 indicates that the corresponding manager is notified, their default

value is 1.

This permits updating real time data and alarms on value change or on timestamp change.

Real time data
Also in: 11.2.06001,
11.1.06069

Go to the definition of a function (SPR # 61506)

It is now possible to go to the definition of a function in a SCADA Basic program by using the
corresponding entry of the context menu displayed when right clicking on a function name.

Scripting > SCADA
Basic

Upgrade Instruction LOGDISPLAY - Context parameter reworked
The argument Context of the instruction LOGDISPLAY, which enables delaying the application of
the filter until the mode EXECUTE is called, has been reworked as following:

® |tis renamed DelayExecution,

®  When set to 0, the instruction is immediately executed,

®  When different from 0, its execution is delayed until the mode EXECUTE is called,

® |tis optional for all applicable modes and defaults to 0.
This argument can be used with the modes DOMAIN, EVENTMASK, EVENTMASKEX, FILTER,
LOGLIST, NATURE, MINMAX and SETDATETIME.
When upgrading a project from an earlier version, a particular attention must be given to the
mode SETDATETIME that was working differently (instruction delayed only when the argument
was omitted).

Scripting > SCADA
Basic
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Upgrade Instruction M61850 - return code reworked Scripting > SCADA
The return codes of the instruction M61850 has been reworked for the modes: Basic
START_NETWORK

STOP_NETWORK

START_PHYSICALDEVICE

STOP_PHYSICALDEVICE

START_DATAGROUP

STOP_DATAGROUP

START_DATASETGROUP

STOP_DATASETGROUP

START_REPORTGROUP

STOP_REPORTGROUP
The new return values are the following:

-1, Command in progress

0, Command successfully executed
1, Not implemented

2, Object not found

3, Not enabled

4, Already enabled

5, Already disabled

6, Not produced by local station

7, Message lost and nack

8, Stopped

9, Already stopped

10, The owner is not started

11, Already connected

12, CommObj already connecting
13, Connection lost

14, Already disconnected

15, CommObj already disconnecting
16, The owner is in bad state

17, Object undefined

1001, Stack issue

1002, Remote access error

1003, No datareport associated
1004, Report is already used

1005, Bad configuration for scope request
1006, No dataset associated

1007, Error during browsing

Instruction OPC - Group identifier separator Scripting > SCADA
The instruction OPC now supports both '.' and '/* as separator for group identifier. Basic

Upgrade Instruction SYSTEM mode CHANGEPASSWORD - New return Scripting > SCADA
value (SPR # 63047) Basic

New return values are available for the instruction SYSTEM, mode CHANGEPASSWORD:

0: Syntax error,

1: Success,

2: User name or old password error,

3: New password is empty,

4: New password length is less than 6 characters, for the advanced security option
only,

®  5:New password has already been used, for the advanced security option only,

®  6: New password does not meet the strong password criteria, for the strong password
option only,

® 7:New password is the same as the old one.
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Instruction CYCLIC, mode DELALL - New argument

A new argument DellAllMode is available for the instruction CYCLIC mode DELLALL. It can have
the following values:

® 1:Delete all temporary items by program (default value),
®  2:Delete all permanent items by program,
®  3: Delete all temporary and permanent items by program.

Scripting > SCADA
Basic

Instruction EVENT mode DELALL - New argument

A new argument DellAllMode is available for the instruction EVENT with the mode DELLALL. It
can have the following values:

®  1:Delete all temporary items by program (default value),
®  2:Delete all permanent items by program,
®  3:Delete all temporary and permanent items by program.

Scripting > SCADA
Basic

Instruction TREND - New mode SHOW LEGEND (SPR # 63254)

A new mode SHOW_LEGEND is available for the instruction TRENDVIEWER. It enables showing
and hiding the legend of a given Trend viewer.

Scripting > SCADA
Basic

Instruction XMLPATH - New mode COUNT

A new mode COUNT has been added to the instruction XMLPATH. It returns the number of
nodes in the Xml fragment.

Scripting > SCADA
Basic

Instruction CRONTAB - New modes EXECUTE_TABLE &

EXECUTE_ALLTABLES (SPR # 63444)
Two new modes EXECUTE_TABLE and EXECUTE_ALLTABLES have been added to the instruction
CRONTAB to execute the standard timetable or active exceptions:

e CRONTAB ("EXECUTE TABLE", TableName)

returns O if the TableName does not exists
returns 1 otherwise

e CRONTAB ("EXECUTE ALLTABLES")

always returns 1

Scripting > SCADA
Basic

Also in: 11.2.06062,
11.2.06062, 11.1.06111,
11.1.06111, 11.0.06096

Instruction ASSOCLABEL - New modes (SPR # 16728)

New modes are available for the instruction ASSOCLABEL to set a specific associated labels type:

®  SETBITLABEL
® SETALARMLABEL

Scripting > SCADA
Basic

Instruction GETARG - New modes

Several modes dedicated to event actions have been added to the instruction GETARG:
® TS_VALUE: Get the timestamp of the triggering variable,

TS_TYPE: Get the timestamp source of the triggering variable,

VARVALUE_BIT: Get the triggering variable value as an integer,

VARVALUE_TEXT: Get the triggering variable value as a string,

VARVALUE_REGISTER: Get the triggering variable value as a double,

VARVALUE_ALARM: Get the triggering variable alarm status.

Scripting > SCADA
Basic

Instruction TREEVIEW - New modes

Several new modes have been added to the instruction TREEVIEW:

CLEAR,
®  INSERTNODE,
®  REMOVENODE,
® SORT.

Scripting > SCADA
Basic

Instruction WINDOW - New mode GETCOLLECTION (SPR # 63129)

A new mode GETCOLLECTION is available for the instruction WINDOW. It enables retrieving an
XML fragment with the list of opened mimics.

Scripting > SCADA
Basic
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Instruction TREND - New modes related to thresholds (SPR # 62758) Scripting > SCADA
New modes have been added to the SCADA Basic instruction TREND: Basic
e TREND ("THRESHOLD_GETMODE", Window, BranCh, Also in: 11.2.06034
Identity, Trace); U '
Returns the current mode of the selected trace: 11.2.06034, 11.2.06031,
E)l: nc; threshold, 11.1.06092, 11.1.06092,
: automatic,
1: ppphigh/pphigh/phigh/high, 11.1.06089
2: pphigh/phigh/high/low,
3: phigh/high/low/plow,
4: high/low/plow/pplow,
5: low/plow/pplow/ppplow.
e TREND ( "THRESHOLD_ISCHECKED" , Window, Branch,
Identity, Trace, ThresholdNumber );
Returns the current mode of a given threshold (0: not activated; 1: activated).
e TREND ( "THRESHOLD_GETVALUE" , Window, Branch,
Identity, Trace, ThresholdNumber );
Returns the value of a given threshold.
e TREND ( "THRESHOLD_ISDRAWLINE" , Window,
Branch, Identity, Trace, ThresholdNumber );
Indicates if the limit line of a given threshold is displayed or hidden (0: hidden, 1:
displayed).
e TREND ("THRESHOLD_GETCOLOR" , Window, Branch,
Identity, Trace, ThresholdNumber );
Returns the line color of a given threshold (RGB code in double format).
e TREND ("THRESHOLD_GETSTYLE" , Window, Branch,
Identity, Trace, ThresholdNumber );
Returns the style of the line of a given threshold:
0: solid,
1: dash,
2:dot,
3: dashdot,
4: dashdotdot.
Instruction WINDOW mode IS_OPEN - Branch now optional (SPR # Scripting > SCADA
62748) Basic
From now on, the branch is an optional parameter when using the SCADA Basic instruction Also in: 11.2.06031
WINDOW mode IS_OPEN. It enables to check if a mimic is opened whatever the branch is. 11.1.06088 '

Instruction LOGDISPLAY- New mode GET_NAME_FROM_LINE
A new mode is available for the SCADA Basic instruction LOGDISPLAY:

®  GET_NAME_FROM_LINE: Returns the variable name associated to a given line number.

Scripting > SCADA
Basic

Also in: 11.2.06022,
11.1.06075

Instruction CRONTAB - New modes ADDPROG_EX and DELPROG_EX
(SPR # 15208)
Two new modes are available for the instruction CRONTAB:

® ADDPROG_EX (15) to add a program schedule by
CronType/Frequency/Program/Branch/Function and its function arguments & active

it.
CRONTAB ("ADDPROG EX", CRONTYPE, Date, Time,
Program, Branch, Function [, Arguments [,
ActiveBit]]);

® DELPROG_EX (16) to delete program schedules with different arguments & active bit.
CRONTAB ("ADDPROG EX", CRONTYPE, Date, Time,
Program, Branch, Function [, Arguments]|[,
ActiveBit]]);

The modes ADDPROG and DELPROG are now obsolete.

Scripting > SCADA
Basic

Also in: 11.2.06001,
11.1.06066

Setlmage method with absolute path (SPR # 63487)

The VBA method Set/mage now support absolute path, thus allowing loading images that are
not stored within a project or library folder.

Scripting > VBA
Also in: 11.2.06058
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New events on the Grid Control (SPR # 63425)

Two new VBA events have been added to the Grid Control to indicate when it starts and
completes the update of the variables. These events are useful when the Grid control is in
variable tracking mode:

®  OnBeginUpdatingVariables()
®  OnEndpdatingVariables()

Scripting > VBA
Also in: 11.2.06058,
11.1.06105

Change a picture dynamically in a mimic (SPR # 62685)

A new VBA method Set/mage is available for the Bitmap objects. It enables to dynamically
change a picture in a mimic. Only pictures stored in the libraries (Common, Shared or Project)
can be used.

myObject.SetImage "/myLib/newImage.png"

It returns:
® -1if the image does not exist,
®  (if the formatis invalid,
® 1 when successful.

Scripting > VBA
Also in: 11.2.06026,
11.2.06026

Alarm value in VBA (SPR # 60978)

A new HMI option named Scripting.Variable Value returns alarm value if variable is an alarm is
available.

When activated, the VBA property Value of Variable items is an Alarm value (see below),
otherwise it is a Bit value (0 or 1). It is not activated for new projects and activated for existing
projects.

In addition, a new VBA property AlarmValue is available on Variable items. If a variable item
corresponds to an alarm, it returns the alarm value as follows:

0: Off

: On, Not Acknowledged
: On, Acknowledged

: Off, Not Acknowledged
: Masked operator

: Masked program

: Masked variable

: Masked expression

e 6 o o o o o
N o b WwWN R

Scripting > VBA
Also in: 11.2.06001,
11.1.06065

Support for Alarm maintenance mode (SPR # 63951)

WebVue, TouchVue and the associated Web Services now support the maintenance mode of
alarms.

Web Server Extensions

Web Extensions - WebScheduler (SPR # 65627, 65436, 65354, 64408,
64389, 63072)

In order to simplify deployment, the WebScheduler now accesses the built-in timetable
configuration directly via an API.
The configuration of the path to the Cron.dat file is no longer necessary and ignored if present.

Web Server Extensions

Upgrade Week numbering (SPR # 63363)

Week numbering in the WebScheduler is no longer based on the CalendarWeekRule setting
from the web.config file, but on the culture associated to the language selected at login time (or
the culture settings of the web browser, if the Default language is selected upon login).

This change makes it easier to adapt to a variety of users operating in areas with different
standards for week numbering, but may affect existing users if their browser configuration or
language selection do not correspond to how the CalendarWeekRule setting was configured on
the WebScheduler server.

WebScheduler
Also in: 11.2.06056,
11.1.06103

Configuration of associated labels on Schedules (SPR # 62625, 61819)

It is now possible to configure associated labels at the schedule level instead of only within the
properties of referenced outputs. This new property has a higher priority than properties of
reference outputs. It offers the possibility to have suitable labels in the WebScheduler even if
schedule outputs are not configured at the PcVue level.

WebScheduler

Also in: 11.2.06038,
11.2.06034, 11.2.06033,
11.2.06033

Default number of schedules displayed (SPR # 62557)

A new setting GridViewPageSize is available in the web.config file of the WebScheduler. It
enables to set the number of schedules to be displayed in the schedule page. Defaults to 20.

WebScheduler

Also in: 11.2.06030,
11.2.06030, 11.2.06026,
11.2.06026, 11.1.06089,
11.1.06089, 11.1.06086
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5. Performance

Alarm counters
Performance enhancements in the handling of alarm counter system variables.

Alarms
Also in: 11.2.06066

Alarm syntheses loading time improved

Loading time of Alarm Syntheses has been significantly improved with a better handling of filter

defined without branches.
As an example, the loading of 7300 Alarm Syntheses now takes only 7 mn instead of 37 mn.

Alarms
Also in: 11.2.06066

Saving of the file HDSTrend.dat Configuration
The file C\HDSTrend.dat is now saved on demand, and only when trends have been added, Environments
modified or removed. Prior to this fix, it was saved each time a trend was modified leading to

strong performances issues when importing configuration with a Smart Generator or the

Application Architect.

HDS Trends configuration saving (SPR # 62905, 62900) Configuration
From now on, the configuration file containing HDS Trends is only saved in the following cases: Environments

®  Completion of an import (Generic Import, Smart Generators, Application Architect),
®  Application Explorer Save action,

®  Project exit.
This file was previously saved upon all single modification of a HDS Trend, causing imports to
perform poorly.

Also in: 11.2.06039

Improved performances of the variable selector (SPR # 62849, 62838, Configuration
62571) Environments
Improvement of the variable browsing implementation. As a consequence, the variable selector ~ Also in: 11.2.06035,
is much more responsive. 11.2.06035

Slow display of templates with Global parameters Configuration

The time to display templates and instances having global parameters has been greatly
improved. On large number of instances, the time to display is reduced from 15 sec to 3 sec.

Environments >
Application Architect
Also in: 11.2.06081,
11.2.06081, 11.2.06081

New settings for performance improvements

Two new settings have been added to improve general performances when displaying object
composition:

®  Skip reference calculations for generation - This setting affects the generation of
properties requiring access to an Excel function. The properties are not generated in
the output from the Application Architect. The affected properties do not exist - they
are not just empty. This is to ensure the correct synch when de-selecting the option.

® Do not display detail of included templates for instances - This setting affects the
instances tab. If not selected when you click on a template instance, the inputs, input
parameters and expressions appear in the lower part of the screen for both the
selected instance and any child objects particularly those from included templates. If
set, inputs, input parameters and expressions for the included templates are not
displayed. This is used to improve the display of the Application Architect's HMI,
particularly for templates including other templates that have many parameters to
evaluate.

Configuration
Environments >
Application Architect

Rendering performance on template/category creation

Rendering performances when adding a new template or category to a library has been
improved.

Configuration
Environments >
Application Architect

Synchronization time reduced
The time to synchronize with the Application Architect has been improved, in particular when

the configuration contains alarm synthesis, expression on variables, cyclic and HDS trend items.

Configuration
Environments >
Application Architect
Also in: 11.2.06026,
11.1.06088
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Excessive time to import Associated Actions (SPR # 61908)

Importing alarm Associated Actions was taking an abnormal long time to perform due to
multiple file accesses.

Prior to the fix, importing 6000 Associated Actions took around 12mn. The import time has been
decreased to less than a minute.

Configuration
Environments > Smart
Generators

Also in: 11.2.06026,
11.1.06085, 11.1.06085

Improved responsiveness (SPR # 62638, 62455, 62230, 61749)

On-demand reads are heavily used by the mapping editor and Helpers for device objects
discovery, introspection of property lists, and value retrievals.

This series of enhancements increases performances by reducing both the network traffic and
improving the user experience. When using the mapping editor and Helpers, the time to display
or refresh information is reduced, making use of these tools much more comfortable for users.
The improvement is significant when connected to devices with limited support for
segmentation, small max APDU size, or having large sets of objects and properties (object-list,
arrays...).

Data Acquisition >
BACnet Client

Also in: 11.2.06038,
11.2.06038, 11.2.06037,
11.2.06037, 11.2.06037,
11.2.06037, 11.2.06036,
11.2.06035, 11.2.06035,
11.2.06034, 11.2.06034

Resources usage (SPR # 65770)

Improvements to CPU and resources usage for the IEC 61850 driver, leading to more responsive
data exchanges. CPU consumption has been reduced by 40%.

Data Acquisition > IEC
61850 Client

Also in: 11.2.06080,
11.2.06080

Excessive time to stop a network (SPR # 62605)

In case of dynamic host name resolution, stopping a network could take a long time. Now the
name resolution is stopped when a device is stopped.

Data Acquisition >
SNMP Manager
Also in: 11.2.06031,
11.1.06078

Several performance improvements
Several performance improvements, including:
®  Faster start-up, reduced generation and synchronization time with the Application
Architect and XML generic import,
® |mprovements to CPU and resources utilization for the IEC 61850 driver, leading to
more responsive data exchanges,
®  |mprovements to on-demand reads with the BACnet driver, leading to more responsive
configuration and diagnostic tools,
®  |mprovements to the variable browsing to improve the user experience with the
variable selector,

Improvements to the WebScheduler responsiveness when displaying BACnet Schedules and
Calendars.

General

Max framerate
The framerate is now limited to 33 fps to avoid CPU overloading.

HMI > Map control
Also in: 11.2.06045,
11.1.06098

Loading time of the Trend Viewer (SPR # 62336)

The time to load historical data points in the Trend Viewer has been reduced.

Web Server Extensions
> WebVue

Also in: 11.2.06001,
11.1.06068

Asynchronous loading of schedules (SPR # 62557)

The loading time of schedules has been improved by using asynchronous calls. In addition,
selecting a schedule before the end of loading interrupts it to enable a faster display of the
selected schedule.

WebScheduler

Also in: 11.2.06045,
11.2.06045, 11.2.06045,
11.2.06045

BACnet Calendar loading time (SPR # 62435)

When displaying a BACnet Calendar, multiple reads were done, slowing down the loading time
of the calendar page.

WebScheduler
Also in: 11.2.06010
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6. Audit & diagnostic

Archives audit (SPR # 62846)

Audit counters for archives items have been enhanced. The following counters are now
available:

Trends linked to Free Archive Units,
Trends linked to HDS Archive Units,
Trends linked to ODBC Archive Units,
Trends linked to Proprietary Archive Units,
Trends linked to other outputs (printer),
Trends without output,

Log lists linked to Free Archive Units,

Log lists linked to HDS Archive Units,

Log lists linked to ODBC Archive Units,

Log lists linked to Proprietary Archive Units,
Log lists linked to other outputs (printer),
Log lists without output.

Audit

Pending export (SPR # 64508)

A new system variable is available to indicate the amount of pending exports per station:
System.<Station>.DataAnalysis.DataExport.PendingE
xXports

Audit

New audit counters for IEC 104 Outstation (SPR # 64587)

New audit counters are available for IEC 104 Outstation.

Audit

Additional messages in FORM.ERR (SPR # 64265, 64264)

New messages are recorded in the FORM.ERR file when incorrect properties are defined in the
Varexp.dat file, in particular:

®  Range of alarm acknowledgment level between -1 and 29,
®  Range of alarm masking level between -2 and 29,

®  Range of alarm maintenance level between -2 and 29.
Value -1 means that the corresponding property uses the Alarm Priority level.
Value -2 means that the corresponding property uses the Alarm Acknowledgment level.

Audit

Additional traces and messages for Email and SMS (SPR # 63746)

Additional traces and messages can be activated for diagnosis purpose for Messages (Email and
SMS).

Audit

CwAudit startup enhancement (SPR # 63029)

CwAudit was able to connect to PcVue only one time after startup. Now it can be started,
stopped and restarted on the fly while PcVue is running.

Audit
Also in: 11.2.06038

CwAudit - Max number of equipments (SPR # 63019)

The maximum number of equipments CwAudit can managed is now 2018 (was 256).

Audit
Also in: 11.2.06038,
11.1.06096, 11.0.06093

New traces for the SNMP Agent driver (SPR # 62378)

New traces are added to the SNMP Agent driver, for a better diagnosis of incorrect loading of
the configuration file.

Communication
interfaces > SNMP
Agent

Also in: 11.2.06001,
11.2.06001

Additional report in case of fatal error (SPR # 65060)

In addition to dump file, plain text files are now created in case of a fatal error of the Application
Explorer or Smart Generators.

Configuration
Environments
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New dump files (SPR # 16703)

From now on, dump files are generated upon fatal error of the Application Explorer, the
Application Architect and Smart Generators.

Configuration
Environments

Also in: 11.2.06035,
11.2.06035, 11.2.06034,
11.2.06034

Application Architect tracing

Logs and traces generated by the Application Architect have been improved for better diagnosis
and tracking of the sources of configuration errors.

Configuration
Environments >
Application Architect

New traces for the KNX driver (SPR # 62378)

New traces are added to the KNX driver, for a better diagnosis of incorrect loading of the
configuration file.

Data Acquisition > KNX
Also in: 11.2.06001,
11.2.06001

Enhanced robustness of the Event Viewer (SPR # 62901, 62763)

Under some circumstances, a fatal error could occurred when too many traces were sent to the
Event Viewer. Now the Event Viewer updates the displayed traces 3 times per seconds instead
of on every new trace.

General
Also in: 11.2.06067

Warning message when no reference project/library (SPR # 65102)

A warning message is now displayed in the event viewer when the project is started using the
command line option -r or -r_delta if no reference version is defined.

General > Version
management
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7. Add-ons & tools

BACnet server Add-on (SPR # 63008) Communication

A BACnet server interface is now available as an Add-on. It supports BACnet/IP with the profile interfaces

B-ASC. .

The Add-on is licensed. Also in: 11.2.06057,

11.2.06056, 11.2.06054,
11.2.06046, 11.2.06046,
11.2.06031

Reference: PcVue 12 Release Notes Last update: November 3, 2025
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8. Installation

Dream Report version 5.0 Add-ons and Tools
The newer installation package for Dream Report is available in the Add-ons & Tools section of

the DVD.

New Add-on - OPC UA Gateway Add-ons and Tools
PcVue now supports the OPC UA Gateway with built-in licensing. It includes: Also in: 11.2.06063

® The OPC UA client gateway for data acquisition,

®  The OPC UA server gateway for exposing PcVue variables to 3rd party UA clients.
The OPC UA Gateway is available in the Add-ons & tools section of the DVD.

New and updated libraries General
New and updated libraries:

®  Railway: A new library including a set of images and symbols for Urban & Main lines
signaling systems and station assets such as ticketing machines and security gates,

®  Navigation: Updated mimic templates with new styles in dark and light themes.

Documentation update General >
The product documentation has been updated: Documentation
®  Online help in Chinese - Now at the level of version 11.2 update.

Reference: PcVue 12 Release Notes Last update: November 3, 2025
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9. Security

Weak password set by the administrator (SPR # 64326) General > User

When resetting a user's password, the administrator was able to set a weak password evenifa  management
strong password policy was enforced.

OpenSSL library updated Security

The OpenSSL library has been updated to version 1.0.2q (20 Nov 2018).

Latency when starting the application (SPR # 63384) Security

Under some circumstances, a huge latency (up to 1 min) could be noticed when starting an Also in: 11.2.06060

application (project selector, Application Explorer...). The issue was due to the validation of the
code-signing certificate regarding the certificate revocation list (CRL).

FIPS enforcement deactivated Security

FIPS has been deactivated at the application level for all the provided executables that are Also in: 11.2.06058

based on the .NET Framework and are likely to use cryptographic algorithms that are not FIPS !

compliant. / yprograpnic S 11.2.06058, 11.1.06106,
11.1.06105

Reference: PcVue 12 Release Notes Last update: November 3, 2025

Copyright ©2024 - ARC Informatique. All rights reserved — LI N0 H I3 Page 111/119



PcVu

e\

v

10. Other fixes & enhancements

SPR #14068, 60149, 61490, 61879, 61935, 61967, 61968, 61978,
62014, 62792, 63301, 63897, 63922, 64068, 64514, 64567, 64645,
64675, 64695, 64794, 64815, 64816, 64817, 65180, 65225, 65245,
65307, 65470, 65703, 65768, 65796, 65920

e SPR #62538 Also in: 9.0SP3,
11.2.06022, 11.1.06076,
11.0.06087, 10.0SP?2

e SPR #65931 Also in: 11.2.06082

e SPR #65840, 65958 Also in: 11.2.06081

SPR #65617, 65701, 65720, 65725

Also in: 11.2.06080

e SPR #65496, 65513 Also in: 11.2.06079
e SPR #65491 Also in: 11.2.06078
e SPR #65463 Also in: 11.2.06076
e SPR#65313 Also in: 11.2.06074
e SPR #65074, 65090 Also in: 11.2.06073
e SPR #64555 Also in: 11.2.06069,
11.2.06068, 11.2.06068
e SPR #64596 Also in: 11.2.06068
e SPR #63949 Also in: 11.2.06068,

11.2.06067

SPR #63532, 63893, 64315, 64503

Also in: 11.2.06067

e SPR #64531 Also in: 11.2.06067,
11.2.06067

e SPR #64463 Also in: 11.2.06067,
11.2.06067, 11.1.06114,
11.1.06113

e SPR #64316 Also in: 11.2.06067,

11.1.06115

SPR #61858, 63749, 63974, 63988, 64125

Also in: 11.2.06064

o SPR#61718, 64018 Also in: 11.2.06064,
11.2.06064, 11.2.06064

e SPR #64042 Also in: 11.2.06064,
11.1.06113

e SPR #63338 Also in: 11.2.06064,

11.1.06112
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e SPR #63889 Also in: 11.2.06062,
11.2.06062

e SPR #63923 Also in: 11.2.06062,
11.2.06062, 11.2.06062

e SPR #63815 Also in: 11.2.06062,
11.2.06062, 11.2.06060

e SPR#63723 Also in: 11.2.06062,
11.2.06062, 11.1.06112

e SPR #63894 Also in: 11.2.06062,
11.1.06111

e SPR#63873 Also in: 11.2.06061

SPR #60690, 63095

Also in: 11.2.06061,
11.1.06110, 11.0.06095

SPR #63730

Also in: 11.2.06060

SPR #63668

Also in: 11.2.06059

SPR #63334, 63355, 63383, 63438, 63493, 63580, 63607

Also in: 11.2.06058

SPR #63486

Also in: 11.2.06058,
11.1.06105

SPR #62167, 63277

Also in: 11.2.06057

SPR #63403

Also in: 11.2.06057,
11.1.06105

SPR #62762, 63375

Also in: 11.2.06056

SPR #63164

Also in: 11.2.06056,
11.1.06102, 11.0.06094

SPR #63046, 63119

Also in: 11.2.06055

SPR #63226, 63229

Also in: 11.2.06055,
11.2.06055

SPR #63255

Also in: 11.2.06055,
11.1.06102, 11.0.06094

SPR #63163, 63174, 63183, 63208

Also in: 11.2.06054

e SPR #63164 Also in: 11.2.06054,
11.1.06099, 11.0.06093
e SPR #63152 Also in: 11.2.06048,

11.1.06098
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SPR #62845

Also in: 11.2.06047,
11.2.06047, 11.2.06047,
11.2.06047, 11.1.06098,
11.1.06098

SPR #62734

Also in: 11.2.06045,
11.2.06045

SPR #63030

Also in: 11.2.06038

SPR #62251, 62881, 63764

Also in: 11.2.06035

SPR #62811, 62912

Also in: 11.2.06034

SPR #62806, 62875

Also in: 11.2.06033

SPR #62874

Also in: 11.2.06033,
11.1.06092

SPR #62496, 62749, 62786

Also in: 11.2.06031

e SPR #61080 Also in: 11.2.06031,
11.2.06031

e SPR#62741 Also in: 11.2.06031,
11.1.06088

e SPR #62672 Also in: 11.2.06026

e SPR#16300 Also in: 11.2.06025

o SPR #62585, 62668 Also in: 11.2.06025,
11.1.06081

e SPR #62535 Also in: 11.2.06023,
11.1.06086

e SPR #62409 Also in: 11.2.06023,
11.1.06079

e SPR #62414 Also in: 11.2.06022

o SPR #62541 Also in: 11.2.06022,
11.1.06076, 11.0.06087

e SPR #62451 Also in: 11.2.06022,
11.1.06073

e SPR #62034 Also in: 11.2.06001,
11.1.06071

e SPR#61039 Also in: 11.2.06001,
11.1.06069, 11.0.06086

e SPR#62290 Also in: 11.2.06001,

11.1.06068
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3. Known Issues

[Fixed] Alarm synthesis timestamp changed on server switchover (SPR
# 71548)

On a server switch from passive to active, an alarm synthesis is recalculated, including its value
and timestamp. If the alarm synthesis has not changed, the value is not set. But, since a
regression introduced in Maintenance Release 12.0.20 the timestamp is updated, causing event
triggering if any.

[Edit: Fixed in 15.2.4 and 12.0.28].

Alarms

12.0.20

Also in: 15.2.0, 15.1.0,
15.0.0

Audit counter mean values are inaccurate (SPR # 65251)
Calculation of mean values is wrong for audit counters (error every 27 hours).

Audit
12.0.7
Also in: 15.2.0, 15.1.0,
15.0.0

Lost instances (SPR # 67013)

Under some circumstances, all instances are lost. Investigations indicate that this may be caused
by the deletion of the root node.

While the investigations continue to uncover and fix the source of the issue, changes have been
made to mitigate and prevent the root node deletion.

Specific diagnostic traces have been added to indicate that an attempt to delete the root node
occurs. In addition, a specific backup (in addition to the rolling backup files) is now performed to
ensure that instances configuration will not be lost.

These changes are in effect starting with the Maintenance Release 12.0.13.

If you run an earlier release of version 12 and notice that the instances root node is not
displayed in the Instances tab of the Application Architect, you have probably run into the issue
and the instances are lost. In such situation, stop PcVue and recover a valid instances
configuration from the rolling backup files located the C\Templates\Back folder. Do not restart
PcVue multiple times before you recover your configuration as it exposes you to losing the
useful rolling backup.

Configuration
Environments >
Application Architect
12.0.13

Also in: 15.2.0, 15.1.0,
15.0.0, 15.0.0, 15.0.0

Upgrade Potential behavior change for alarm syntheses (SPR # 67799,
66701, 60594)

Starting with version 11.2 Release, by default, new alarm synthesis items created with the
Application Explorer or the XML Generic Import do not take the population filter into account.
This change was not introduced for alarm syntheses created with the Application Architect,
leading to the following potential issues if your project includes populations and alarm
syntheses created based on templates and instances with the Application Architect:

® |f you have migrated or are migrating a project from version 11.1 or earlier to version
11.2 or later, you should check with the Application Explorer that alarm syntheses are
configured to fit your requirements (take into account or ignore population). If
configuration does not fit, reverse the value of the 'Take population filter into account'
using the Application Architect and proceed with a full synchronization.

® Do the same verification and configuration changes if your project was once migrated
to 11.2 (earlier than 11.2.06094), and is now being migrated to 11.2.06094 or later.

® Do the same verification and configuration changes if your project was once migrated
to 12 (earlier than 12.0.16), and is now being migrated to 12.0.16 or later.

® |nall cases, pay particular attention to alarm syntheses created with version 11.2 and
12, as it is likely that the population filter property is not applied as it used to be with
earlier versions.
You are not impacted by this issue if you do not use population filtering in your project, or if
alarm syntheses are not created based on application modeling with the Application Architect.

Configuration
Environments >
Application Architect
12.0.16

Also in: 15.2.0, 15.1.0,
15.0.0, 11.2.06094

Supported operating systems for the KNX Add-on

The KNX add-on is only supported on the following operating systems, with the exclusion of any
virtual environment:

®  Windows 7 SP1 (x64),
®  Windows Server 2008 R2 SP1 (x64).

Data Acquisition > KNX
12.0.7

Also in: 15.2.0, 15.1.0,
15.0.0, 11.2.05001
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Supported operating systems for the LNS data acquisition driver
The LNS data acquisition driver is only supported on the following operating systems:
®  Windows 7 SP1 (x64),
®  Windows 8.1 (x64),
®  Windows Server 2008 R2 SP1 (x64),

®  Windows Server 2012 (x64).
Starting with version 15, the LNS data acquisition driver is validated with 1zoT Net Server 4.5
(also known as OpenLNS) and supports recent operating systems.

Data Acquisition > LNS

12.0.7
Also in: 11.2.05001

Xbus-IP-Master - Handling of connection termination (SPR # 66310)

Some devices require connection termination using the TCP FIN_ACK flag instead of the usual
RST_ACK.
In the case, receiving the TCP RST_ACK caused the device to reboot.

In order to improve interop with such devices, a change was implemented to make it possible to

configure if a connection shall be terminated using the TCP RST_ACK or FIN_ACK flag.
[Changed in versions 11.2.06085, 12.0.19 and 15.0].

Data Acquisition >
Other built-in drivers
12.0.7

[Fixed] Issue when changing the binding (SPR # 65998, 65964)

When changing the binding of a web site (from hostname to IP or IP to FQDN for example) and
re-deploying, the Registry service end-point is not properly re-configured, preventing the web
site from being operational.

The workaround is to delete and recreate the web site or to modify the WDC configuration file
manually.

[Fixed in 12.0.10]

Deployment tools >
Web Deployment
Console

12.0.7

[Fixed] WDC will not start after changing the computer name (SPR #
66066, 66017)

Because the WDC checks that the IIS configuration it holds matches the computer where it is
run, if the computer name of an IIS Web server is changed after a deployment with the WDC,
then the WDC will fail to start again.

[Edit: Fixed in 12.0.10]

Deployment tools >
Web Deployment
Console

12.0.7

License for version 15 not recognized by PcVue version 12

Some licenses shipped during Q2 2021 for version 15 are not recognized by PcVue version 12.
If you encounter the issue, update to Maintenance Release 12.0.14 or a later Maintenance
Release of version 12, or contact our sales representative.

[Fixed in 12.0.14]

General > Licensing
12.0.13

Upgrade [Fixed] Upgrade of HDS table schema

With version 12, the length of Log list names can be up to 100 characters long (was 12).

This change affects the schema of HDS log tables (column LogList).

The change in table schema is done automatically at startup if the size of the database is less
than 10 Gb.

If the size is higher, the traces ask you to run the migration script.

Historical data
12.0.7

The issue is that the migration script, as supplied with the installation package 12.0.7 and 12.0.8,
was wrongly altering the column EvtTitle instead of the column LogList, causing the archiving to

no longer be effective after project startup.

If you have upgraded your HDS log tables with version 12.0.7 or 12.0.8, it is advised to apply the

following changes manually:

®  Alter the LogList column of Log tables to type it varchar(100),
®  Alter the EvtTitle column of Log tables to type it varchar(255),
®  Make sure the value of DBVersion is set to 4.

[Edit: Fixed in 12.0.9] If you are upgrading your HDS log tables with version 12.0.9 or later, no
specific action is required apart from running the migration script.

SQL filtering on HMI variables (SPR # 65903) HMI > Grid control

When using the Grid control in variable tracking mode, the Sqgl syntax cannot be used to filter 12.0.7

HMI variables. .
Also in: 15.2.0, 15.1.0,
15.0.0
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[Fixed] Potential memory leak in Networking with mixed PcVue versions
(SPR # 67867)

Under some circumstances, while migrating a project, a memory leak occurs on a data
acquisition server if it runs a version greater than or equal to 11.2.6086 and communicates with
a client station running with version 12.0.15 or lower. The leak occurs at each restart of a client
station, and its size is proportional to the number of variable subscriptions sent by the client
station to the server station (250 bytes per subscription - typically a leak of 2.5 MB for 10 000
variables at each restart of a client station).

[Edit: Fixed in 11.2.06094 - The leak is fixed whatever version 12 build is running on the client
station]

[Edit: Fixed in 12.0.16 - The leak is fixed whatever version 11.2 build is running on the serve
station]

Networking
12.0.16
Also in: 11.2.06094

Client/Server networking instability if recent hardening is enabled (SPR
#76112)

If the security fix described in security bulletin SB2025-4 is enabled, networking packets can be
falsely detected as malformed, causing a server station to force a disconnection. This issue leads
to a situation where a client station may not be able to stay connected to a server station in a
stable way.

Recommendation:

The issue does not manifest itself if the recent hardened connection mechanism is disabled. To
disable this mechanism, the security alteration setting named 'Networking.Allow security
altering configuration options' must be checked and the property 'Allow stations with altered
security' on Nodes must be set to Yes.

Fix planned in 16.3.3, 15.2.13 and 12.0.32.

Networking

12.0.31

Also in: 16.3.2, 16.3.1,
15.2.12

BeforeClose script not triggered (SPR # 68418)

Since version 12.0.7, the SCADA Basic function called upon closing a mimic was not correctly
triggered when the mimic was closed via SCADA Basic.

[Edit: Fixed in 12.0.20 and 15.0.0 for PcVue desktop]

A fix for WebVue is planned for a later release.

Scripting > SCADA
Basic

12.0.20

Also in: 15.2.0, 15.1.0,
15.0.0

[Fixed] Control animations not executed (SPR # 70070, 69124)

In Maintenance Release 12.0.24, control animations in mimics are not executed if rendered in
Web & Mobile clients.

We recommend users of WebVue and TouchVue not to use the Maintenance Release 12.0.24.
[Edit: Fixed in 12.0.25]

Web Server Extensions
12.0.24

Issue with host name resolution on Android (SPR # 65724)

Android versions earlier than 5.1 are known to be affected by a bug related to host name
resolution.

When using DHCP, the issue prevents from using a host name other than a Fully Qualified
Domain Name even if the host name is properly registered in a local DNS and the DNS server
automatically updates itself to reflect DHCP leases. The issue is that Android devices do not use
the DNS search path provided by DHCP.

Please refer to the Google Issue Tracker for more information:
https://issuetracker.google.com/issues/36916949

Web Server Extensions
12.0.7

Also in: 15.2.0, 15.1.0,
15.0.0

[Fixed by Apple] Issue in the Trend viewer with the Safari browser (SPR
#65731)

With the Safari Web browser, the hexadecimal code of colors is displayed instead of the actual
colors in the Trend viewer's legend.

The fix is available in Safari 12.1 shipped with iOS 12.2 and macOS 10.14.4. It is also available for
macO0S 10.13.6 and 10.12.6. (Added support for <input type="color">)

Web Server Extensions
> WebVue
12.0.7

[Fixed] Limited support for included mimics and popups

Support for included mimics and popups in WebVue is still limited compared to the behavior of
the desktop client.

[Edit: Fixed in 12.0.11]

Web Server Extensions
> WebVue
12.0.7

Drag handling with Firefox (SPR # 70455)

If a position animation with Cursor mode enabled is used on an image, the user needs to click
twice in Firefox to perform the action.

Web Server Extensions
> WebVue

12.0.7

Also in: 15.2.0, 15.1.0,
15.0.0
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Known limitation related to hiding control zone highlighting (SPR #

69621, 69606, 68375)

At the time of writing, hiding the control zone highlighting (according to the HMI option) is only
implemented for rectangle shapes.

Web Server Extensions
> WebVue

12.0.7

Also in: 15.2.0, 15.1.0,
15.0.0

Known limitation related to the animation Send register in Step mode
(SPR # 66012)

The '+' and '-' buttons are not rendered in WebVue when using the Send register animation with
the Step mode enabled.

Web Server Extensions
> WebVue

12.0.7

Also in: 15.2.0, 15.1.0,
15.0.0

Restrictions related to web browsers

Each web browser can come with its own restrictions, in particular when security is at stake.
Below is a list of known behaviors, specific to one or the other web browser available on the
market at the time of writing. These restrictions may be cleared and others appear depending
on web browser updates and their publisher's strategy.

®  SafarioniOS - When the Safari web browser is closed without logging out from
WebVue, WebVue is re-open by default the next time the user opens Safari, but the
user will not be able to successfully login, and will be stuck on the WebVue loading
page. This is due to the Safari snapshot of the last visited page where Safari displays
the web page without actually requesting the web server. The solution is to go to the
address bar and click the Go button, or ask Safari to reload the page.

®  Google Chrome - The password manager of Chrome does not store credentials if the
connection to the web server is insecure. As a consequence, if you do not have a
proper certificate on the web server, users will not be able to use the Chrome
password manager to store their credentials.

®  Microsoft Edge - Edge in versions prior to 79 (Jan 2020) does not store the session
cookie when using the local computer as a web server with a binding on the hostname
at the IIS level. As a consequence, you cannot successfully log in, and can see a warning
message indicating that the version of the client is not compatible with the server. The
solution is to add .local to the computer host name when setting up the web site
binding with the Web Deployment Console (for example,
https://mycomputername.local instead of https://mycomputername).

Web Server Extensions
> WebVue

12.0.7

Also in: 15.2.0, 15.1.0,
15.0.0

SCADA Basic scripting of form controls (SPR # 65938)

When scripting form controls in SCADA Basic in a WebVue context, the GET modes such as
GETSELECTEDINDEX, GETTEXT... do not return the correct value if the currently selected item
was selected either via the keyboard or another script (with a mode such as
SETSELECTEDINDEX).

These GET modes work properly if the selection was done via mouse-click or a tap (on a touch
device).

Web Server Extensions
> WebVue

12.0.7

Also in: 15.2.0, 15.1.0,
15.0.0

Support for WebFont requires manual installation on Windows 7 SP1 (IIS

7.5) (SPR # 65847)

If the Web Server runs IIS 7.5 - a Windows 7 desktop or Windows 2008 R2 server computer - the
default font (Times New Roman) is used instead of the Roboto Web Font for texts inside pre-
defined WebVue pages and mimic tittles. Texts used in animations within mimics and symbols
are not affected.

This issue is due to the lack of pre-configured support for WebFont in IIS 7.5.

The solution is to install the MIME type handler for .woff files manually using the IIS manager.
This issue may be fixed in a later version of the Web Deployment Console.

Web Server Extensions
> WebVue

12.0.7

Also in: 15.2.0, 15.1.0,
15.0.0

Upgrade WebScheduler migration issue

In order to fit with Microsoft Windows default privileges for the 1IS_IUSRS group, the
configuration files of the ScheduleData service are now stored in the folder
ScheduleData\AppData on the IIS Web server.

These files, namely ScheduleDataAccess.xml and SchedulesAccess.dat, used to be stored in the
folder ScheduleData\config.

Upon migrating a project to PcVue 12.0, it is advised to move the files manually to avoid losing
customization of any piece of configuration. The manual copy shall take place after installation
and deployment of the WebScheduler (using the WDC).

WebScheduler
12.0.7

Also in: 15.2.0, 15.1.0,
15.0.0
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We would love to hear your thoughts and suggestions
so we can improve this document
Contact us at team-doc@pcvuesolutions.com

Copyright ©2025 - ARC Informatique. All rights reserved — LI N0 B3


mailto:arcnews@arcinfo.com
mailto:team-doc@pcvuesolutions.com?subject=[Feedback]%20Release%20Notes

	1. Updates
	1. New features
	2. Fixes
	3. Critical fixes
	4. Enhancements
	5. Performance
	6. Installation
	7. Security
	8. Other fixes & enhancements

	2. Release
	1. New features
	2. Fixes
	3. Critical fixes
	4. Enhancements
	5. Performance
	6. Audit & diagnostic
	7. Add-ons & tools
	8. Installation
	9. Security
	10. Other fixes & enhancements

	3. Known Issues

